Configuring Continuum for Security and Access Control

This chapter provides an overview of Continuum security and access control components and describes how they work together. It describes how to use the Area editor and the Door editor. The Personnel editor is covered in Chapter 19.

Access Control System Overview

A Continuum access control system involves the following objects, conditions, and devices:

- Areas for which entry and egress are controlled (Area objects)
- Doors through which entry and egress are controlled (Door objects)
- People who can access an area (Personnel objects)
- Times when they can access the area (Schedule objects)
- How they access the area (Valid Access)
- Who can change the access control system (User objects)
- How anti-passback violations are detected (area based) and handled (logs, alarms)
- A Continuum workstation with
  - A controller to oversee and monitor access
  - 9000-series controller with a 700-series access controller
- A NetController with a Continuum Access Control Module
- A 9702 Site Controller
- Card readers, keypads, hand geometry and retina scan devices
- Door switches, bond sensors (Door input sensors)
- Motion detectors, push bars, buttons (Request-to-Exit devices)
- The hardware components, such as the controller, card reader, motion detector and door switch, all work together to unlock a door when authorized personnel request to enter or exit an area.
About Access Control

What Is Access Validation?
Access validation is the process of checking conditions that must be met before a person is allowed into an area. Access validation conditions include, but are not limited to:

- Valid site number on the person card
- Valid card number
- Valid PIN
- General code
- Door schedule

What Is Tailgating?
Tailgating is defined as the practice of following another person into an area without swiping your card or entering an access code. If an individual has tailgated into an area, the system does not have an accurate record of the individual’s location.

What Is Invalid Attempt?
An invalid attempt occurs when there is an attempt to access an area by a person who is:

- Not authorized
- Not authorized by schedule
- Not in the database

What Is Anti-Passback?
There are two types of Anti-Passback violations: area based and time based.

Area-based violations occur when personnel attempt access from a non-adjacent area. This could occur if they tailgated into an area.

Adjacent Area objects have at least one common door in their respective lists. As people move through areas, Continuum keeps track of the last area entered by each person. A person causes a violation when they try to use a door that isn’t in the list of their last known Area.

The system can be configured to prevent the same card or access code from being used more than once within a pre-determined time (called Anti-Passback Minutes) to enter the same area. An Anti-Passback violation is an attempt to use the card or code twice before the Anti-Passback Minutes time expires.

What Is a Supervised Input?
A supervised input on a controller or expansion unit monitors the resistance of the device attached to it. If the wiring is tampered with, the resistance of the circuit changes. This change in resistance causes the switch to go into a “Trouble” state. Trouble conditions can be programmed to trigger alarms.
What Is a Request to Exit Device?
A request-to-exit device is a device such as a pushbar, motion detector, or button used instead of a card reader or keypad to pass through a door. If request-to-exit devices are used, the known personnel in the area are invalid, and Entry/Egress cannot be utilized.

Recommended Order for Creating Security Objects
Configure access control objects in the following order.

1. Create the Area objects.
2. Create the Door objects and associate each Door with an Area object.
3. Create Personnel objects and attach them to the Area objects to which they are allowed access.

When you finish, each Area object has a list of Door objects through which it can be entered and a list of personnel authorized to enter it.

How Area, Door, and Personnel Objects Work Together
Area, Door, and Personnel objects work together to check which personnel can access which areas:

- Each Area object has a list of Door objects and a list of authorized personnel
- Each Door is configured with an Entry Reader and Exit Reader that associates it with one Area object
- Each Personnel object has a list of Area objects to which the person is allowed access

These objects all have Current Status pages so that:

- From the Door object you can see which person was the last to go through
- From the Personnel object you can see which area the person last entered

We will discuss the configuration of Area and Door objects in this chapter. We will cover the configuration of Personnel objects in the following chapter.
About Areas and Doors

What Is an Area?
An area is usually defined as a space, which is accessed only by passing through some type of access control device. An area can be accessed by 1 or more doors.

What Is a Door?
A door is defined as a portal controlled by some type of access control device, leading to a predetermined area. Each door becomes part of two different areas, one on each side. Doors are always created at the access controller object.

When you configure a door, you assign an area to it, and then the name of the door automatically appears in that area’s List of Doors in Area.

See the picture below for an example of how areas and doors can be defined and controlled.
About Creating an Area Object
The following section describes how to complete the tabs of the Area object editor. You will be typing information into text fields and making selections from dropdown menus in the tabs of the editors. Once you have configured an Area, you can review the details of the configuration several different ways:

Object editor
Object Properties dialog
List View or Class Default List View

Note: An Area is a specific place accessed by 1 or more doors. You should always define “Outside” as an area

Using the Area Editor
The General Tab

![Image of General Tab]

Description  To help users locate the area and understand its significance within the access control system, enter a description using up to 32 characters, including spaces.
The Doors to Area Tab
Use the **Doors to Area** tab to view all Door objects that provide access to this Area. You can edit any Door shown in this field. Right click on a Door and select **Edit** from the popup menu.

Door objects are automatically added to an Area object when configuring the **Entry Reader** and **Exit Reader** tabs of a Door object.

The People With Access Tab
The people allowed in the area field shows the Personnel objects authorized to enter this Area. They are automatically added when an Area object is added to the **Area List** tab of a Personnel object.
**About Creating a Door Object**

The following section describes how to complete the tabs of the Door object editor. You will be typing information into text fields and making selections from dropdown menus. Once you have created the new door, you can review the details of the configuration several different ways:

- Object editor
- Object Properties dialog
- ListView or Class Default ListView

The Door editor lets you specify Schedule, Area, and other information to control movement of people through the door.

The Door editor’s **Entry Status** and **Exit Status** tabs show read-only data on such details as last person admitted, time admitted, last invalid person, and entry count.

A door can provide access to two different areas (the areas on either side of the door). When you configure a door, you assign areas to it. The door name automatically appears in the **Doors to Area** tab of those areas.

Door objects are always created in the controller to which the door sensors, access card readers and keypads are wired. The exact configuration details for a Door editor depend on whether your access control devices are wired to a Continuum AC-1 and AC-1 Plus access control IOU module, an ACX 700 Infinet controller, an ACX 781 Infinet controller or to an EMX 190 Module/ACX 700 controller combination. An AC-1 and ACX can have a card reader and a keypad wired in parallel. Access of up to four doors can be controlled with a combination of two EMX 190 modules attached to a single ACX 700.
Before You Start
Before creating a Door object you need to know:

- Site codes and format information for access control card sets
- Channel numbers for the following Door outputs and inputs
  - Door lock output
  - Alarm output (Optional)
  - Exit request input (Optional)
  - Door switch input (Optional)
  - Bond sensor input (Optional) (AC-1 Plus)
  - ADA Input (Optional) (AC-1 Plus)
  - ADA Exit Request (Optional) (AC-1 Plus)
- The Schedules used to lock and unlock doors (Optional)
- The InfinityNumeric objects that those schedules turn on and off (Optional)
- IOU, Channel and Area information for entry and exit card reader and keypad inputs
- Type of Validation (card, site, PIN, etc.)

Using the Door Editor

The General Tab
The General tab lets you set and/or monitor basic information about the door.
<table>
<thead>
<tr>
<th><strong>Description</strong></th>
<th>Enter a description of up to 32 characters, including spaces, to help others realize the door’s significance and physically locate it and its access control equipment.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Door Lock</strong></td>
<td>This field displays whether the door is locked or unlocked (based on door output). You can lock or unlock the door by selecting <strong>Locked</strong> or <strong>Unlocked</strong> from the dropdown list.</td>
</tr>
</tbody>
</table>
| **Door State**     | Select **Disabled** or **Enabled**. When the door state is:  
  * **Disabled**, valid access or manual access is permitted. Selecting **Disabled** takes the door out of automatic control.  
  * **Enabled**, valid access is permitted to authorized personnel |
| **Operating Mode** | Leave the selection at **Automatic**. |
| **Momentary Unlock** | Not implemented in this release. |
| **Bond Sensor**    | A bond sensor detects whether a door is truly locked. It senses if the lock bolt is extended or retracted. |
| **(Controller-Specific AC-1 Plus)** | |
| **Door Switch**    | A door switch input detects if a door has been opened or a wire circuit has been tampered with. |
The Card Formats Tab
Use the Card Formats tab to enter information about your access cards, and if needed, your keypad.

**Card Reader**
A card reader is mounted on the wall next to a door.

It reads site code and card numbers on cards passed through it (swiped) by people trying to go through the door.

**Keypad**
A keypad is mounted on the wall next to a door.

People unlock the door by typing the general code numbers and/or their unique PIN number.

**Site Codes (Wiegand Only)**
Each set of cards you purchase is encoded with a single site code. If you purchase multiple sets of cards for the same site and each has a different site code, you can set up the door to accept up to four different site codes. Enter each acceptable site code in one of the four fields.

If an AC-1 loses communication with its NetController, it will only allow access for site codes from the first two fields, and only if the No Database checkbox is selected for Validate Site on the Entry Reader tab.

**General Code**
If you are using a keypad to permit access through the door and you want all personnel to use the same entry code, enter that code in this field.
Arm Code  Not implemented in this release.

Card Format  Click either Wiegand or ABA. These are the two types of cards available from TAC.

ABA Formats  This list of formats appears when you select ABA as the card format. Select ABA Format 1, ABA Format 2, or Custom. This format must match the card format used by the personnel.

Wiegand Formats  Select the card format of the cards used by your personnel:

- Wiegand 26 Bit
- A0 34 Bit
- Wiegand 25 Bit
- Q1 34 Bit
- Custom
- $31 Bit

For information on the use of multiple custom formats with specific controllers, see Appendix F.
The Channels Tab
The Channels tab provides you with information about how you installed the access control hardware. The controller-specific (AC-1 Plus) ADA (Alternate Door Access) Options allow you to configure a door to accommodate disabled persons by allowing for longer than usual door unlock and open periods.

Enter the Channel numbers for various access inputs and outputs.

**Door Output Channel**
The channel number to which the door lock is wired.
For ACX 700 controllers, the value of this attribute depends on how the strike controlling the door has been wired to the controller or the expansion units. If one expansion unit has been used with the ACX 700, its Door Output Channel is 4. If two expansion units have been used, the second EMX 190 Door Output Channel is 5.
On an AC-1 module the Door Output Channel will always be 1.
The door output relay can be a normally open or normally closed device.

**Invert**
Click this checkbox to invert the meanings of Locked and Unlocked. This is useful when the door lock relay is actuated when the door is locked, which renders Locked and Unlocked backwards for the Door Lock setting.

**Door Strike Seconds**
Enter the number of seconds the door is to remain unlocked after a valid access. When setting this number, consider the distance from the card reader to the door. If the door switch is used, the door locks 1 second after the door changes state.
Door Ajar Seconds

Enter the number of seconds, 0 to 255, that you want the door to be ajar after the Door Strike Seconds have elapsed. If the door remains ajar longer than the number of seconds you specify, the control system considers this a Door Ajar access event. This event will be sent to the Event Viewer.

ADA Output Channel (AC-1 Plus Specific)

Enter the number of the ADA output channel number to which an electronic door opener is wired. After a card swipe that Continuum identifies as a person with ADA privileges, the output causes the door to unlock. To get the number, look at the controller hardware. Every output connection area (known as a channel) on every type of controller is numbered. Type the channel number as it is marked on the controller.

ADA Output Strike Seconds (AC-1 Plus Specific)

Enter the number of seconds you want the door to remain unlock after a valid access by personnel with disabilities. This attribute accommodates those who need extra time to get through the door.

ADA Door Ajar Seconds (AC-1 Plus Specific)

Enter the number of seconds, 0 to 255; the door can be ajar after the ADA Output Strike Seconds have elapsed. If the door remains ajar longer, the control system considers this a Door Ajar access event, which is sent to the Event Viewer (for ADA personnel only).

Alarm Output Channel

If you have installed a flashing or beeping alarm for the door, enter the channel number to which the alarm is wired.

Channel 9 on an ACX 781 controller is a spare channel. Connect it to a light or some other signaling device physically near the door. In the event of an alarm, this channel will be activated.

Use Channel 2 (Auxiliary) for alarm output on an AC-1.

Alarm Relay Seconds

Enter the number of seconds the alarm output channel remains energized when a Door Attribute goes into alarm.

- The alarm output channel remains energized for the time you enter in Alarm Relay Seconds even if the alarm condition has been corrected.
- If a second alarm comes in while this channel is still energized, the Alarm Relay Seconds resets to 0, and starts over with the new alarm.
- You can select a time in seconds ranging from 0 to 255, and the default is 60 seconds.

Andover Continuum CyberStation Configurator’s Guide 18-13
**Supervised Input Types**
All 700 / 780 controller series inputs are supervised inputs.
All inputs on an AC-1 are supervised inputs.

**Door Switch Input Type, Exit Request Input Type, Bond Sensor Input Type**
The table below summarizes the selections in the dropdown menus in these fields based upon your switch configuration. Wiring configurations for each switch type are shown on the following page.

<table>
<thead>
<tr>
<th>Supervised Input Type</th>
<th>Switch Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>NOSeries</td>
<td>Normally-open switch with a resistor in series.</td>
</tr>
<tr>
<td>NOParallel</td>
<td>Normally-open switch with a resistor in parallel.</td>
</tr>
<tr>
<td>NOSerPar</td>
<td>Normally-open switch with a resistor in parallel and an added resistor in series.</td>
</tr>
<tr>
<td>NCSeries</td>
<td>Normally-closed switch with a resistor in series.</td>
</tr>
<tr>
<td>NCPParallel</td>
<td>Normally-closed switch with a resistor in parallel.</td>
</tr>
<tr>
<td>NCSerPar</td>
<td>Normally-closed switch with a resistor in parallel and an added resistor in series.</td>
</tr>
</tbody>
</table>

The table below summarizes the ACX781 door switch configuration options.

<table>
<thead>
<tr>
<th>Supervised Inputs</th>
<th>Controller and Expansion Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - 8</td>
<td>700 Series Inputs</td>
</tr>
<tr>
<td>9 or 10</td>
<td>First Expansion Unit Inputs</td>
</tr>
<tr>
<td>11 or 12</td>
<td>Second Expansion Unit Inputs</td>
</tr>
<tr>
<td>1 - 32</td>
<td>780/781 Controller Inputs</td>
</tr>
</tbody>
</table>

If the wiring is tampered with, the resistance of the circuit changes. This change in resistance causes the switch to go into a **Trouble** state, which can cause the door to go into an alarm condition. You should attach all supervised inputs to a Trouble alarm. The normal state of the switch is the state the switch is in when the door is closed.
## NC Series

**Sensor**
- Contact Closure

**Switch Position**
- AUX or DOOR or REX

**External Resistor**
- 10 K

<table>
<thead>
<tr>
<th>Sensor</th>
<th>Switch Position</th>
<th>Resistance Value</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Closed</td>
<td>Closed</td>
<td>10 K</td>
<td>Off</td>
</tr>
<tr>
<td>Open</td>
<td>Open</td>
<td>Infinite</td>
<td>On</td>
</tr>
<tr>
<td>Shorted</td>
<td>Open</td>
<td>10 K</td>
<td>On</td>
</tr>
<tr>
<td>Wire cut</td>
<td>Open</td>
<td>Infinite</td>
<td>On</td>
</tr>
</tbody>
</table>

## NO Series

**Sensor**
- Contact Closure

**Switch Position**
- AUX or DOOR or REX

**External Resistor**
- 10 K

<table>
<thead>
<tr>
<th>Sensor</th>
<th>Switch Position</th>
<th>Resistance Value</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Closed</td>
<td>Open</td>
<td>Infinite</td>
<td>Off</td>
</tr>
<tr>
<td>Open</td>
<td>Closed</td>
<td>10 K</td>
<td>On</td>
</tr>
<tr>
<td>Shorted</td>
<td>Closed</td>
<td>Zero K</td>
<td>On</td>
</tr>
<tr>
<td>Wire cut</td>
<td>Open</td>
<td>Infinite</td>
<td>On</td>
</tr>
</tbody>
</table>

## NC Parallel

**Sensor**
- Contact Closure

**Switch Position**
- AUX or DOOR or REX

**External Resistor**
- 10 K

<table>
<thead>
<tr>
<th>Sensor</th>
<th>Switch Position</th>
<th>Resistance Value</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Closed</td>
<td>Closed</td>
<td>Zero K</td>
<td>Off</td>
</tr>
<tr>
<td>Open</td>
<td>Open</td>
<td>10 K</td>
<td>On</td>
</tr>
<tr>
<td>Shorted</td>
<td>Shorted</td>
<td>Zero K</td>
<td>On</td>
</tr>
<tr>
<td>Wire cut</td>
<td>Wire cut</td>
<td>Infinite</td>
<td>Trouble</td>
</tr>
</tbody>
</table>

## NO Parallel

**Sensor**
- Contact Closure

**Switch Position**
- AUX or DOOR or REX

**External Resistor**
- 10 K

<table>
<thead>
<tr>
<th>Sensor</th>
<th>Switch Position</th>
<th>Resistance Value</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Closed</td>
<td>Open</td>
<td>10 K</td>
<td>Off</td>
</tr>
<tr>
<td>Open</td>
<td>Closed</td>
<td>Zero K</td>
<td>On</td>
</tr>
<tr>
<td>Shorted</td>
<td>Shorted</td>
<td>Zero K</td>
<td>On</td>
</tr>
<tr>
<td>Wire cut</td>
<td>Wire cut</td>
<td>Infinite</td>
<td>Trouble</td>
</tr>
</tbody>
</table>

## NC Series and Parallel

**Sensor**
- Contact Closure

**Switch Position**
- AUX or DOOR or REX

**External Resistor**
- 10 K

<table>
<thead>
<tr>
<th>Sensor</th>
<th>Switch Position</th>
<th>Resistance Value</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Closed</td>
<td>Closed</td>
<td>5 K</td>
<td>Off</td>
</tr>
<tr>
<td>Open</td>
<td>Open</td>
<td>10 K</td>
<td>On</td>
</tr>
<tr>
<td>Shorted</td>
<td>Shorted</td>
<td>Zero K</td>
<td>On</td>
</tr>
<tr>
<td>Wire cut</td>
<td>Wire cut</td>
<td>Infinite</td>
<td>Trouble</td>
</tr>
</tbody>
</table>

## NO Series and Parallel

**Sensor**
- Contact Closure

**Switch Position**
- AUX or DOOR or REX

**External Resistor**
- 10 K

<table>
<thead>
<tr>
<th>Sensor</th>
<th>Switch Position</th>
<th>Resistance Value</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Closed</td>
<td>Open</td>
<td>10K</td>
<td>Off</td>
</tr>
<tr>
<td>Open</td>
<td>Closed</td>
<td>5 K</td>
<td>On</td>
</tr>
<tr>
<td>Shorted</td>
<td>Shorted</td>
<td>Zero K</td>
<td>On</td>
</tr>
<tr>
<td>Wire cut</td>
<td>Wire cut</td>
<td>Infinite</td>
<td>Trouble</td>
</tr>
</tbody>
</table>
Exit Request Input Channel
Enter the channel number as it is marked on the controller. To get the number, look at the controller hardware. Every input connection area (known as a channel) on every type of controller is numbered. Type the channel number as it is marked on the controller.

The Exit Request Input for an AC-1 is Channel 3.

Exit Request Input Type
Select a resistor type (10K Ohms) from the dropdown menu.

Unlock on Exit Request
Select the Unlock on Exit Request checkbox if you want to unlock the door every time an exit request occurs. Otherwise, clear the checkbox.

Door Switch Input Channel
The door switch input channel monitors whether the door is open or closed. Enter the channel number to which the door switch is wired. To get the number, look at the controller hardware. Every input connection area (known as a channel) on every type of controller is numbered. Type the channel number as it is marked on the controller. The Door Switch Input for an AC-1 is Channel 2.

Door Switch Input Type
Select a resistor type from the dropdown menu. (Same options as Exit Request Input Type.)

Relock upon Door Closure
Not implemented in this release.

Request to Exit Device
Not implemented in this release.

Motion Detector
A motion detector is an input mounted on a wall. It can be integrated into a Door as a request to exit device or as an independent unit used to detect intrusion.

Bond Sensor Input Channel – Controller-Specific (Currently AC-1 Plus)
Enter the channel number to which the bond sensor is wired. The bond sensor determines the physical latch position. To get the number, look at the controller hardware. Every input connection area (known as a channel) on every type of controller is numbered. Type the channel number as it is marked on the controller.

Bond Sensor Input Type – Controller-Specific (Currently AC-1 Plus)
Select a resistor type from the dropdown menu. (Same options as Exit Request Input Type.)

ADA Exit Request Input Channel –
Enter the channel number to which the ADA Exit Request Input is wired. The ADA Exit Request Input requests that the door be
Controller-Specific (Currently AC-1 Plus) opened (when the request is transmitted made the system presumes that the door is unlocked) to allow exit from a restricted area for a disabled person. To find the channel number, look at the controller hardware. Every input connector area (known as a channel) on every type of controller is numbered, type in the channel number as it appears on the controller.

ADA Exit Request Input Type – Controller-Specific (Currently AC-1 Plus) Select a supervised input connection scheme from the ADA Exit Request dropdown menu.

ADA Input Channel – Controller-Specific (Currently AC-1 Plus) Enter the channel number to which the ADA Input is wired. The ADA input requests that the door be opened, (when the request is transmitted made the system presumes that the door is unlocked) providing a disabled person with an entrance to a restricted area. To find the channel number, look at the controller hardware. Every input connector area (known as a channel) on every type of controller is numbered, type in the channel number as it appears on the controller.

ADA Input Type– Controller-Specific (Currently AC-1 Plus) Select a supervised input connection scheme from the ADA Input dropdown menu.
The Options Tab

The Options tab lets you specify schedules that lock and unlock the door, and select which access events are sent to the Active Event View and logger.

About Associating Schedules with Doors

Continuum offers many different ways to link schedules and doors. The control requirements of a particular building or area will determine how you should configure the Door editor to permit or deny access based on schedules. For example, a lobby door may have different locking requirements than one door of many into an auditorium.

There are two places in the Door editor where you can link to a schedule, and there are checkboxes that affect the relationship between the Door and schedules. You will be using a combination of some of these options, not all of them at once.

The fields where you link the Door to schedules are labeled as Schedule fields. The objects you attach in the Schedule fields are the InfinityNumerics that are turned on and off by the schedules. You do not attach the Schedule objects themselves.
Browse for and select an InfinityNumeric controlled by the Schedule if you want to control this Door with the following conditions:

- When this schedule is **On**, the door is locked but access is permitted to all Personnel by card swipe and/or keypad entry. (Allow use of door.)

- When this schedule is **Off**, the door is locked and card reader and/or keypad access is denied to all Personnel. (No access.)

If you associate a schedule with this field, you must enable it with the Access Validation checkboxes on the Entry Reader and/or Exit Reader tabs of the Door editor. The state of this schedule has no effect on the operation of a request-to-exit device.

Browse for and select an InfinityNumeric controlled by the Schedule if you want to control this Door with the following conditions:

- When this schedule is **On**, the door is unlocked. (Door unlocked.)

  When this schedule is **On**, Continuum, in effect, ignores this door and any other schedules attached on the Entry Reader and/or Exit Reader tabs of the Door editor.

- When this schedule is **Off**, the door is locked but access is permitted to all Personnel by card swipe and/or keypad entry. (Allow use of door.)

You could use this for a lobby where you want doors to remain unlocked during business hours, but have controlled access after hours.

Select one of the following control options:

**Area Based Control**
Select this option if you want to enforce Anti-Passback violations based on areas.

Area-based violations occur when personnel attempt access from a non-adjacent area. This could occur if they tailgated into an area.

Adjacent Area objects have at least one common door in their respective lists. As people move through areas, Continuum keeps track of the last area entered by each person. A person causes a violation when they try to use a door that isn’t in the list of their last known Area.

**Zone Number Based Control** – Not implemented in this release

Access events that are not selected are not saved in the database. Events that are selected are logged and sent to the Event Viewer.
### Events

<table>
<thead>
<tr>
<th><strong>Valid Attempts</strong></th>
<th>A valid attempt access event occurs when a card number or access code has been accepted as valid and the door switch detects that the door has opened.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Invalid Attempts</strong></td>
<td>An invalid attempt access event occurs when a card number or access code is rejected and access is denied.</td>
</tr>
<tr>
<td><strong>Exit Requests</strong></td>
<td>An exit request access event occurs when someone uses a keypad, card reader, motion detector, or Request-to-Exit button to ask the system to unlock a door so the person can leave an area or zone.</td>
</tr>
<tr>
<td><strong>Forced Entries</strong></td>
<td>A forced entry access event occurs when the door switch detects that the door lock is locked and the door switch is open, or the input is tampered with (Trouble).</td>
</tr>
<tr>
<td><strong>Door Ajar</strong></td>
<td>A door ajar access event occurs when a door remains open longer than the number of seconds specified for the <strong>Door Strike</strong> and <strong>Door Ajar</strong> attributes combined.</td>
</tr>
<tr>
<td><strong>Valid Access – No Entry</strong></td>
<td>A valid access – no entry event occurs when a card number or access code has been accepted as valid and the door switch detects that the door has not opened.</td>
</tr>
</tbody>
</table>
The XDriver Tab
Select the comm port for the XDriver associated with this Door (if using Xdriver based access control).

The Entry Reader Tab
The **Entry Reader** tab lets you enter card reader and keypad hardware specifics. Also make selections that determine what the controller does with information taken from the reader and keypad and how it determines whether or not to open the door.
<table>
<thead>
<tr>
<th>Reader IOU</th>
<th>If you are using a NetController, enter the number of the IOU module connected to the card reader. On NetControllers, IOU module numbers are on the IOU Module tab of the IOU Module editor. On 9000-series controllers, you use a 700-series Infinet controller, which has no IOU modules. Leave the Reader IOU number at zero in this case.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reader Channel</td>
<td>Enter the channel number connected to the reader. An AC-1 Reader Channel will be 1.</td>
</tr>
<tr>
<td>Keypad Channel</td>
<td>Enter the channel number connected to the keypad. An AC-1 Keypad Channel will be 1.</td>
</tr>
<tr>
<td>Area</td>
<td>Browse for the Area to which this Door will give access.</td>
</tr>
<tr>
<td>Validate Reader or PIN</td>
<td>Not implemented in this release.</td>
</tr>
<tr>
<td>Access Validation</td>
<td>In the Access Validation area, select the conditions the controller uses to decide whether to open the door. You select each condition by selecting up to three modes of operation for it.</td>
</tr>
<tr>
<td>Validation Conditions</td>
<td>The list below contains the validation conditions:</td>
</tr>
</tbody>
</table>

- **Validate Site**
  - Check access cards for a valid site code.

- **Validate Card**
  - Check access cards for valid card numbers.

- **Validate PIN**
  - Check the numbers pressed at the keypad to see if they form a valid personal identification number (PIN).

- **General Code**
  - Check the numbers pressed at the keypad to see if they form a valid general access code.

- **Door Forced Lock Schedule**
  - Check this box to control this Door with the following conditions:
    - When this schedule is On, the door is locked and card reader and/or keypad access is denied to all Personnel. (No access.)
    - When this schedule is Off, the door is unlocked and access is permitted to all Personnel by card swipe and/or keypad entry. (Allow use of door.)

- **Personnel Schedule**
  - Check the personnel schedule to see if it allows a person access at a particular time.

- **Reader Schedule**
  - Not Implemented.
Modes of Operation

Select modes of operation for each condition you want to use by selecting one or more of the Normal, Comm Fail and No Database columns. Note that No Database is available only for Valid Site and General Code.

Normal
The 700-series controller or IOU module is communicating normally.

Comm Fail
Communication between the access server and the 700-series Infinet controller or the IOU module has failed.

No Database
The access server, Infinet controller, or NetController CPU that stores the door information has been reset or has otherwise lost the database. When this occurs, the controller cannot check access card numbers, PINs or schedules against the database. However, the Infinet controller can still check site codes and general codes. An AC-1 only holds the first two site codes in its memory and cannot check the general code.

The Entry Options Tab
Use the Entry Options tab to select from special condition options that help enforce the access validation choices and reader options, such as invalid access events, or personnel requesting access under duress.
<table>
<thead>
<tr>
<th><strong>Reader Enable Schedule</strong></th>
<th>Not implemented in this release.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Department Point</strong></td>
<td>Browse for the InfinityNumeric point that holds the department number of the last person through the door. This number is taken from the Personnel object created when you add a person to the system.</td>
</tr>
<tr>
<td><strong>Timed Anti-PassBack Minutes</strong></td>
<td>Enter the number of minutes during which an individual cannot enter through the same area again. This guards against the practice of passing a card back through an open door for someone else to use, or allowing someone else to use a PIN. This field holds only the last area someone was in for the duration of the anti-passback minutes. It is not a record of the sequence of areas a person had been in.</td>
</tr>
<tr>
<td><strong>Zone Number</strong></td>
<td>Type a number from 0 to 65535, the zone to which this card reader controls access. When an individual passes through a door, the person’s zone point is set to the number you assign here. In this way, you can enforce zone-based Anti-PassBack violations. If you are not using zone-based control, leave this number at 0.</td>
</tr>
</tbody>
</table>
The Entry Status Tab

The Entry Status tab lets you view the following information about the door’s entry status.

<table>
<thead>
<tr>
<th>Current Operating Mode</th>
<th>Card mode, Site mode and Card mode, and PIN mode.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Person Admitted</td>
<td>The name of the person associated with the last card number or access code used to go through the door.</td>
</tr>
<tr>
<td>Time Admitted</td>
<td>The time the last person when through the door.</td>
</tr>
<tr>
<td>Last Person’s Department</td>
<td>The last person’s department number, taken from the associated Personnel object.</td>
</tr>
</tbody>
</table>
**Last Invalid Person**  
The name of the person who last attempted to enter, but was not granted access.

**Last Invalid Time**  
The time of the last invalid attempt.

**Last card number**  
The number encoded in the last valid card swiped.

**Last site number**  
The site code encoded in the last card swiped. (Wiegand cards only, as the last card number for ABA cards is always 0.)

**Entry Count**  
The total number of personnel that have entered through the door. Use a Plain English statement to reset this count, for example:

Set `DoorName EntryCount to 0`

Entry and Exit have separate counts.

**The Exit Reader Tab**  
The Exit Reader tab lets you enter hardware specifics about the card reader and keypad used for exiting an area. This tab is configured the same way as the Entry Reader tab.

![Exit Reader Tab](image)
Entering IOU, Channel and Area Information
For the reader to work properly with the controller, provide the following:

**Reader IOU**
For a NetController, enter the number of the IOU module connected to the card reader (IOU module numbers are on the **IOUModule** tab of the IOUModule editor). 700-series controllers have no IOU modules, so set this field to zero.

**Reader Channel**
Enter the channel number as it is marked on the controller.

**Keypad Channel**
Enter the channel number connected to the keypad as it is marked on the controller.

**Area**
Type in or browse for the path and name of the Area object where this door is located.

**Validate Reader or PIN**
Not implemented in this release.

Access Validation
In the **Access Validation** area, select the conditions the controller uses to decide whether to open the door. Select up to three modes of operation for each condition.

**Validation Condition**
Select to Make the Controller Check.

**Validate Site**
Access cards for a valid site code.

**Validate Card**
Access cards for valid card numbers.

**Validate PIN**
To see if numbers typed at a keypad are a valid PIN.

**General Code**
If numbers typed at a keypad are valid general access codes.

**Door Forced Lock Schedule**
Check this box to control this **Door** with the following conditions:

- When this schedule is **On**, the door is locked and card reader and/or keypad access is denied to all Personnel. (No access.)
- When this schedule is **Off**, the door is unlocked and access is permitted to all Personnel by card swipe and/or keypad entry. (Allow use of door.)

**Personnel Schedule (always on)**
The personnel schedule to see if a particular person should be allowed access at a particular time. Always on.

**Reader Schedule**
Not Implemented.
**Modes of Operation**
Select modes of operation for each condition you want to use by selecting one or more of the **Normal**, **Comm Fail**, and **No Database** columns. Note that **No Database** is available only for **Valid Site** and **General Code**:

**Normal**
The 700-series controller or the IOUModule is functioning normally.

**Comm Fail**
Communication failure between the access server and the 700-series controller or the IOU module.

**No Database**
The access server, Infinet controller, or NetController CPU that stores the door information reset or otherwise lost the database. The controller cannot check access card numbers, PINS or schedules against the database, but can still check site codes and general codes.

**The Exit Options Tab**
Use the **Exit Options** tab to select from special condition options that help enforce the access validation choices and reader options, such as entry or egress violations, or personnel requesting access under duress. This tab is configured the same as the **Entry Options** tab.

**Reader Enable Schedule**
Not implemented in this release.
<table>
<thead>
<tr>
<th><strong>Department Point</strong></th>
<th>Browse for the Numeric point that holds the department number of the last person through the door. This number is taken from the Personnel object created when you add a person to the system.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Timed Anti-PassBack Minutes</strong></td>
<td>Enter the number of minutes during which an individual cannot re-exit through the same door again. This guards against the practice of passing a card back through an open door for someone else to use, or allowing someone else to use a PIN. 0=off.</td>
</tr>
<tr>
<td><strong>Zone Number</strong></td>
<td>Type a number from 0 to 65535, the zone to which this card reader controls access. When an individual passes through a door, the person’s zone point is set to the number you assign here. In this way, you can enforce zone-based Anti-PassBack violations. If you are not using zone-based control, leave this number at 0.</td>
</tr>
</tbody>
</table>

### Reader Options

<table>
<thead>
<tr>
<th><strong>Allow Exit on a Timed Anti-PassBack Violation</strong></th>
<th>Allow re-exit to an area within the time in <strong>Timed Anti-Passback Minutes</strong>.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Anti-PassBack Protection</strong></td>
<td>Makes the controller check for individuals who have tailgated. The controller records a violation when someone tries to access an area that can only be accessed by going through other areas first, and the controller has no record of that person going through them.</td>
</tr>
<tr>
<td><strong>Allow Exit on an Anti-PassBack Violation</strong></td>
<td>Select this checkbox to permit access even though it appears the individual has tailgated.</td>
</tr>
<tr>
<td><strong>PIN Duress</strong></td>
<td>Lets personnel signal a duress situation when forced into an area by an unauthorized individual. Personnel enter their PIN or the general code, and then press the star key (*) instead of the pound key. You can set up an alarm to go off when this occurs.</td>
</tr>
<tr>
<td><strong>Reverse Card Duress</strong></td>
<td>Lets personnel signal a duress situation when an access card is not swiped properly. You can set up an alarm to go off when this occurs.</td>
</tr>
<tr>
<td><strong>Allow Exit on a Reverse Card</strong></td>
<td>Allow an exit when a card is swiped with the front of the card facing the building rather than away from it. (This does not work for proximity cards.)</td>
</tr>
</tbody>
</table>

Anti-This is referred to as soft anti-passback. This is an Anti-PassBack Violation only upon area reentry.
PassBack Violation Only on Area Reentry

This option will permit access even though it appears the individual has tailgated.

This checkbox becomes available if the Anti-PassBack Protection checkbox was first selected.

The Exit Status Tab

The Exit Status tab lets you view the following information about the door’s exit status.

Current Operating Mode
Card mode, Site mode and Card mode, and PIN mode.

Last Person Admitted
The name of the person associated with the last card number or access code used to go through the door.

Time Admitted
The time the last person went through the door.

Last Person’s Department
The last person’s department number, taken from the associated Personnel object.

Last Invalid Person
The name of the person who last made an unsuccessful attempt to enter.

Last Invalid Time
The time of the last invalid attempt.

Last card number
The number encoded in the last card swiped.
<table>
<thead>
<tr>
<th><strong>Last site number</strong></th>
<th>The site code in the last card swiped. (Wiegand cards only: the last card number for ABA cards is always 0.)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Exit Count</strong></td>
<td>The total number of people who have exited through the door. Use a Plain English statement to reset this count, for example: Set <em>DoorName</em> ExitCount to 0</td>
</tr>
</tbody>
</table>
The Alarms Tab
Return to this tab to configure alarms after you have set other Door attributes and saved the object. Alarms are discussed in Chapter 10, *Configuring Alarms*.

<table>
<thead>
<tr>
<th>Exit Points</th>
<th>Channels</th>
<th>Alarms</th>
<th>Access Events</th>
<th>Entry Options</th>
<th>Entry Reader</th>
<th>Exit Reader</th>
<th>Exit Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

[Image of the Alarms Tab interface]
The Access Events Tab
Use this tab of the Door editor to review the access activities for this door. It is an event viewer for this door only that shows access events as they occur. Below is a description of the Access Events tab columns.

<table>
<thead>
<tr>
<th>Event Class</th>
<th>Time Stamp</th>
<th>Person</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unauthorized Open Door Cleared</td>
<td>2/9/02 2:00:30 PM</td>
<td></td>
</tr>
<tr>
<td>Unauthorized Open Door</td>
<td>2/9/02 2:00:22 PM</td>
<td></td>
</tr>
<tr>
<td>Unauthorized Open Door Cleared</td>
<td>2/9/02 2:00:22 PM</td>
<td></td>
</tr>
<tr>
<td>Unauthorized Open Door</td>
<td>2/9/02 2:00:03 PM</td>
<td></td>
</tr>
<tr>
<td>Unauthorized Open Door Cleared</td>
<td>2/9/02 2:00:03 PM</td>
<td></td>
</tr>
<tr>
<td>Door Channel Override Cleared</td>
<td>2/9/02 2:00:53 PM</td>
<td></td>
</tr>
<tr>
<td>Door Channel Override And Door Locked</td>
<td>2/9/02 2:01:44 PM</td>
<td></td>
</tr>
<tr>
<td>Unauthorized Open Door Cleared</td>
<td>2/9/02 1:50:14 PM</td>
<td></td>
</tr>
<tr>
<td>Unauthorized Open Door</td>
<td>2/9/02 1:50:14 PM</td>
<td></td>
</tr>
<tr>
<td>Unauthorized Open Door Cleared</td>
<td>2/9/02 1:50:14 PM</td>
<td></td>
</tr>
<tr>
<td>Unauthorized Open Door</td>
<td>2/9/02 1:49:41 PM</td>
<td></td>
</tr>
<tr>
<td>Unauthorized Open Door Cleared</td>
<td>2/9/02 1:49:41 PM</td>
<td></td>
</tr>
<tr>
<td>Unauthorized Open Door</td>
<td>2/9/02 1:49:41 PM</td>
<td></td>
</tr>
<tr>
<td>Unauthorized Open Door Cleared</td>
<td>2/9/02 1:49:41 PM</td>
<td></td>
</tr>
<tr>
<td>Door Channel Override Cleared</td>
<td>2/9/02 1:49:41 PM</td>
<td></td>
</tr>
<tr>
<td>Door Channel Override And Door Locked</td>
<td>2/9/02 1:49:41 PM</td>
<td></td>
</tr>
<tr>
<td>Unauthorized Open Door Cleared</td>
<td>2/9/02 1:49:41 PM</td>
<td></td>
</tr>
<tr>
<td>Unauthorized Open Door</td>
<td>2/9/02 1:49:41 PM</td>
<td></td>
</tr>
<tr>
<td>Unauthorized Open Door Cleared</td>
<td>2/9/02 1:49:41 PM</td>
<td></td>
</tr>
<tr>
<td>Unauthorized Open Door</td>
<td>2/9/02 1:49:41 PM</td>
<td></td>
</tr>
<tr>
<td>Unauthorized Open Door Cleared</td>
<td>2/9/02 1:49:41 PM</td>
<td></td>
</tr>
<tr>
<td>Door Channel Override Cleared</td>
<td>2/9/02 1:49:41 PM</td>
<td></td>
</tr>
<tr>
<td>Door Channel Override And Door Locked</td>
<td>2/9/02 1:49:41 PM</td>
<td></td>
</tr>
<tr>
<td>Unauthorized Open Door Cleared</td>
<td>2/9/02 1:49:41 PM</td>
<td></td>
</tr>
<tr>
<td>Unauthorized Open Door</td>
<td>2/9/02 1:49:41 PM</td>
<td></td>
</tr>
<tr>
<td>Unauthorized Open Door Cleared</td>
<td>2/9/02 1:49:41 PM</td>
<td></td>
</tr>
<tr>
<td>Unauthorized Open Door</td>
<td>2/9/02 1:49:41 PM</td>
<td></td>
</tr>
<tr>
<td>Unauthorized Open Door Cleared</td>
<td>2/9/02 1:49:41 PM</td>
<td></td>
</tr>
<tr>
<td>Door Channel Override Cleared</td>
<td>2/9/02 1:49:41 PM</td>
<td></td>
</tr>
<tr>
<td>Door Channel Override And Door Locked</td>
<td>2/9/02 1:49:41 PM</td>
<td></td>
</tr>
<tr>
<td>Unauthorized Open Door Cleared</td>
<td>2/9/02 1:49:41 PM</td>
<td></td>
</tr>
<tr>
<td>Unauthorized Open Door</td>
<td>2/9/02 1:49:41 PM</td>
<td></td>
</tr>
<tr>
<td>Unauthorized Open Door Cleared</td>
<td>2/9/02 1:49:41 PM</td>
<td></td>
</tr>
<tr>
<td>Unauthorized Open Door</td>
<td>2/9/02 1:49:41 PM</td>
<td></td>
</tr>
<tr>
<td>Unauthorized Open Door Cleared</td>
<td>2/9/02 1:49:41 PM</td>
<td></td>
</tr>
</tbody>
</table>

**Event Class**
The type or class of access event that has occurred.

**Time Stamp**
The time at which the access event occurred.

**Person**
The name and path of the Personnel object for the person causing the event.

**Area**
Area associated with this event.
Configuring Continuum for Custom ABA Card Access

In addition to supporting the ISO 7811 ABA American Banking Association) standard for magnetic stripe cards, Continuum now provides support for custom ABA access cards. The Continuum standard ABA card format only reads one field (the Primary Account Number or PAN) consisting of 19 digits from the card, which is used to identify the card number. The custom ABA card format expands that capability (in addition to the card number) to provide support for:

- Site code
- Issue Code
- Manufacturer Code

Continuum provides the user with an interface to specify the structure of a custom ABA magnetic stripe card.

Custom ABA Card Rules

In order for Continuum to support custom ABA cards the following requirements apply.

- Andover Continuum CX series controllers connected to AC-1 Plus Door Access modules must be used.
- A door can be configured for ABA Format2 or Custom ABA but not both.
- Only one custom ABA format will be supported at a time.
- The default mode for parsing a card is fixed length. Installations not using fixed length cards must indicate that they are using variable length structures with a special identifier character (V) described later in this section.

Overall Process

The overall process of setting up Continuum to support custom ABA access cards works as follows:

- Define a special Infinity String object in the CX controller editor and name it CustomABAFormat. This allows Continuum to interpret important custom information contained on a person's ABA access card — for example, the site or “facility” code, the issue code, the manufacturer code, and so on.
- Specify the Custom ABA card format in the Door editor.
- Enter the card number and site code of the cardholder in the Personnel editor.
- Once the door is configured for Custom ABA card format, the CX controller sends the value of the string to the AC-1 Plus modules.
- The AC-1 Plus modules use the information in the string to parse card swipes and then send the parsed data (CardNumber, SiteCode, etc) to the CX controller for validation.
**Procedure**

The detailed steps involved in defining and configuring a custom ABA card format are described below.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>In network view of the Continuum Explorer, right click on the CX controller to be configured for the custom ABA format.</td>
</tr>
<tr>
<td>2</td>
<td>Select <strong>New</strong> and <strong>InfinityString</strong> from the dropdown menus.</td>
</tr>
<tr>
<td>3</td>
<td>Type in CustomABAFORMAT in the <strong>Object name</strong> field of the <strong>New</strong> dialog.</td>
</tr>
<tr>
<td>4</td>
<td>Click on the <strong>Create</strong> button. The InfinityString editor will appear.</td>
</tr>
<tr>
<td>5</td>
<td>Set the <strong>String Size</strong> field of the <strong>General</strong> tab to 60 or less characters. 132 is the default. If you enter more than 60 you will receive an error message (only on CX reload).</td>
</tr>
<tr>
<td>6</td>
<td>Ensure that the <strong>Setpoint</strong> checkbox is checked (the string must be identified as a setpoint) and click on the <strong>Apply</strong> button.</td>
</tr>
<tr>
<td>7</td>
<td>In the <strong>Value</strong> field of the <strong>General</strong> tab enter the unique alphanumeric characters for the CustomABAFORMAT string.</td>
</tr>
<tr>
<td>8</td>
<td>Click <strong>OK</strong> to save the CustomABAFORMAT Infinity String.</td>
</tr>
<tr>
<td>9</td>
<td>Open the Door editor associated with the CustomABAFORMAT CX controller selected in step 1.</td>
</tr>
<tr>
<td>10</td>
<td>In the <strong>Card Formats</strong> tab, click on the <strong>Card Format ABA</strong> radio button.</td>
</tr>
<tr>
<td>11</td>
<td>Click on the <strong>ABA Formats Custom</strong> checkbox.</td>
</tr>
<tr>
<td>12</td>
<td>In <strong>AccessValidation</strong> section of the <strong>Entry Reader</strong> tab, enable the <strong>Validate Site</strong> checkboxes plus any other applicable checkboxes.</td>
</tr>
<tr>
<td>13</td>
<td>Repeat step 13 for the <strong>Exit Reader</strong> tab.</td>
</tr>
<tr>
<td>14</td>
<td>Click on the <strong>OK</strong> button to save the settings to the Door editor.</td>
</tr>
<tr>
<td>15</td>
<td>Open the Personnel editor for the person holding a CustomABAFORMAT access card.</td>
</tr>
<tr>
<td>16</td>
<td>Select <strong>CustomMagStripe</strong> from the <strong>Card Type</strong> drop down menu.</td>
</tr>
<tr>
<td>17</td>
<td>Enter the correct numbers in the <em>Site Code</em> and <em>Card Number</em> fields.</td>
</tr>
<tr>
<td>18</td>
<td>Click the <strong>OK</strong> button to save the settings to the Personnel editor.</td>
</tr>
<tr>
<td>19</td>
<td>Repeat steps 15-18 for each custom ABA cardholder.</td>
</tr>
</tbody>
</table>

* Site Code is optional, if it is not used, set it to zero.

**Guidelines for Creating a CustomABAFORMAT Infinity String**

The special name CustomABAFORMAT (step 3 above) together with the unique alphanumeric InfinityString that you enter as its value (step 7 above) is what tells Continuum how to interpret and validate the information on a person’s custom ABA card.

Every CX controller that has AC-1 Plus IOU modules attached will need to have its own instance of the CustomABAFORMAT Infinity String. The string structure must match the layout of the data on the card.
Definitions Associated with ABA Card Formats

Bit — A binary digit with the value of either 0 or 1. Each track consists of a string of bits; bit strings make up an alpha or numeric character.

Start Sentinel — A defined character (bit pattern) in an encoding format. Cannot be all zeros. The Start Sentinel is encoded on the magnetic stripe immediately before the first data character and indicates the beginning of data.

Field Separator — A designated character, which separates data fields. Cannot be used for data.

End Sentinel — A defined character (bit pattern) in an encoding format. Cannot be used for data. The End Sentinel is encoded on the magnetic stripe immediately after the last data character and indicates the end of data.

Longitudinal Redundancy Check Character (LCR) — A bit pattern, which is encoded immediately after the End Sentinel. Checks for bit errors in the message, which includes the Start Sentinel, End Sentinel, data, and Field Separators.

Custom ABA Card Structure

ABA cards are digit oriented, not bit oriented. The card structure defines the membership of each digit to one or more of the card fields with each field having a character identifier. The character identifiers are assembled in a CX controller string object (CustomABAFormat), which contains all the information needed to allow the AC-1 Plus IOU modules to parse the card swipes.

The supported card fields are SiteCode, CardNumber, IssueCode and ManufacturerCode. Other elements of the card structure are the Start Sentinel, Field Separator, End Sentinel and the LRC Check.

TAC provides the following card data fields that you must use in defining your structure:

<table>
<thead>
<tr>
<th>Card Field</th>
<th>Alphanumeric Identifier</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start sentinel (for fixed length structure)</td>
<td>T (an ASCII character)</td>
</tr>
<tr>
<td>The start sentinel indicates the beginning of data. See “Definitions”, above.</td>
<td></td>
</tr>
</tbody>
</table>

| Start sentinel (for variable-length structure) | V (an ASCII character) |
| See “Definitions”, above and “Rules and Guidelines” later in this chapter. |

| Site or “facility” code | 1 (a hexadecimal integer) |
| The site code, if used, is a number that identifies your facility. See “Site Code Requirements” later in this chapter. |

<p>| Card number |
| Contains the custom ABA card number. See “Card Number Requirements” later in this chapter. | 2 (a hexadecimal integer) |</p>
<table>
<thead>
<tr>
<th>Card Field</th>
<th>Alphanumeric Identifier</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field separator</strong></td>
<td>S (an ASCII character)</td>
</tr>
<tr>
<td>The field separator separates the digits of one field from another. See “Definitions” on previous page.</td>
<td></td>
</tr>
<tr>
<td><strong>Card issue code</strong></td>
<td>4 (a hexadecimal integer)</td>
</tr>
<tr>
<td>The card issue code, if used, is the number of times a person has been issued a card — second, third, fourth, and so on. See “Card Issue Code Requirements” later in this chapter.</td>
<td></td>
</tr>
<tr>
<td><strong>Manufacturer code</strong></td>
<td>8 (a hexadecimal integer)</td>
</tr>
<tr>
<td>Identifies the card’s manufacturer code See “Manufacturer Code Requirements” later in this chapter.</td>
<td></td>
</tr>
<tr>
<td><strong>Shared-field integers</strong></td>
<td>Any other hexadecimal integer</td>
</tr>
<tr>
<td>Each of these integers indicates that the digit is shared in two or more fields. If you specify shared-field integers, the string structure must be fixed-length. See “Shared-field Integer Requirements” later in this chapter.</td>
<td></td>
</tr>
<tr>
<td><strong>Not used</strong></td>
<td>X (an ASCII character)</td>
</tr>
<tr>
<td>This character indicates digits that are not used within the string structure. See “Rules and Guidelines” later in this chapter.</td>
<td></td>
</tr>
<tr>
<td><strong>End sentinel</strong></td>
<td>Z (an ASCII character)</td>
</tr>
<tr>
<td>The end sentinel indicates the end of data See “Definitions” on previous page.</td>
<td></td>
</tr>
<tr>
<td><strong>Longitudinal Redundancy Check (LRC)</strong></td>
<td>L (an ASCII character)</td>
</tr>
<tr>
<td>The LRC checks for bit errors when the card is read. See “Definitions” on previous page.</td>
<td></td>
</tr>
<tr>
<td><strong>Raw Data Mode</strong></td>
<td>R (an ASCII character)</td>
</tr>
<tr>
<td>To read the raw data encoded on a card set the first character to R. See “Raw ABA Data Mode” later in this chapter.</td>
<td></td>
</tr>
</tbody>
</table>
Example of a CustomABAFormat String
As an example, you might enter the following value as a CustomABAFormat string:

T33112222222222SXXXX8888ZL

Setting the CustomABAFormat string to the value shown above, tells Continuum to interpret the information read from a custom ABA card as follows:

- The first digit (T) is the start sentinel.
- The second and third digits (33) are the first two digits of the site code as well as the first two digits of the card number since both fields share them.
- Digits 4 – 6 (111) are the remaining digits of the site code.
- Digits 7 – 15 (222222222) are the remaining digits of the card number.
- Digit 16 (S) is a field separator.
- Digits 17 – 20 (XXX) are ignored by Continuum since they have been marked as not used.
- Digits 21 – 24 (8888) make up the manufacturer code
- Digit 25 (Z) is the end sentinel.
- Digit 26 (L) is the LRC (Longitudinal Redundancy Check)

Now, suppose that a card that has been previously encoded with the following data is swiped at the custom ABA door:

SS10555123456789FS20021040ES (For the purpose of this illustration, SS is the start sentinel, FS is the field separator and ES is the end sentinel)

In accordance with the CustomABAFormat string entered in the example on the previous page, Continuum will interpret the card data like this:

- Site Code 10555
- Card Number 10123456789
- Not Used 2002
- Manufacturer Code 1040

Note that the site code and card number share the same first two digits (10) as determined by the 33 in the string format.
Rules and Guidelines
Here are some important rules and guidelines to follow when entering the string structure value:

- Continuum parses and interprets the card data from left to right, based on the string structure you provide. The leftmost digit becomes the most significant digit. Remember, there is a limit of 60 characters.
- There is a limit to the number of digits each field may have, as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Card number</td>
<td>19 digits</td>
</tr>
<tr>
<td>Site Code</td>
<td>5 digits</td>
</tr>
<tr>
<td>Card issue code</td>
<td>2 digits</td>
</tr>
<tr>
<td>Manufacturer code</td>
<td>16 digits</td>
</tr>
</tbody>
</table>

- In a fixed-length structure, the number of digits in a field of a person's card must match the number of digits in each field of the structure you define. For example, if your facility’s code (site code) is 75 (encoded on the second and third digits on your cards) and your cards use up to 4 digits for the card number (encoded on the fourth through seventh digits) you would configure the CustomABAFormat string as follows:

  T112222...

  When the cards are encoded, any card with a card number less than four digits must be padded to four digits. For example a card with card number 12 must be encoded with 0012 in the card number field.

- In a fixed-length structure, you must use a field separator (S) to correspond with every place it appears in the person's card. For example, if the card contains four field separators, your structure must have four separators, which must appear, in the same location specified by the CustomAAFormat string. If the card has no separators, then your structure would have no separators.

- A variable-length structure can accommodate cards containing fields whose digits vary in length. If the number of digits in a field on a person's card is less than the number of corresponding digits in your structure, then Continuum pads that number with zeros. For example, if a person’s site code is 75 and card number is 1234, and your structure is V11111S222222, then these numbers become:

  00075
  001234

In a variable-length structure, you must use a field separator (S) to separate the fields so the card must be encoded with a field separator to indicate to Continuum where each field ends. Like the following:

```
SS75FS1234FS..................ESLR
```
For the purpose of this illustration SS is the start sentinel, FS is the field separator, and ES is the end sentinel.

- In any structure, the not-used character (X) should correspond with digits that are not used on the card (see example on previous page).
- Any ASCII character, other than A, B, C, D, E, F, L, R, S, T, V, X and Z, is invalid.

**Card Number Requirements**
The field containing the integer 2 represents the card number that is read from a person's custom ABA card. The limit is 19 digits. The largest card number supported is 9999999999999999999. The structure must be fixed-length when one or more digits are shared. (See **Shared Site Code Requirements**, below.) The card number must be entered in the **Card Number** field on the Personnel editor's **General** tab.

**Site Code Requirements**
The field containing the integer 1 represents a person's site. The limit is five digits. The largest site code supported is 65535. The site code is optional. If you have a site code it must be entered in a **Site Codes** field on the Personnel Editor's **General** tab. If your site does not use a site code enter a zero.

**Card Issue Code Requirements**
The field containing the integer 4 represents digits belonging to the card issue code (that is, if your site uses issue codes). The limit is two digits. Continuum reads the issue code (one or two digits) from the card, and attaches the code to the beginning of the person's card number, whereby it becomes part of the card number. The card number is first padded with zeros if necessary until it has the same number of digits as specified in the CustomABAFormat string.

For example, if a person's card number is 751, and his/her issue code is 12 and if the CustomABAFormatString specifies a six-digit card number the resulting card number is: 12000751

Continuum inserts the issue code in front (to the left) of the card number.

**Note:** Because the issue code becomes the first digit (or first two digits) of a person's card number, you must enter this modified card number in the **Card Number** field of the Personnel Editor's General tab, so that Continuum recognizes the issue code. Using the example above, you would enter 12000751.
Manufacturer Code Requirements
The field containing the integer 8 represents digits belonging to the manufacturer code (that is, if your site uses a manufacturer code). The limit is 16 digits.

Note: Because the Continuum editors currently have no field in which you may enter the manufacturer code, you must append the card's actual manufacturer code after the LRC (L) whereby this code becomes the last digits of the structure. For example, if the manufacturer code on your card is 576, then the latter half of the CustomABAFormat string would look similar to this:

...S44XXX888ZL576

where Continuum will reject any cards that does not contain the number 576 in the location specified by the code 888 in the CustomABAFormat string.

Shared-Field Integer Requirements
In two or more fields, you may share any digit that is read from a person's card. To do so, use one or more of the following hexadecimal integers in your string structure:

3, 5, 6, 7, 9,A, B, C, D, E, or F

Each of these integers tells Continuum to read the digit and use it in the fields specified by the integer. For example, the integer 3 means the digit is used in the card number and the site code. For example, the integer D means the digit is used in the site code, the card issue code, and the manufacturer code. (See the table, below.)

Note: To accommodate shared-field integers, your string structure must be fixed-length. You must place the overlapping (shared) integer in the structure from left to right because Continuum parses digits from left to right.

For example, suppose you were sharing two numbers in the site code and card number. (The integer 3 specifies a share between these two fields.) Suppose the person's site code is 75, and his/her card number is 75944. Therefore, the site code and card number fields in your structure would look similar to this:

T332222...

For every combination of shared fields (two, three, or four fields) the following table tells you which hexadecimal integer to use in your string structure.

Note: Each integer below is the sum of the integers that represent the shared fields (1 for site code, 2 for card number, 4 for card issue code, and 8 for manufacturer code). For example, a 9 specifies a share between the site code field (1) and manufacturer code field (8) — in other words, 1 plus 8. For example, a 6 specifies a share between the card number field (2) and the card issue code field (4) — in other words, 2 plus 4.
Use the following table to look up the shared-field integer that you need:

<table>
<thead>
<tr>
<th>To Share Digits in these Fields…</th>
<th>Use this Shared Hexadecimal Integer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Card Number Site Code</td>
<td>3 (represents 2 +1)</td>
</tr>
<tr>
<td>Site Code Card Issue Code</td>
<td>5 (represents 1 + 4)</td>
</tr>
<tr>
<td>Card Number Site Code Card Issue Code</td>
<td>6 (represents 2 + 4)</td>
</tr>
<tr>
<td>Card Number Site Code Card Issue Code</td>
<td>7 (represents 2 + 1 + 4)</td>
</tr>
<tr>
<td>Site Code Manufacturer Code</td>
<td>9 (represents 1 +8)</td>
</tr>
<tr>
<td>Card Number Site Code Manufacturer Code</td>
<td>A (represents 2 +8)</td>
</tr>
<tr>
<td>Card Number Site Code Manufacturer Code</td>
<td>B (represents 2 + 1 + 8)</td>
</tr>
<tr>
<td>Card Issue Code Manufacturer Code</td>
<td>C (represents 4 +8)</td>
</tr>
<tr>
<td>Site Code Card Issue Code Manufacturer Code</td>
<td>D (represents 2 + 1+ 8)</td>
</tr>
<tr>
<td>Card Number Site Code Manufacturer Code</td>
<td>E (represents 2 + 4 +8)</td>
</tr>
<tr>
<td>Card Number Site Code Card Issue Code Manufacturer Code</td>
<td>F (represents 2 + 1 + 4 + 8)</td>
</tr>
</tbody>
</table>

Remember the string structure must be fixed-length.

**Raw ABA Data Mode**

Sometimes it is desirable to read the “raw” data encoded on a card. To do this, the first character that you enter in the CustomABAFormat string must be an R. This character takes the place of the StartSentinel.

When the CX controller detects such a string, it sends a Custom Card event to the Cyberstation and allows the raw card data to appear in an Active Event View whenever the card is swiped. The raw data that appears will be from the StartSentinel digit to the LCR digit.
Creating a New Personnel Object

The following section describes how to complete the tabs of the object editor. You will be typing information into text fields and making selections from dropdown menus in the tabs of the Continuum Personnel editor.

Personnel objects store information about the people who have access to an area. A Personnel object:

- Represents a person in your company, a visitor, or a contractor
- Can be named after the person, for example, T.JONES
- Holds access card codes and the person’s keypad PIN number, used by Doors
- Holds a list of Areas to which the person has access in an access control system

This editor has a badge-making option using Integrated EpiSuite Badging application. You can purchase it and the necessary software from TAC. For installation and use of EpiSuite, refer to Appendix E.

Once you have created the new object, you can review the details of the configuration several different ways:

- Object editor
- Object Properties dialog
- ListView or Class Default ListView
- Command Line
Before You Start

Before configuring a Personnel object, you may need the following information about the person for whom you are creating the object:

- Personal information such as name, blood type, emergency contact, height, weight, hair color, and so on. Only the last name is required.
- Employee information such as office location, supervisor name, vehicle information and social security number.
- Security access information such as card numbers, a list of areas the person can enter, current status, and so on. Required only for use in an Access Control System.

If you are using the badge-making option, Integrated EpiSuite Badging application should be installed. Refer to Appendix E.

About EpiSuite

EpiSuite is a software product that allows the capture of photographs, fingerprints, and signatures, corrects output colors, encodes magnetic stripes and smart chips, prints cards, and performs access control.

When integrated with the Continuum database, you can create photo ID cards that work with Continuum's Personnel objects. That means when these cards are used at access control points, Continuum workstation operators can compare the image in the database to that on the card or the actual cardholder.

When you have the Integrated EpiSuite Badging application installed on your Continuum system, you access EpiSuite’s badging utilities on the **General** tab of the Continuum Personnel editor.
Using the Personnel Editor

The Personnel General Tab
You must fill out the General tab:

- So people can use access cards and/or access codes to access areas on the Area List tab.
- If an access card is lost
- If you need to create or edit a person’s ID badge

![Personnel Editor Interface]

**Name**
From left to right, enter a first name, middle initial or middle name (if applicable) and last name.

**State**
Select Enabled or Disabled from the dropdown menu. This enables or disables a person’s record and all actions, such as area access.

**Activation Date**
Not implemented in this release.
Expiration Date
Enter an expiration date and time for this person’s access card. Expiration Date automatically disables a personnel object when the specified date/time is reached. This is especially useful for contractors or temporary employees.

Card Type
Select this person’s card type from the dropdown menu. Select PIN only if you are using only keypads for access control.

Card Number
Enter the number that is encoded on this person’s card.

Site Code
Enter the site code that is encoded on this person’s card.

PIN
Enter a person’s personal identification number (PIN). If you are using a General Code (one code for all employees), do not enter a PIN.

Visitor
Select if this person is a visitor rather than a permanent employee.

ADA – Controller-Specific (AC-1 Plus)
Select if the person requires assistance due to a disability. This Personnel attribute will cause a door to remain open for the length of time specified in the ADA configuration choices made in the Door editor.

Signature
This read-only field displays this person’s signature, which is part of the badge you can make using the optional EpiSuite Integrated Badging.

Mark Card As Lost
Click this button in the editor if a person has lost his access card. Continuum creates another personnel record for this individual with a .lost file extension. If the card is used after being marked as lost, it will not open a door and it logs into the Event Viewer as an Invalid Attempt.

Issue Temporary Card/Restore Permanent Card
Click the Issue Temporary Card when you are issuing a temporary card to replace a lost card. (The button text changes to Restore Permanent Card.) Enter the card number of the temporary card in the Card Number field.

When you are swapping a temporary card for the found permanent card, click Restore Permanent Card. (The button text changes back to Issue Temporary Card.) Continuum puts the original card number back into the Card Number field.

Make/Edit Badge
Select to start the optional EpiSuite Integrated Badging to create or make changes to an ID badge.
The Area List Tab

The Area List tab lets you specify the areas to which the person (identified in the title bar) is allowed access. The list of areas displays the following information:

- The full path and name of each area.
- The full path and name of the schedule that controls each area.
- The state of the area, either Enabled or Disabled, indicating whether the area is currently accessible.

Continuum provides two methods for selecting and assigning area/s that a person will have access to:

- Multiple areas – using the Add Areas button
- A single area – using the Add Area button

Both methods are described below.

**Multiple Areas**

To assign multiple areas that a person can access, open the Personnel Area List tab (shown above) and proceed as follows:

1. Click on the Add Areas button to display the Area dialog (top of next page).
2. To select multiple areas click on the first area to highlight it, then hold down the Control (Ctrl) key and select the next area by clicking on it with the mouse.

3. Click on the **OK** button to bring up the Personnel editor popup.

4. Click on the **Yes** button to select a schedule to attach. This will open a **Browse** dialog where you will select the object name of the InfinityNumeric that will be set by the schedule.

5. Click on the **No** button if you do not want to attach a schedule. This will open a Confirmation popup.

6. Click on the **OK** button. This returns you to the **Area List** tab of the Personnel editor.
7. To verify that the selected areas have been added to the person, click on the Refresh button.

8. Click on the OK button. This will complete the operation and return the Explorer to the screen.

Single Area

To assign a single area that a person can access, open the Personnel Area List tab (shown above) and proceed as follows:

1. Click the Add Area button to display a dialog for finding and selecting an Area to which this person will have access.
2. Browse for the **Area** that you want to add.
3. Browse for the **Area Schedule** for that **Area**. Select the InfinityNumeric that is controlled by the schedule.
4. Select the **State**.
5. Click **OK**. This inserts the **Area** information.

**Note:** The **Areas** you add to the Area List tab do not get added to the Continuum database until you click the **Apply** button, or you click the Personnel editor’s **OK** button to exit the editor.

To remove an area from the Area List, select it, and click the **Remove Area** button.
The **Privileges Tab**

Use the **Privileges** tab to enter information defining a person’s access privileges.

<table>
<thead>
<tr>
<th>Zone Point</th>
<th>Custom Control Fields</th>
<th>Allow Anti-PassBack</th>
<th>Disable Card if not used in Days</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browse for a <strong>Numeric</strong> point.</td>
<td>Used only if TAC created custom controls as part of the installation.</td>
<td>Check this checkbox to let this person access an area regardless of an Anti-Pass violation.</td>
<td>Enter the number of days of inactivity after which the access card is disabled.</td>
</tr>
</tbody>
</table>

If such a violation occurs, it is recorded in the event log, but the person is granted access to the area.
The Employee Info Tab
Use the Employee Info tab to enter optional employment-related information.

- **Department**: Enter the name of the department for which this person works.
- **Dept Number**: Enter the number of the department for which this person works. This number will be stored in every door object's department point every time this person gains access through a door. In this way, the control system tracks which departments use which doors. Number limit: 65535
- **Employee Number**: Enter this person's employee number.
- **Supervisor**: Enter the name of this person's supervisor.
- **Office Phone**: Enter this person's office phone number.
- **Office Location**: Enter the location of this person's office.
- **Title**: Enter this person's job title.
- **Parking Sticker**: Enter the number of this person's parking sticker.
<table>
<thead>
<tr>
<th><strong>Vehicle Info</strong></th>
<th>Enter vehicle information, such as year and make, for this person.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>License</strong></td>
<td>Enter this person's license number</td>
</tr>
<tr>
<td><strong>Social Security #</strong></td>
<td>Enter this person's Social Security number.</td>
</tr>
<tr>
<td><strong>Start Date</strong></td>
<td>Enter the date this person started work.</td>
</tr>
<tr>
<td><strong>Info 1 – Info 6</strong></td>
<td>The six attributes under Dept Number can be customized for your company's purposes.</td>
</tr>
</tbody>
</table>
The Personal Info Tab
The Personal Info tab lets you enter optional personal information such as home address, physical characteristics, and an emergency contact.

Address: Enter this person's home street address.
City: Enter the city in which this person lives.
State: Enter the state in which this person lives.
ZIP: Enter this person's ZIP code.
Country: Enter the country in which this person lives.
Emergency: Enter the name of this person's emergency contact.
Phone: Enter the phone number of this person's emergency contact.
Home Phone: Enter this person's home phone number.
Date of Birth: Enter this person's date of birth.

19-12 TAC
Hair Color  Enter this person's hair color.

Eye Color  Enter this person's eye color.

Height  Enter this person's height.

Weight  Enter this person's weight.

Sex  Enter this person's sex. Select either Male or Female from the dropdown menu.

Blood Type  Enter this person's blood type.
The Current Status Tab
The Current Status tab shows this person’s current status.

Current Area
The last area entered by this person. Another way to find out the current area is to use a print command with this Personnel object from the Command Line, as in:

PR TJONES

The current information displays in the Response Line.

Current Security Zone
Not implemented in this release

Last Door Entered
The object name of the last door this person went through using an access card and/or access code.

Current Status
Not implemented in this release

Time of Entry
The time and date this person entered the area displayed for Current Area.
The Access Events Tab
This access event viewer shows you the access event activity for this Personnel object. Continuum does not search the database for events for this tab until you click on the tab in the editor.

<table>
<thead>
<tr>
<th>Event Class</th>
<th>Time Stamp</th>
<th>Door</th>
<th>Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>ManualKioskAssign</td>
<td>3/11/02 11:12 AM</td>
<td></td>
<td>Main Lobby</td>
</tr>
<tr>
<td>ManualKioskAssign</td>
<td>3/11/02 11:21 AM</td>
<td></td>
<td>Main Lobby</td>
</tr>
<tr>
<td>ManualKioskAssign</td>
<td>3/11/02 11:21 AM</td>
<td></td>
<td>Main Lobby</td>
</tr>
<tr>
<td>ManualKioskAssign</td>
<td>3/11/02 11:23 AM</td>
<td></td>
<td>Main Lobby</td>
</tr>
<tr>
<td>ManualKioskAssign</td>
<td>3/11/02 11:24 AM</td>
<td></td>
<td>Main Lobby</td>
</tr>
<tr>
<td>ManualKioskAssign</td>
<td>3/11/02 11:24 AM</td>
<td></td>
<td>Main Lobby</td>
</tr>
<tr>
<td>ManualKioskAssign</td>
<td>3/11/02 11:26 AM</td>
<td></td>
<td>Main Lobby</td>
</tr>
</tbody>
</table>

Event Class  The type of class of access event that has occurred.

Time Stamp  The date and time at which the access event occurred.

Door  The name and path of the Door with which the person caused the event.

Area  Area associated with this event.
The Templates Tab
The Templates tab shows you a list of the same Personnel template objects that appear in the Templates/Personnel Templates folder of your Continuum Explorer. Click on a Personnel template here to open the editor for that template.

Use this tab to:

- Add a Personnel Template – Click on the radio button next to the Personnel template that has the Area list you want to apply to the Personnel object you are editing.
- Deselect a Personnel Template – Right-click on the Templates tab. Select Clear Selection from the popup menu. Previous Template areas are removed when switching templates.

Manually added areas are not affected by template changes. Clear Selection keeps all area links.

The Custom Attributes Tab
The Custom Attributes tab will show any custom attributes that have been configured for your system.

Distributing Personnel Objects to Controllers
There are two methods for distributing Personnel objects to controllers:

**Sending Selected Personnel Objects to All Controllers**
Select and right-click the Personnel objects to be sent to the controllers. Click Send To in the dropdown menu and select Controllers.
Sending All Personnel Objects to a Specific Controller

Select and right-click on the controller to which the Personnel objects will be distributed. On the dropdown menu select **Distribute Personnel**.
Managing Personnel Distribution

When personnel are assigned to areas and doors, their information is sent to the controller hardware, where the doors are located. The act of sending this information is called distribution. Several things can get in the way of a clean distribution:

- The controller may be offline for some reason.
- The network may be down.
- There may be an error on the network during the distribution.
- The telephone line connecting a remote site to the main controller may be busy.

In all these cases, the distribution of a personnel object may not make it down to the proper controller immediately. Eventually, the distribution will go through, unless the memory capacity of the controller is exceeded. However, in the meantime, key personnel may not be able to obtain entrance to the area.

Access Distribution View

In CyberStation, you may open a new Continuum application, the Access Distribution View, to display all distribution tasks (also known as distribution-event transactions) and determine their current status – that is, whether they have succeeded, failed, or are “in process.” The Access Distribution View is similar to the Active Alarm View and Active Event View. Instead of active alarms and active events, the Access Distribution View lists active personnel-distribution tasks.

The Access Distribution View is a powerful application. If necessary, you may immediately distribute a single personnel record, in any pending distribution transaction, to its proper controller. This is useful in urgent situations, when a personnel record must be sent to the controller but for some reason, such as those listed above, distribution is not happening.
You may also designate multiple workstations to act as distribution servers. By having more than one workstation perform a distribution, there is less dependency on a single PC. The workstations work together to assure that they do not perform multiple distributions of the same personnel object. The Access Distribution View displays the workstation that is currently distributing or “handling” the distribution of any personnel object. Distribution is enabled for every workstation, by default. To disable a workstation’s ability to distribute records to controllers, set preference 19 (Enable personnel distribution to controllers on the LAN) and/or 20 (Enable personnel distribution to RAS networks) to FALSE on the Preferences tab of the Device editor for any workstation that should not be a distributing workstation. (See Chapter 14 for a description of the settings on the Device editor’s Preferences tab.)

Using Continuum’s General Preferences dialog, you may also set the number of concurrent personnel distributions sent to controllers on each field bus network, as well as set a time interval between these fieldbus distributions. This is done via General Preference settings 12 and 13, as follows:

- **Setting 12: Number of Concurrent Fieldbus Personnel Distributions** — This setting is the number of concurrent personnel distributions that are sent from each workstation to controllers on each field bus network. The default (and minimum) value is 1. Maximum value is 4. This setting, which works in conjunction with setting 13, improves performance by preventing or large numbers of personnel records from flooding field bus controllers.

- **Time Interval Between Fieldbus Personnel Distributions** — This General Preference setting is the amount of time (in milliseconds) that CyberStation waits before it sends another personnel distribution to controllers on the same fieldbus network. The default value is 30. Minimum value is 0. Maximum value is 15000 (15 seconds). This setting, which works in conjunction with setting 12, improves performance by preventing large numbers of records from flooding field bus controllers. It is also useful when there are many workstations performing access distribution. (That is, set it higher if there are many workstations.)

For more information on General Preferences, see the Continuum online help and Chapter 13.
Launching and Populating the Access Distribution View

To launch and populate the Access Distribution View, please follow this procedure:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Double click the Distribution server icon located in your tool tray. The Distribution Properties dialog appears. <strong>Note:</strong> For more information on the Distribution server, please see Chapter 2 or the Continuum online help.</td>
</tr>
</tbody>
</table>
| 2    | Click the Access Distribution View button. The Access Distribution View Summary appears. 

The summary view, which appears initially by default, displays the total number of transactions for each destination network, controller, door, or area based on the status of each transaction. That is, the summary view's columns display total numbers of each transaction, according to status — total failed, total successful, total "in process," and so on. (See Using Columns in Access Distribution View, later in this chapter.) Here is an example of the summary view:

![Access Distribution View Summary](image)

If you wish to switch from summary view to full view (where individual transactions are listed, instead of totals) go to step 3, and apply a filter. **Note:** In order to use the Distribute Now function, you must switch to full view and apply a filter.

| 3    | Switch from summary view to full view. Select Edit filters from the Filters dropdown menu. The Filter dialog appears. |
| 4    | In the Filter dialog, remove the check from the Summary view checkbox, and apply a filter. (See Filtering Distribution Events in Access Distribution View, next.) **Note:** In summary view, Filter dialog attributes are not selectable, except two destinations, Network and Controller. |
| 5    | Click OK. The full Access Distribution View appears. |
| 6    | Select Refresh from the View menu, or click the refresh button icon in the toolbar. **Note:** Access Distribution View remembers your filter settings and launches in full view at your next session. |

Filtering Distribution Events in Access Distribution View

From the Filters dropdown menu, select Edit Filters. Via the Filter dialog, you may select certain criteria based on destination, personnel, and status, to display specific types of distribution-event transactions in the Access Distribution View. For example, you may choose to see transactions for one person, for one area, for one controller, for failed transactions, and so on. Filtering the list greatly narrows your search for anomalies.
Note: When you launch the Access Distribution View initially, the Access Distribution View Summary appears. To switch from summary view to full view, remove the check from the Summary view checkbox at the top of the Filter dialog. The summary view lists the total number of transactions for each destination, based on the status of each transaction. The full view lists the actual, individual transactions, instead of totals. You must apply a filter in order to use the Distribute Now feature. (See Launching and Populating the Access Distribution View, earlier in this chapter.)

Access Distribution View remembers your filter settings. Therefore, these settings are applied in the full view in your next session.

The Filter dialog has three general types of filters:

- **Destination**
- **Personnel**
- **Status**

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Network** | Select the Network radio button, and click the browse button in the Network field, to search for and select a Network object. This displays only the transactions occurring in the selected network.  
From the Browse dialog, use the dropdown menu in the Objects of type field to select Network. No other object class is selectable.  
Highlight the network you want, and its name appears in the Object name field. Click the Select button to select that network and dismiss the Browse dialog. The Network object name appears in the Network field.  
As an option, you can apply an area to the selected network. (See Area, below.) |
| **Controller** | Select the Controller radio button, and click the browse button in the Controller field, to search for and select an InfinityController or InfinityInfinetCtlr object. This displays only the transactions that are controlled by the selected controller.  
From the Browse dialog, use the dropdown menu in the Objects of type field to select InfinityController to make just Infinity controllers selectable, select InfinityInfinetCtlr to make only Infinet controllers selectable, or select All classes to make them both selectable.  
Highlight the controller you want, and its name appears in the Object name field. Click the Select button to select that controller and dismiss the Browse dialog. The controller object name appears in the Controller field.  
As an option, you can apply an area to the selected controller. (See Area, below.) |
| **Door** | Select the Door radio button, and click the browse button in the Door field, to search for and select a Door object. This displays only the transactions occurring at the selected door. From the Browse dialog, use the dropdown menu in the Objects of type field to select Door. No other object class is selectable.  
Highlight the door you want, and its name appears in the Object name field. Click the Select button to select that door and dismiss the Browse dialog. The Door object name appears in the Door field. |
As an option, you can apply an area to the selected door. (See Area, below.)

**Note:** You may deselect any and all radio buttons in the Destination filter section. You need not select any Destination radio button.

**Area**

Check the Area checkbox, and click the browse button in the Area field, to search for and select an Area object. This displays only the transactions that are happening in the selected area.

**Note:** You may select an area as a sole destination, or you may select a network, controller, or door, and then select an area with which to associate it.

In the Browse dialog, use the dropdown menu in the Objects of type to select Area. No other object class is selectable.

Highlight the area you want, and its name appears in the Object name field. Click the Select button to select that area and dismiss the Browse dialog. The Area object name appears in the Area field.

---

**Personnel Filter**

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Personnel Filter</td>
<td>Select this radio button when you do not want to apply any personnel filter, thereby allowing any personnel record to appear in the list of transactions.</td>
</tr>
<tr>
<td>Browse for Personnel</td>
<td>Select this radio button, and click the browse button in this field, to search for one personnel record that you wish to appear in the list of transactions. This path of this person's personnel record object appears in this field.</td>
</tr>
<tr>
<td>Use filters below</td>
<td>Select this radio button when you want to apply a filter, rather than specifying a personnel record. You may apply a filter according to: First Name, Last Name, Department, and Card Number, described below.</td>
</tr>
</tbody>
</table>

**First Name**

Check the First Name checkbox, and enter the first name in the field.

Select the Exact match radio button, and enter a complete first name, if you want to display transactions for all persons who have this first name.

Select the Starts with radio button, and enter a string of characters, if you want to list transactions for all persons whose first names begin with these characters. For example, if you enter KE, the filter finds matches with persons named Kenneth, Kendra, Kelly, Kevin, and so on. Click OK to apply the filter.

**Last Name**

Check the Last Name checkbox, and enter the last name in the field.

Select the Exact match radio button, and enter a complete last name, if you want to display transactions for all persons who have this last name.

Select the Starts with radio button, and enter a string of characters, if you want to list transactions for all persons whose last names begin with these characters. For example, if you enter SIMON, the filter finds matches with persons with last names such as Simon, Simone, Simonson, Simonetti, and so on. Click OK to apply the filter.

**Department**

Check the Department checkbox, and enter the department name in the field.

Select the Exact match radio button, and enter a complete department name, if you want to display transactions for all persons in this department.

Select the Starts with radio button, and enter a string of characters, if you want to list transactions for all persons whose department names begin with these characters.

Click OK to apply the filter.
Card Number: Check the Card Number checkbox, and enter the card number in the field, to display transactions for the person who holds this card number.

Click OK to apply the filter.

<table>
<thead>
<tr>
<th>Status Filter</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Filter</strong></td>
</tr>
<tr>
<td>Success</td>
</tr>
<tr>
<td>Failed</td>
</tr>
<tr>
<td>In Process</td>
</tr>
<tr>
<td>Available</td>
</tr>
<tr>
<td>Controller out of service</td>
</tr>
</tbody>
</table>

**Note:** For each transaction listed in the Access Distribution View, the Status column displays an icon that indicates one of these status conditions. For a description of these icons, please see Using Columns in the Access Distribution View, next.

### Using Columns in the Access Distribution View

Like the Active Alarm View and Active Event View, the Access Distribution View lists its information across many columns. As with the other views, you may add and hide these columns in the Access Distribution View. You may also rename, resize, move, and change the sort order of columns.

**Note:** You cannot add/hide columns in the summary view.

To add or hide a full-view column, perform this procedure:

1. In the full view, select Add/Remove Columns from the View menu.
2. Check the column's checkbox to show this column in the view. Remove the check to hide the column.
3. Click OK in the Add/Remove Columns dialog to apply the change and add/hide the column.

**Note:** You may also right click on a column heading and select Add or Hide from the popup menu. When you select Add, the Add/Hide Columns dialog appears. In this case, go to step 2. When you select Hide, the column over which you have right-clicked is immediately removed from the view.

For information on how to rename, resize, move, and change the sort order of columns, please see Organizing Information in Chapter 10, Configuring Alarms, and apply that information to the Access Distribution View window.

See also: Changing Alarm Sort Order in Chapter 10. In the Continuum online help, please see the following topics: Organizing Information in the Active Alarm View, as well as Changing the Sort Order, Understanding Sort Order, and Sorting in Ascending or Descending Order.
Full View Columns

The following table describes the information that appears in the columns of the full Access Distribution View.

Here is an example of the full view:

![Example of the full view](image-url)

Andover Continuum CyberStation Configurator’s Guide 20-7
<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Shows the current status of the distribution-event transaction. Status conditions that appear in this column (along with their status icons) can be one of the following:</td>
</tr>
<tr>
<td></td>
<td><strong>Status and Status Icon</strong></td>
</tr>
<tr>
<td></td>
<td>Success</td>
</tr>
<tr>
<td></td>
<td>Failed</td>
</tr>
<tr>
<td></td>
<td>In Process</td>
</tr>
<tr>
<td></td>
<td>Available</td>
</tr>
<tr>
<td></td>
<td>Controller out of service</td>
</tr>
<tr>
<td>Destination</td>
<td>Displays the path of the controller to which the information is being distributed.</td>
</tr>
<tr>
<td>Area</td>
<td>Displays the path of the area to which the person has access.</td>
</tr>
<tr>
<td>Department</td>
<td>Displays the department of the person.</td>
</tr>
<tr>
<td>Door</td>
<td>Displays the path of the door through which access is being attempted.</td>
</tr>
<tr>
<td>Personnel</td>
<td>Displays the name of the person whose personnel record is involved in the distribution transaction.</td>
</tr>
<tr>
<td>Card Number</td>
<td>Displays the card number of the person.</td>
</tr>
<tr>
<td>Card Type</td>
<td>Displays the type of card that was specified (via the Personnel editor when the personnel record object was established) for the person.</td>
</tr>
<tr>
<td>Site Code</td>
<td>Displays the site code that is encoded on the card belonging to the person.</td>
</tr>
<tr>
<td>Last Error</td>
<td>Displays the text of the system error occurring in the most recent (or current) transaction. If the most recent transaction is a success, then the word &quot;Success&quot; appears.</td>
</tr>
<tr>
<td>Next Retry</td>
<td>Displays the date and time of the next attempt to process the transaction. Each time a transaction fails, the failure count is incremented. The &quot;next retry&quot; time is based on the number of failures. The transaction is tried less and less frequently as this number of failures increases. For example, the Next Retry time is 10 minutes from the current time for the first failure, 20 minutes for the second failure, 40 minutes for the third failure, 80 minutes for the fourth failure, and so on. This ensures that reoccurring unsuccessful transactions do not have a negative impact on the system.</td>
</tr>
</tbody>
</table>
Priority
Displays either Low or High for the transaction.
A Low priority denotes the "normal" operation of the distribution process. In an emergency situation (for example, when someone is waiting to get into a building) an administrator may click the Distribute Now button to elevate the priority to High. This does not necessarily distribute immediately, but high-priority transactions are processed before low-priority transactions. This is useful when a large distribution is occurring.

Transaction Type
Displays the current type of transaction, which can be one of the following:
- **Update** — Indicates that a new or modified personnel record is being downloaded to the controller. See the status of this download transaction in the Status column.
- **Delete** — Indicates that a personnel record is being deleted from the controller. See the status of this delete transaction in the Status column.
- **AccessModeNormal** — Indicates that the controller has just completed the reload of its database, and personnel records are being re-distributed to the controller, after its reload, to repopulate personnel in the controller. The transaction is responsible for setting the SystemStatus variable back to Normal.

Number of Failures
Displays an integer indicating the number of failed distribution attempts, including "retries."

Locking Workstation
Displays the workstation that is currently processing or "handling" the transaction, regardless of the status. If the locking workstation goes down, the lock on the transaction expires, allowing another workstation to process the transaction.

Summary View Columns
The summary view displays the total number of access-event transactions (an integer) for each destination — network, controller, door, or area, based on the status of each transaction. Summary view columns are:

- Destination
- Total Failed
- Total Available
- Total In Process
- Total Successful
- Total Out of Service
Using Toolbar Buttons in Access Distribution View

The following table describes the toolbar button icons in the Access Distribution View.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Distribute Now" /></td>
<td>Opens the Pending Access Distribution dialog, which allows immediate distribution. This resolves a person’s attempt to access an area. (See Distributing Personnel Immediately – Distribute Now, next.)</td>
</tr>
<tr>
<td><img src="image" alt="Refresh" /></td>
<td>Refreshes the list so that information is up-to-date. (You may also select Refresh from the View menu.)</td>
</tr>
<tr>
<td><img src="image" alt="Sort" /></td>
<td>Enables the column sort function. (You may also select Sort from the View menu.) The sort function works like the sort function in the Active Alarm View and the Active Event View. (Please see Using Columns in the Access Distribution View, earlier in this chapter.)</td>
</tr>
<tr>
<td><img src="image" alt="Help" /></td>
<td>Opens the online help system. (You may also select Contents from the Help menu.)</td>
</tr>
<tr>
<td><img src="image" alt="Right-arrow and left-arrow buttons" /></td>
<td>Displays the next “page” in the view, when the list of transactions is longer than the length of the window. <strong>Note:</strong> The page status line at the bottom of the view (Page x of x) tells you what “page” you are currently viewing in a long list. Click the inner right-arrow button to move to the next page. Click the rightmost button to view the last page. Likewise, click the inner left-arrow button to view the previous page and the leftmost button to view the first page.</td>
</tr>
</tbody>
</table>

**Note:** You may move the **Distribute Now**, **Refresh**, **Sort**, and **Help** buttons as one toolbar. Click and hold the left edge of the **Distribute Now** button, and drag the toolbar to the desired location. Click and drag the arrow buttons as one toolbar in the same way.
Distributing Personnel Immediately — Distribute Now

For any pending distribution-event transaction listed in the Access Distribution View, you may immediately distribute a personnel record (representing the person who has access an area) to a controller on the local area network (LAN) and/or a remote access services (RAS) network.

Note: Distribution is enabled for every workstation by default. To disable a workstation's ability to distribute records to controllers, set preference 19 and/or 20 to FALSE on the Preferences tab of the Device editor for any workstation that should not be a distributing workstation. (See Chapter 14 for a description of the settings on the Device editor’s Preferences tab.)

Note: You cannot use this Distribute Now feature while in the summary view.

To distribute personnel using Distribute Now, follow this procedure:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>In the full Access Distribution View, highlight the pending transaction.</td>
</tr>
<tr>
<td>2</td>
<td>Click the Distribute Now button in the toolbar, or double click any transaction listed in the view. The Pending Access Distribution dialog appears. For example:</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Pending Access Distribution dialog" /></td>
</tr>
<tr>
<td></td>
<td>Note: The Distribute Now button is enabled in the toolbar only when both the personnel and controller object IDs are present. Both are needed to perform the distribution.</td>
</tr>
<tr>
<td>3</td>
<td>In the Pending Access Distribution dialog, make sure the person that appears in the Personnel field is the one that you wish to distribute to the controller that appears in the Controller field. If this is not the right person or controller, click Cancel to dismiss this dialog. Make sure information in the Door and Area fields is also correct.</td>
</tr>
<tr>
<td>4</td>
<td>If this is the right person and controller, click the Distribute Now button. The personnel record is immediately distributed to the controller.</td>
</tr>
<tr>
<td>5</td>
<td>In the Access Distribution View, select Refresh from the View menu (or click the refresh button) to refresh the information in the window. In the Status column, the status icon of this event is changed.</td>
</tr>
</tbody>
</table>

Andover Continuum CyberStation Configurator's Guide 20-11
Overview

Continuum's file management system offers a powerful suite of features that manage configuration information for BACnet devices. You can automatically back up configuration information from the BACnet device to your database, as well as automatically restore it from the database to the device. The configuration information resides in a special configuration file, which is stored as an object — the BACnet class object, `File`. You can also archive it locally in a text file (ASCII dump .dmp file.)

Backup Capabilities

Specifically, file management backup features allow you to:

- Back up the configuration information (stored in a special File object called `ACCConfiguration` in Andover Continuum) for a single BACnet controller and save it to your Continuum database.
- Back up configuration information for multiple controllers (also stored in ACCConfiguration files, each in its respective controller) and save the information for multiple controllers to your Continuum database.
- Back up configuration information from the database and archive it to a text (ASCII dump) file.
- Simultaneously back up a controller's configuration information to the database and copy (archive) it to a text (ASCII dump) file.
Note: You perform these operations via either the right-click container popup menu in Continuum Explorer's navigation pane or the Backup/Restore tab in the Device editor for that controller. For detailed information on backup operations, please see Backing Up a Device's Configuration and the Device editor's Backup/Restore tab, Chapter 14.

**Restore Capabilities**

Specifically file management restore features allow you to:

- Restore configuration information from your database to a single BACnet controller.
- Restore configuration information from your database to multiple controllers.
- Restore the archived configuration information (contained in the text ASCII-dump file) to your database.
- Simultaneously restore the archived configuration information (contained in the text ASCII-dump .dmp file) to your database and to the controller.

Note: You perform these operations via either the right-click container popup menu in Continuum Explorer's navigation pane or the Backup/Restore tab in the Device editor for that controller. For detailed information on restore operations, please see Restoring a Device's Configuration and the Device editor's Backup/Restore tab, Chapter 14.

**The File Object**

When a backup operation (or send-to-database operation) is performed for a BACnet device, a File object (a BACnet class object) is created. This object, which is stored in the File object class folder residing in its respective BACnet controller. It contains configuration information for objects residing on the controller.

Note: The number and names of these files and file names are determined by individual BACnet devices (Andover Continuum vs. third-party). On Andover Continuum devices, the name of this file is ACCConfiguration.

Because the BACnet File object is implemented in Continuum, this object has an object editor consisting of two tabs: General and SecurityLevel. The General tab displays information about the file properties of the ACCConfiguration file.

Note: The General tab is read-only. You cannot change the values in its fields.
This chapter presents the following topics:

- **General Tab**
- Backing up a configuration
- Restoring a configuration

## General Tab

The File editor's **General** tab displays information about the file properties of the ACCConfiguration file.

**Note:** The **General** tab is read-only. You cannot change the values in its fields.

The following table describes the read-only attributes of the **General** tab. For more information on these attributes, see the File object type section in the BACnet Standard.

<table>
<thead>
<tr>
<th>Editor Attribute</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>This field is typically blank. However, if some third-party BACnet devices support the <strong>Description</strong> property for the File object, then the content of the description appears in this field.</td>
</tr>
<tr>
<td>Last Changed</td>
<td>Displays the date/time that the configuration file was last modified.</td>
</tr>
<tr>
<td>Type</td>
<td>Displays the class object type, <strong>File</strong>.</td>
</tr>
<tr>
<td>Size</td>
<td>Displays the size of the file. The size changes whenever the file is modified.</td>
</tr>
<tr>
<td>Access Method</td>
<td>Displays either Stream_Access or Record_Access.</td>
</tr>
<tr>
<td>Record Count</td>
<td>Displays the size of the file in records. This is displayed only when <strong>AccessMethod</strong> is Record_Access.</td>
</tr>
<tr>
<td>Archive</td>
<td>This box is checked if this is an archive file in the device.</td>
</tr>
<tr>
<td>Read Only</td>
<td>This box is checked by default.</td>
</tr>
</tbody>
</table>

## Backing Up a Device’s Configuration

File-management backup operations, listed below, are performed via the container popup menu in Continuum Explorer's navigation pane and/or via the **Backup/Restore** tab in the Device editor for that controller:

- Back up configuration information (stored in a special File object called **ACCConfiguration**) for a single BACnet controller and save it to your Continuum database. (See the procedures below.)

- Back up configuration information for multiple controllers (also stored in ACCConfiguration files, each in its respective controller) and save the information for multiple controllers to your Continuum database. (See the procedures below.)
- Back up configuration information from the database and archive it to a text (ASCII dump) file. (See Backup/Restore tab of the Device editor, Chapter 14.)

- Simultaneously back up a controller's configuration information to the database and copy (archive) it to a text (ASCII dump) file. (See Backup/Restore tab of the Device editor, Chapter 14.)

**Note:** Backup/restore operations are not supported in the context menu if the device does not support the BACnet property, AutomaticReadFile. Backup/restore operations are not supported on the Backup/Restore tab of Device editor if the device does not support the BACnet property BackupFailureTimeout.

**Procedures**

**Backing up a single device** — To back up a configuration for a single device, perform the following procedure:

1. On the BACnet side of Continuum Explorer's navigational pane, locate the controller whose configuration information you want to back up.

2. Right click over the device, and from the popup menu select **Backup BACnet Device**.

   For Andover Continuum BACnet controllers, the backup operation begins and the Distribution Properties dialog appears, showing the progress of and information about the operation. (For more information on the Distribution Server and the Distribution Properties dialog, see Chapter 2.)

   For some third-party BACnet controllers, you are first prompted to enter a password. If the password is accepted, the operation begins.

**Backing up multiple devices** — To back up configurations for multiple devices, perform the following procedure:

1. On the BACnet side of Continuum Explorer's navigational pane, locate the controllers whose configuration information you want to back up.

2. In the navigational tree, click the parent container containing the desired devices, so that those controllers appear in the viewing pane.

   For example, the parent container could be **BACnet Devices** or any BACnet controller that contains sub-devices.

3. Highlight (select) two or more controllers in the viewing pane.

4. Right click over the highlighted controllers, and from the popup menu select **Backup BACnet Device**.
For Andover Continuum BACnet controllers, the backup operation begins and the Distribution Properties dialog appears, showing progress messages about the status of the operations. For multiple controllers, information is backed up one controller at a time. The progress messages tell you when the backup operation finishes for one controller and begins for the next. (For more information on the Distribution Server and the Distribution Properties dialog, see Chapter 2.)

For some third-party BACnet controllers, you are first prompted to enter a password. If the password is accepted, the operation begins.

**Backing up all devices on a BACnet Network** — You can back up configurations for all devices residing in a BACnet network by right clicking over a BACnet Network folder:

1. On the BACnet side of Continuum Explorer's navigational pane, locate the blue BACnet Network folder that contains the devices whose configurations you want to back up.

2. To back up all the devices contained in the Network, right click over Network folder, and from the popup menu select Backup BACnet Device.

To back up two or more controllers selectively (but not all of them), in the navigation tree, click the Network folder so that its controllers appear in the viewing pane. In the viewing pane, highlight (select) the controllers you want to back up.

For Andover Continuum BACnet controllers, the backup operation begins and the Distribution Properties dialog appears, showing progress messages about the status of the operations. For multiple controllers, information is backed up one controller at a time. The progress messages tell you when the backup operation finishes for one controller and begins for the next. (For more information on the Distribution Server and the Distribution Properties dialog, see Chapter 2.)

For some third-party BACnet controllers, you are first prompted to enter a password. If the password is accepted, the operation begins.

**Restoring a Device's Configuration**

File-management restore operations, listed below, are performed via the container popup menu in Continuum Explorer's navigation pane and/or via the Backup/Restore tab in the Device editor for that controller:

Specifically file management restore features allow you to:

- Restore all configuration information from your database to a single BACnet controller. (See the procedures below.)
- Restore configuration information from your database to multiple controllers. (See the procedures below.)
• Restore the archived configuration information (contained in the text ASCII-dump file) to your database. (See the Backup/Restore tab of the Device editor, Chapter 14.)

• Simultaneously restore the archived configuration information (contained in the text ASCII-dump file) to your database and to the controller. (See the Backup/Restore tab of the Device editor, Chapter 14.)

Note: Backup/restore operations are not supported in the context menu if the device does not support the BACnet property, AutomicReadFile. Backup/restore operations are not supported on the Backup/Restore tab of Device editor if the device does not support the BACnet property BackupFailureTimeout.

Procedures

Restoring to a single device — To restore a configuration to a single device, perform the following procedure:

1. On the BACnet side of Continuum Explorer's navigational pane, locate the controller whose configuration information you want to restore.

2. Right click over the device, and from the popup menu select Restore BACnet Device.

   For Andover Continuum BACnet controllers, the restore operation begins and the Distribution Properties dialog appears, showing the progress of and information about the operation. (For more information on the Distribution Server and the Distribution Properties dialog, see Chapter 2.)

   For some third-party BACnet controllers, you are first prompted to enter a password. If the password is accepted, the operation begins.

Restoring to multiple devices — To restore configurations to multiple devices, perform the following procedure:

1. On the BACnet side of Continuum Explorer's navigational pane, locate the controllers whose configuration information you want to restore.

2. In the navigational tree, click the parent container containing the desired devices, so that those controllers appear in the viewing pane.

   For example, the parent container could be BACnet Devices or any BACnet controller that contains sub-devices.

3. Highlight (select) two or more controllers in the viewing pane.

4. Right click over the highlighted controllers, and from the popup menu select Restore BACnet Device.
For Andover Continuum BACnet controllers, the restore operation begins and the Distribution Properties dialog appears, showing progress messages about the status of the operations. For multiple controllers, information is restored one controller at a time. The progress messages tell you when the restore operation finishes for one controller and begins for the next. (For more information on the Distribution Server and the Distribution Properties dialog, see Chapter 2.)

For some third-party BACnet controllers, you are first prompted to enter a password. If the password is accepted, the operation begins.

**Restoring to all devices on a Network** — You can restore configurations to all devices residing in a BACnet network by right clicking over a BACnet Network folder:

1. On the BACnet side of Continuum Explorer's navigational pane, locate the blue BACnet Network folder that contains the devices whose configurations you want to restore.

2. To restore all the devices contained in the Network, right click over Network folder, and from the popup menu select **Backup BACnet Device**.

To restore two or more controllers selectively (but not all of them), in the navigation tree, click the Network folder so that its controllers appear in the viewing pane. In the viewing pane, highlight (select) the controllers you want to restore.

For Andover Continuum BACnet controllers, the restore operation begins and the Distribution Properties dialog appears, showing progress messages about the status of the operations. For multiple controllers, information is restored one controller at a time. The progress messages tell you when the restore operation finishes for one controller and begins for the next. (For more information on the Distribution Server and the Distribution Properties dialog, see Chapter 2.)

For some third-party BACnet controllers, you are first prompted to enter a password. If the password is accepted, the operation begins.
What is a Group?

A group is an object used to monitor other objects. Each group has its own list of objects known as “members.” Members can be objects from any class, and one group can have members from different classes. Typically, you’ll create a member list by adding objects that have something in common. For example, you could create a group that monitors all the objects stored on a particular controller. Similarly, you could use a group object to monitor all the objects pertaining to a particular function, such as air handling or security.

Group objects provide three ways to monitor objects:

1. You can view a group’s member list. The member list displays the name, class, and value of every object in the member list. For groups that consist entirely of personnel objects, the member list displays the last name, first name and middle initial of the individual, the last known location of the individual, and personnel object name.

2. You can view a graph the group’s first 15 points. The graph plots logged values.

3. You can view a history of the object values. The history displays a list of all the points in the group, and the values logged for them over a particular period.

When creating a group, you’ll work with the group editor to build or modify its member list, and you make choices that will configure the group’s graph and history views.
What is a Graph?
The graph view plots logged values for a point, or the first 15 points and/or system variables in a group's member list. You'll see a vertical scale to the left of the graph. Along the bottom, you'll see a horizontal line delineated by time periods. In most cases, you'll see a horizontal scroll bar that allows you to move left and right along the time line. The vertical scale and the horizontal time line are also known as the vertical axis and horizontal axis, respectively. The body of the graph displays one line for each point. To the right of the graph, you'll see a legend. The legend lists the names of the points, each in different color. The color of the point name matches the color of its respective line in the graph.

Reading Graphs
Graphs differ from histories in that they depict trends as well as actual point values. For example, it's easy to see whether temperatures tend to rise at noon. Simply find 12:00 PM in the horizontal time line, then look at the lines above its tick mark in the body of the graph. Do they spike up, or drop down? In a history view, you would have to compare all the point values in the 12:00 PM row against values in other rows to retrieve the same information.

As with a history view, a graph view also provides specific point values for specific times. To locate a point's value, find the time you want in the horizontal axis. Next, imagine a vertical line going from the time's tick mark to the line that represents the point in which you are interested. Finally, imagine a horizontal line going from the line to the vertical axis. The value located where the horizontal line intersects the vertical axis is the value of the point for that particular time.

Working With Multiple Scales
A graph can be set up to use more than one scale. When points to be graphed use different units (Deg F, CFM, Square Meters, etc.) multiple scales allow one graph to plot the values for all. Graphs that use multiple scales display only one scale at a time. You'll know that a graph uses multiple scales if the scale's color matches the color of the first point in the legend. That means the graph is currently displaying the scale for that point. To switch to another scale, use one of these methods:

- Click on the scale to change its color and scale values. The scale will change to according to the order of the points in the legend. Keep clicking until the scale’s color matches the color of the point whose scale you would like to see.
- Click on a point name in the legend. This changes the scale color and the scale values to match the point on which you click.
What Are Automatic Logs?
Automatic logs are record-keeping devices that can be set up for every kind of point except DateTime and String. There are four types of automatic logs:

- **LogInstantaneous** – Continuum stores the current value of points at the beginning of every interval.

- **LogAverage** – Continuum calculates average point values over every interval, using a weighted average algorithm. Average values are stored at the end of every interval.

- **LogMinimum** – Continuum compares all values over an interval, and finds the minimum value. Minimum values are stored at the end of every interval.

- **LogMaximum** – Continuum compares all values over an interval, and finds the maximum value. Maximum values are stored at the end of every interval.

Log intervals determine how often to record the point value. These intervals are specified in the point's editor, on the Logs tab. Logs store values in an array that group views use to create histories and graphs.
Using the Group Editor

The Group General Tab

You use the General tab to set up data sampling parameters for the group you are configuring.

![Group Editor Interface]

**Description**

The text you enter in this field appears as the title of the graph and history of your group.

**Default View**

Select the view of the group that you want to appear when you open the Group object with the SHOW command.

**Default Time Range**

Enter the Days, Hours or Minutes to specify what period of time your group graph or history will sample. For example, if you enter 1 hour, the group monitors group members for one hour. The time range selected on this tab does not affect the starting and stopping time for the group. These values are specified by you when you open a History or Graph view.

**Member List Refresh Rate**

This is the polling rate. Enter the interval in seconds at which you want the system to update values for your group. Members will only be refreshed when the Member List is shown.

**Personnel Only Member List**

Not implemented in this release.
The Member List Tab
The Member List tab lets you add objects to or delete them from the group. You click the Add button to browse for objects to add to the group. Remember, graph and history views display only point objects that have automatic logs set up for them. From this tab you can right-click on any object in the list and select any of the following options:

- Open
- Edit
- View History or View Graph
- Send To Controller or Send To Text File
- Rename
- Properties

Use the Member List tab to add and delete members. You can also look the properties for each member.

Adding Members – To add a member, click the Add button. This displays a Browse dialog to help you locate the object you want. You can also add members by dragging the objects from the viewing pane of the Explorer into the open member list. After you have found the object you are looking for, select it, then click the Select button. When adding objects, keep these points in mind:

- Graph and history views display only point objects that have automatic logs set up for them.

- If you are creating a group consisting entirely of Personnel objects, select Personnel Members Only on the General tab to insure that the member list displays the appropriate attributes.

When you add folder, ListView, or group objects, all the objects contained by or listed in these objects are added to the group as well.

Deleting Members – To delete a member, click it, then click the Delete button.
**Viewing Member Properties** – To view a member’s properties, click on it, then click the **Properties** button.
The Graph Tab

This is the tab you use to set up the parameters of the graph view of this group. Use the Graph tab to configure the scale that will be used to plot the first 15 point values in the member list. Note that only points with automatic logs set up for them will be graphed. To complete this tab, you'll perform the following tasks:

**Scale of Vertical Axis**
- **Singular Scale:** Use the **Singular Scale** option if all your points use the same units.
- **Multiple Scale:** Use the **Multiple Scale** option if you have a group of objects with different units.

**Vertical Axis Scale**
If you are using a single scale, you will need to define the vertical axis. The vertical axis displays a range for the point values in your member list.

- **Top**
  - Enter the number that will show on the graph view as top of scale.

- **Bottom**
  - Enter the number that will show on the graph view as bottom of scale.

- **Units**
  - Enter the **Unit** nomenclature that will show as the label for the vertical axis, for example, **Deg F**.
The History Tab
Use the History tab to configure how the automatic log data for the objects in the group will appear in the group view:

Display History Values
This view displays two types of values, actual and fill. Actual values are taken from automatic logs at the intervals defined for each log. Fill values occur at the interval defined by the Time Between Rows setting.
**Filling Type**

Select the option for filling in values between the logged values on the History chart. The history view displays two types of values: actual and interim.

Actual values are taken from automatic logs at the intervals defined for each log.

Interim values occur at the interval defined by the Time Between Rows setting. If the Time Between Rows setting matches the automatic log interval, all the values displayed are actual values. In most cases, however, the Time Between Rows setting is less than the log interval.

For example, the time between rows could be set to 10 seconds, and the log interval could be one minute. In this case, the history view will display more rows than there are entries in the log. In fact, there will be 5 rows for every 1-log entry. To compensate for this, the history view uses interim values until it receives an actual value from the log.

Interim values are either repeated actual values, or “sloped” to show the gradation between one actual value and the next. The Filling Type determines how the History view will display the interim values. Your Filling Type choices are as follows:

- **None** – This option displays only the values taken at each log interval. In other words, no interim values are displayed between rows. The following picture shows a history view using the None filling type:
This filling type omits interim values from the history view. To achieve this effect, click None on the History tab.

Repeat Values Until Change – This option repeats the last value until the point value changes.

The following picture shows a history view using the Repeat filling type:

```
<table>
<thead>
<tr>
<th>Date/Time</th>
<th>Space Temperature</th>
</tr>
</thead>
<tbody>
<tr>
<td>9/14/98 12:25:00 PM</td>
<td>70.05</td>
</tr>
<tr>
<td>9/14/98 12:25:30 PM</td>
<td>70.05</td>
</tr>
<tr>
<td>9/14/98 12:26:00 PM</td>
<td>70.09</td>
</tr>
<tr>
<td>9/14/98 12:28:30 PM</td>
<td>70.08</td>
</tr>
<tr>
<td>9/14/98 12:37:00 PM</td>
<td>69.99</td>
</tr>
<tr>
<td>9/14/98 12:37:30 PM</td>
<td>69.99</td>
</tr>
<tr>
<td>9/14/98 12:38:00 PM</td>
<td>69.99</td>
</tr>
<tr>
<td>9/14/98 12:38:30 PM</td>
<td>69.99</td>
</tr>
<tr>
<td>9/14/98 12:39:00 PM</td>
<td>70.09</td>
</tr>
<tr>
<td>9/14/98 12:39:30 PM</td>
<td>70.09</td>
</tr>
<tr>
<td>9/14/98 12:40:00 PM</td>
<td>70.31</td>
</tr>
<tr>
<td>9/14/98 12:40:30 PM</td>
<td>70.31</td>
</tr>
<tr>
<td>9/14/98 12:41:00 PM</td>
<td>70.40</td>
</tr>
<tr>
<td>9/14/98 12:41:30 PM</td>
<td>70.40</td>
</tr>
<tr>
<td>9/14/98 12:42:00 PM</td>
<td>70.32</td>
</tr>
<tr>
<td>9/14/98 12:42:30 PM</td>
<td>70.32</td>
</tr>
<tr>
<td>9/14/98 12:43:00 PM</td>
<td>70.26</td>
</tr>
</tbody>
</table>
```

This filing type repeats the last actual value until it changes. To achieve this effect, click Repeat Values Until Change on the History tab.

Slope Between Values – This option displays gradations of values between the rows. Gradation calculations are based on the difference between row values, and the number of refresh rate values between rows.
The following picture shows a history view using the Slope filling type:

Notice that this filling type shows gradations of one actual value to the next. To achieve this effect, click Slope Between Values on the History tab.

### Time Between Rows

Enter the Hours, Minutes, or Seconds that will be the interval between rows of values on the History chart.
**Dim Fill Values**  
When this checkbox is selected, the fill values between logged values on the History chart are dimmed and appear gray instead of black.

The following picture shows a history view with its interim values dimmed:

Notice that this filling type makes it easy to distinguish actual values from interim, or fill, values. To achieve this effect, click Dim Fill Values on the History tab.
Opening a Log Viewer

Once you have configured a Group object, you can review the activities of the objects in the group three different ways:

- Log Viewer Member List
- Log Viewer History
- Log Viewer Graph

To bring up any of these group views:

1. Select the **Group** object in Continuum Explorer
2. Right-click and select **View** then **Member List**, **History** or **Graph** from the popup menus.

Or, select **View** from the **Object** menu, then **Member List**, **History** or **Graph**:
Editing a Group from the Log Viewer

Do the following steps to open the Group editor for a Log Viewer:

1. Click the Edit Parent Object icon in the GroupView tool bar.
2. You then can change an existing Group’s default settings or add members to its member list. If there is a check in the checkbox next to an object on a Member List, that object will appear in a history.
3. You can drag and drop objects from Continuum Explorer to the Member List tab.
Creating ListViews

What is a ListView?
A ListView is a Continuum object that displays information about a specific object class. ListView information is either live or retrieved from the Continuum database. The information that you see in a ListView depends on the columns of information displayed, how those columns have been configured, and whether or not qualifiers have been established to filter objects by specified criteria. You can view the contents of the ListView from the ListView object itself, from an HTML report, or from a printed document.

ListViews provide features that allow you to display an HTML report, format and print the ListView contents, and even access the ListView editor itself. From the editor, you can add and configure columns, choose colors for various situations, and set up qualifiers to filter objects. Additionally, you can open the editor for any object shown in the ListView.
About Creating a New ListView

You create ListViews by typing information into text fields, making selections from dropdown menus, and browsing for objects. Once you have used the ListView editor to create a ListView, you will run the ListView then return to the editor if necessary.

Using the ListView Editor

The ListView General Tab

Use the **General** tab to select an object class and specify where Continuum looks for objects of this class. You can also specify an HTML template for viewing your ListView data in an HTML report document.

**Description**

Enter a description of up to 32 characters (including spaces) to help others who need to test, modify or manipulate this ListView.

**Class**

Select an object class from the dropdown menu. This list of objects includes all the object classes that appear in the **New** object popup list in Continuum Explorer.

Continuum also provides many specialized ListView classes you can use to track system events, such as **AlarmInfo**, **DistributionBatch**, **EventLogControl** and **ImExportRef**.
About Class Default ListViews
Continuum allows only one Class Default ListView per class. Database and Live qualifiers should not be used in a Class Default ListView. You can use sorting and background color choices when configuring the ListView columns to make items in the list stand out.

For example, you can create an InfinityInfinetController Class Default ListView with three columns, Name, CommStatus and InfinetId. Make the CommStatus column Sort order be Primary and Sort direction be Ascending. Make the CommStatus column Background color red. Make the Name column Sort order Secondary.

Selecting any path other than ClassDefault will not produce a Class Default ListView.

Path Type
Select from the dropdown menu. This helps Continuum decide where it looks for objects in the Class, such as Programs on a particular controller or BinaryValue points stored in a certain folder.

- AllPaths
  Searches all possible paths on your system

- FolderOnly
  Searches the folder in the Path field

- FolderandBelow
  Searches the folder in the Path field and all its subfolders

- DeviceOnly
  Searches the device in the Path field

- DeviceandBelow
  Searches the device in the Path field all the objects attached (owned by) the device

- Prompt
  Displays a dialog that asks users for the ListView path

- ClassDefault
  Designates this ListView as the default view for the class you selected from the Class dropdown menu.

Path
Browse for and select the device or folder to insert in Path.

Options
Show Grid Lines: Use this option if you want your ListView to contain row and column markings.

Live Data on Open: Use this option to make the ListView open with live data rather than data from the Continuum database.
Options

**Live Data Refresh Rate:** If your ListView contains live data, enter the refresh rate in seconds. Continuum refreshes the ListView display using the interval you specify here. Five (5) seconds is the fastest a list view is permitted to refresh.

**List Reload Rate:** The rate that Continuum reloads the entire list in seconds. The time is measured from when the list finishes loading. For example, if you set the reload rate to 20 seconds, the list will reload 20 seconds after it finishes loading, not 20 seconds from when it starts loading: load list, wait 20 seconds, reload list, wait 20 seconds, and so on. Zero (0) seconds disables this feature. A valid setting must be 5 or more seconds.

Report Template

Click the Browse button in the **Report Template** field to display the Open dialog:

![Open dialog](Open.png)

Browse to find the HTML report template file that you want to use for this ListView.

The HTML file must be local to the workstation or be stored on the server.

The HTML report templates provided for this course contain the fields that will accept ListView attribute data.

When you view the HTML report, the ListView data that appears in the report fields is static. The values are not updated from the ListView. Creating HTML report templates is covered in the Continuum System Administration Course.
The Columns Tab
Use the Columns tab to add, remove and configure data columns in the ListView. You can configure the contents and appearance of each column you add.

Add Column Click the Add Column button once for every column you want in your ListView. For every column you add, a column template like the one shown below appears:

See Configuring ListView Columns on the next tab for instructions on configuring columns after you create them.
Configuring ListView Columns

For each column you add to your ListView you select the attribute information that it displays and make several other choices regarding its appearance.

To make these choices, you work with a column template like the one shown below:

- **Attribute**: Name
- **Heading**: Name
- **Font**: MS Sans Serif
- **Heading Font**: MS Sans Serif
- **Justification**: Left
- **Source**: Database
- **Sort**: None
- **Width**: 150
- **Show**: 
- **Background Color**:

Each column template begins with default values for every aspect of your data. To specify different values, click in the field containing the value you want to change (see diagram above). Depending on the value type, you can:

1. Type over the existing value.
2. Choose a new value from a dropdown menu.
3. Display a dialog that helps you select a new value.
4. Select a checkbox to indicate yes, or clear it to indicate no.
The following table tells you how to use each field.

<table>
<thead>
<tr>
<th>Column Field</th>
<th>How to Configure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attribute</td>
<td>Select an attribute such as Name or Status from the dropdown menu.</td>
</tr>
<tr>
<td></td>
<td>Type in the first letter of the attribute you want to make the list scroll to that letter.</td>
</tr>
<tr>
<td>Heading</td>
<td>By default, the ListView uses the attribute’s name as a heading. To use a different heading, type over the attribute name.</td>
</tr>
<tr>
<td>Edit</td>
<td>Select this checkbox to let users edit the attribute from the ListView. Clear the checkbox to disallow editing.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Not all attributes are editable.</td>
</tr>
<tr>
<td>Font and</td>
<td>For each ListView column you can specify fonts for the column data and the column heading:</td>
</tr>
<tr>
<td>Heading Font</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Click in the <strong>Font</strong> or <strong>Heading Font</strong> field of your column.</td>
</tr>
<tr>
<td></td>
<td>Click the button that appears to display the Font dialog. Select a font, font style and size from the scrollable lists. As you do so, the Sample box shows a text sample.</td>
</tr>
<tr>
<td></td>
<td>In Effects, specify strikeout marks, underlines and font color. Click OK to save your font settings.</td>
</tr>
<tr>
<td>Justification</td>
<td>Select Right, Left, or Center from the dropdown menu.</td>
</tr>
<tr>
<td>Source</td>
<td>Select Database or Live from the dropdown menu.</td>
</tr>
<tr>
<td></td>
<td>With Database, display the attribute’s database value.</td>
</tr>
<tr>
<td></td>
<td>With Live, display the current attribute value of the object. Specify the refresh rate in Live Data Refresh Rate on the General tab.</td>
</tr>
<tr>
<td>Sort</td>
<td>See the section Sorting in ListViews later in this chapter for instructions on using the option.</td>
</tr>
<tr>
<td>Width</td>
<td>The number of pixels for the column width, such as 25.</td>
</tr>
</tbody>
</table>
Show

To include this column in the ListView, select the **Show** checkbox. To hide this column in the ListView, clear the checkbox. Columns that do not show in a ListView can appear in HTML and printed report formats.

Background Color

Click in the **Background Color** field of your column.

Click the button that appears to display the **Color** dialog.

Select a color from the palette or define your own custom colors.

Click **OK** to save your color settings.

**Sorting in ListViews**

You can sort the data in your ListView by the values of up to three attributes.

This is useful for ordering the rows of data to make them easier to read. Select the attributes used to sort the rows from the **Columns** tab.

Because each column represents one attribute of the object class you are viewing, you can sort by **Name**, **Value**, or **Status** providing you have added and configured columns for those attributes.

**To Sort by Attribute Value**

Click on the **Sort** field of the column of the attribute you wish to sort. This displays the dialog shown below:

![Dialog]

Select an **Order number** to help establish the sort order when you sort by more than one attribute. See **Understanding Sort Order** on the next tab.

Select either **Ascending** or **Descending** from the dropdown menu. See the section, **Sorting in Ascending or Descending Order** on the next tab.

Click **OK** to save your work, or click **Cancel** to exit the dialog without saving.
For every attribute on which you base the sort order, specify if it’s the **Primary**, **Secondary**, or **Tertiary** sort order.

The **Order** number defines what happens when Continuum finds two objects that have the same attribute value.

For example, if the **Primary** sort attribute is **Name**, how does Continuum order two objects named **RoomTemp1**? Which does it list first?

If another attribute has been set up as the **Secondary** sort attribute, Continuum uses its value to decide which object is listed first.

The **Tertiary** sort attribute works the same way. If Continuum finds two objects with the same **Primary** and **Secondary** sort attributes, it uses the **Tertiary** sort attribute to decide how to list the objects.

**Sorting in Ascending or Descending Order**

For every attribute on which you base the sort order, specify either **Ascending** or **Descending** order:

- Ascending order starts with the lowest value and ends with the highest value.
- For text, ascending order is A to Z.
- For numbers ascending order is 0 to the highest numeric value.
- Descending order starts with the highest value and ends with the lowest value.
- For text, descending value is Z to A.
- For numbers, descending value is from the highest value to 0.

**Note:** Values such as **Active**, **Inactive**, **ON**, **OFF**, **Online**, **Offline**, **Enabled** and **Disabled** are represented to Continuum by 1 and 0 respectively. These values are sorted just like numeric values.
Sorting Example
The following example shows Numeric objects sorted in Ascending order, with Name as the Primary sort attribute, Value as the Secondary and Device Name as the Tertiary:

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Device Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Num1</td>
<td>0</td>
<td>DeviceC</td>
</tr>
<tr>
<td>Num1</td>
<td>0</td>
<td>DeviceD</td>
</tr>
<tr>
<td>Num1</td>
<td>1</td>
<td>DeviceA</td>
</tr>
<tr>
<td>Num2</td>
<td>73</td>
<td>DeviceB</td>
</tr>
<tr>
<td>Num3</td>
<td>8</td>
<td>DeviceA</td>
</tr>
</tbody>
</table>

These two objects are ordered by Device Name.
This object is ordered by Value.
These two objects are ordered by Name.

The first two objects are sorted by Device Name because they have the same name and value. The third object is sorted by Value because, although it has the same name as the first two, its value is higher. The last two objects are sorted by Name.

The Qualifiers Tab
Uses the Qualifiers tab to enter Plain English statements to further qualify the objects displayed in the ListView.

While the General tab allows you to qualify objects by class and path, the Qualifiers tab lets you qualify and highlight objects depending on their attribute values. It is divided into three main sections: Database, Live and Highlight. In addition, the Highlight Color field is used in conjunction with the Highlight section.
The Qualifiers tab offers two methods of creating qualifying statements for ListView objects:

1. Type the statements directly into the appropriate text field.
2. Use the Query Wizard to build the statements.

The method that you use is determined by the state of the "Advanced XXX Qualifiers" checkbox.

- If it is checked, the edit control is enabled and text can be entered into the text field.
- If it is not checked, the Query Wizard button is enabled and selecting it will open the Query Wizard dialog (see below) which allows you to build an appropriate qualifier statement.

Using the first (advanced) method, you are responsible for creating the qualifier statement correctly. With the second method, the Query Wizard assists you in building the statement and once it is built, it is returned to the appropriate text field in the Qualifier tab. If necessary, the statement can then be edited by checking the "Advanced XXX Qualifier" checkbox.

Live versus Database Qualifiers

The Qualifiers tab offers you the choice of constructing statements Live or from the Database. If you select Live, the Cyberstation retrieves the settings of the qualifier statement attributes directly from the controller. If you select Database the Cyberstation retrieves the attributes settings from Continuum's database.

The choice between Live and Database depends on certain factors. By using Live, you are assured of getting the latest version of the qualifier attribute settings since they are retrieved directly from the controller. If you know the attribute doesn't change very often, you can retrieve it from the database, which is faster than going to the controller to get a live value.

Using the Qualifiers Tab in the Advanced Mode

To create your qualifier statements directly in the Qualifiers tab, proceed as follows:

1. Click on the Advanced Database (or Live) Qualifier checkbox.
2. Type the Plain English qualifier statement/s in the Database (or Live) text field. For example: STATE = DISABLED OR OVERRIDE = TRUE
3. Click on the Advanced Highlight Qualifier checkbox if you wish to highlight certain parts of the statement created in step 2.
4. Type the parts of the statement you want highlighted in the Highlight text field. For the example in Step 2, if you want to highlight only those objects with an Override value of TRUE, you would enter the following statement:

   OVERRIDE = TRUE
5. Place the cursor in the **Highlight Color** text field and click the right mouse button:

   ![Background Color...](image1.png)

   ![Text Color...](image2.png)

6. Click on **Background Color** to display the **Color** dialog:

   ![Color dialog](image3.png)

7. Select the color you want and click the **OK** button.

8. Repeat steps 6 and 7 for the desired **Text Color**. Your color selections will be previewed in the **Highlight Color** field.

9. Return to the **General** tab and follow the “Test and Save” procedure at the end of this chapter to create the ListView.

**Highlight Text and Color Example**

The following figure shows an example of a ListView where objects with a **State** attribute of **Disabled** have been highlighted:

![ListView - All Doors](image4.png)
Using the Query Wizard
To build your qualifier statements with the Query Wizard, proceed as follows:

1. Click on the Query Wizard button in the Database (or Live) section of the Qualifier tab (the Advanced XXX Qualifier checkbox must unchecked) to display the Query Wizard dialog.

2. Click on the down arrow in the Attribute list field and scroll through the list and select the attribute you want by clicking on it.

3. Click on the down arrow in the Operator list field and select the operator you want by clicking on it. (See "Operator Selections" on the next page.)

4. Click on the Value text field and type in the appropriate value for your qualifier statement (see "Value Selections" on the next page).

5. Click on the Prompt checkbox if you want to be prompted for an alternate attribute value when the ListView appears. (See "Prompt for an Attribute Value" on the next page.)

Note: The Prompt feature is only available for a Database qualifier. It is not available for object link attributes, such as owner ID or device ID.

6. If you have additional qualifying conditions to add to your statement move down to the next row of boxes on the Wizard.

7. Fill in the Attribute, Operator and Value fields as described in steps 2, 3 and 4.

8. Click on the left hand field to enter a joint and/or operator. (See "Compound Qualifiers" on the next page.)

9. Repeat steps 6, 7 and 8 if additional Compound Qualifiers are required.

10. Click on the OK button. If the statement validates without any errors, it will re-appear in the appropriate text field of the Qualifier tab. If errors occur during validation, an error message will appear and must be corrected to complete the operation. (See "Error Messages" later in this chapter.)
Operator Selections
The operators that are selectable from the Operator dropdown menu include the following:

>   Is   Is like
>=  Is not  Is not like
<   Is between
<=  Is not between

Refer to Chapter 3 of the Plain English Language Reference manual for explanations for each of these operators. The values to associate with these operators are discussed below.

Value Selections
The value that you select must be an appropriate one for the operator. The value requirements for certain operators are listed below.

<table>
<thead>
<tr>
<th>Operators</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is</td>
<td>Number or expression that gives a number or a string. Also works with object links, for example &quot;Ownerid is \root\MyFolder&quot;.</td>
</tr>
<tr>
<td>Is not</td>
<td>An asterisk (*) for number of characters or a question mark (?) for any single character.</td>
</tr>
<tr>
<td>Is like</td>
<td>An expression that gives two numeric values, the lower one first, separated by an ampersand (&amp;): \textit{number &amp; number}</td>
</tr>
<tr>
<td>Is not like</td>
<td></td>
</tr>
<tr>
<td>Is between</td>
<td></td>
</tr>
<tr>
<td>Is not between</td>
<td></td>
</tr>
<tr>
<td>&gt;, &gt;=</td>
<td>Number or expression that gives a number.</td>
</tr>
<tr>
<td>&lt;, &lt;=</td>
<td></td>
</tr>
</tbody>
</table>

Compound Qualifiers
Notice that an additional selection box appears to the left of the last three rows in the Query Wizard dialog. These boxes allow you to link multiple statements together with the \texttt{and/or} joining operators. An example might look like this:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Operator</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Is like</td>
<td>A*</td>
</tr>
<tr>
<td>and</td>
<td>Value</td>
<td>is between</td>
</tr>
<tr>
<td>and</td>
<td>Channel</td>
<td>&gt;</td>
</tr>
</tbody>
</table>

Prompt for an Attribute Value
Notice that a \texttt{Prompt} checkbox is located at the right hand end of each row on the Query Wizard dialog. This is an optional feature that is only available for a Database qualifier. Activating the checkbox will cause a prompt to appear on the screen when the ListView is opened. The prompt will allow you to change the corresponding attribute value and thus change the contents of the ListView for that particular object.
**Error Messages**
The error messages that you may receive if the qualifier statement is invalid are listed below.

**Note:** In the Error Message column, the words in italics represent the type of item that would be substituted in the actual message.

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Possible Cause</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;You must pick an operator for the expression&quot;</td>
<td>You selected an attribute but did not pick an operator to go with it.</td>
</tr>
<tr>
<td>&quot;You must join additional qualifiers with either an <strong>and</strong> or an <strong>or</strong> operator*&quot;</td>
<td>You have more than one qualifier statement, but did not pick an AND/OR operator to join them.</td>
</tr>
<tr>
<td>&quot;The value <strong>AttributeValue</strong> you entered for the attribute <strong>AttributeName</strong> is invalid.**&quot;</td>
<td>The value portion of the expression failed validation for some reason. For example &quot;The value is not within the specified range&quot;.</td>
</tr>
<tr>
<td>&quot;You may only use the <strong>is</strong>, <strong>is not</strong>, <strong>is like</strong> and <strong>is not like</strong> operators on the attribute <strong>AttributeName</strong>.**</td>
<td>You have selected an operator that is not supported for the attribute.</td>
</tr>
<tr>
<td>&quot;The object <strong>ObjectName</strong> that you entered for the attribute <strong>AttributeName</strong> does not exist in the database. Do you wish to use this object anyway?&quot;</td>
<td>You have tried to enter a value for an object link attribute but the value you entered does not exist in the database. This message box will give you two choices, <strong>yes</strong> and <strong>no</strong>. If you select <strong>yes</strong> then the text you entered will be used anyway, if you select <strong>no</strong> then validation will fail and you can then change the text.</td>
</tr>
</tbody>
</table>

**Test and Save**
After you fill out the tabs of the ListView editor, return to the **General** tab.

1. Click the **Apply** button to create the new ListView.
2. Then, click the **Run ListView** button. Your new ListView will appear, covering the ListView editor window.
3. Review the elements of your new ListView.
4. To use the editor to modify the ListView, click on its button in the Windows task bar at the bottom of the screen.
5. Use the ListView buttons in the Windows task bar to switch between the ListView and its editor.
6. Click **OK** in the editor to save the ListView.
Creating a History or Graph of a ListView

To create a history or graph of your ListView, follow these steps.

Note: This procedure is performed the same (with the same screens) when a history or graph report for your ListView is required. The final output of your history or graph is different and both outputs are shown.

1. Highlight the ListView from which you want a history or graph.

2. From the ListView Object menu, select History or Graph.
3. You are presented with the following screen. Select the times you require in the **Range** fields and the **Time Between Rows** fields. Select the type of log you require and click **OK** or **Now**.

![Time Range Screen](image)

4. Depending on whether you selected **History** or **Graph**, you are presented one of the following screens depicting a history or a graph of your ListView.

If you select **History**, the following appears:

![History Screen](image)
If you select **Graph**, the following appears:
Overview

An EventView object determines which access-related events will display in an Active Event View. You configure an EventView object using the EventView editor.

Active Event Views are used to monitor access-related activities. These activities include the use of card readers and/or keypads to gain access through locked doors, or trouble situations such as a door left ajar, keypad tampering, or forced entry. Active Event Views also provide information such as whom is using which door, when, and whether the door re-locks properly. Event views are called “active” because they receive and list access control events as they occur.

Using the EventView editor, you specify the types of events and the doors you want to monitor. You can also specify sorting criteria for the events, and configure the font and color for each event. Once you have created an EventView object, users on any Continuum workstation can monitor events as they occur in an Active Event View.
Before Creating an EventView

Prior to creating an EventView object, make sure the appropriate Access Events have been selected on the **Options** tab of your Door editor.
Creating an EventView

From the Continuum Explorer, right-click on the **Live Views** folder, **New**, and select **EventView**.

Type in a name for the new EventView (for example, DoorXXEventView) and press **Enter**.

You will be presented with the following tabs. These tabs are discussed in the following sections.

- General
- Doors
- Fonts and Colors
The General Tab
In the General tab, enter information about the Active Event View’s general appearance.

<table>
<thead>
<tr>
<th>Editor Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Enter a description that explains which doors and event types will display in the Active Event View. (Adding this information is optional.)</td>
</tr>
<tr>
<td>Maximum Number of Events</td>
<td>Enter the maximum number of events you want the Active Event View to display at one time.</td>
</tr>
<tr>
<td></td>
<td>When the number of events displayed reaches the maximum number, the bottommost event drops off the list as a new event displays. The order in which events display depends on the sort criteria you set up.</td>
</tr>
<tr>
<td>Maximum Time in View</td>
<td>Enter the number of seconds events will display in the Active Event View before expiring and dropping off the list.</td>
</tr>
<tr>
<td></td>
<td>If this field is left blank, events don’t expire, they drop off the list based on the maximum number of events and the current sort order.</td>
</tr>
<tr>
<td>Sort Criteria</td>
<td>In the Sort Criteria area, you may sort events according to three columns. The Active Event View displays several columns of information for every event, according to the sort criteria you select here. Sorting is useful for grouping events to look for trends in, for example, the source of events, types of events, and which personnel are accessing which doors most often.</td>
</tr>
<tr>
<td></td>
<td>From the Primary, Secondary, and Tertiary dropdown menus, select up to three columns. The columns you select establish the sort order that the Active Event View uses. Check the ascending checkbox to sort in ascending order, or clear it to sort by descending order and click OK to save your work.</td>
</tr>
</tbody>
</table>
The Doors Tab
In the Doors tab, select the doors and the event types to display in the Active Event View. These doors and event types you select are listed on this tab.

Perform the following steps to add doors and/or event types.

1. Click the Add Door button. The Browse dialog appears.
2. Search the directories for, and select, a door to add to the list of doors to be displayed in the Active Event View.
   
   Note: As an alternative, you may select one or more doors from the desired directory, click and drag the doors to the Doors tab, and release the mouse button.
3. Click OK to return to the Doors tab.
4. For each door listed, check the checkbox for every event type that you want to include in the Active Event View. Use the horizontal scroll bar to see all the available event types.

   Note: As an alternative, select the event type you want to include in the Active Event View, and click Check Selected.

   When you do not want to include an event type in the Active Event View, scroll to the event type you want to remove, and click the checkbox to remove the check.

   Note: As an alternative, select the event type you do not want to include, and click Uncheck Selected.

Perform the following steps to remove doors.
1. In the list of doors on the Doors tab, select one or more doors you wish to remove.
2. Click Remove Doors.
The Fonts and Colors Tab
In the Fonts and Colors tab, configure the font, text color, and background color for every event type. All event types are listed on this tab. For example, you could use a green background for valid access events, yellow for invalid attempts, and red for door ajar events. Configuring fonts in this way helps the operator quickly differentiate events.

When you select a font and color for an event type, that event type is listed with its new font and new colors.

Perform the following steps to configure fonts and colors.
1. On the Fonts and Colors tab, right click on an event type. A popup menu appears.
2. Select Font to configure the font and font style.
3. Select Background Color or Text Color to configure colors for the background and text, respectively.

The Security Level Tab
For details in attaching or detaching Security Levels, see Chapter 4, Security.
The Active Event View

The Active Event View lists the events associated with the specified object (in this case the Lobby Area). Based on how your Administrator configured the active event view, it can show events for one door, a group of doors, all doors, or doors associated with a particular area.

The events are shown in chronological order with the most recent event presented first. Each row displays columns of information related to a particular event. Event information can be displayed in a variety of colors to depict different categories of events.

Parts of the Active Event View

An Active Event View generally consists of the following types of components:
- Active Event View menus
- Quick pick options
- Columns

Menus

The Active Event View has the following dropdown menus: Object, View, and Help.

<table>
<thead>
<tr>
<th>Object Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Menu Selection</strong></td>
</tr>
<tr>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Print</td>
</tr>
<tr>
<td>Print Preview</td>
</tr>
<tr>
<td>Print Setup</td>
</tr>
<tr>
<td>Clear All Events</td>
</tr>
<tr>
<td>Exit</td>
</tr>
</tbody>
</table>

View Menu

<table>
<thead>
<tr>
<th><strong>Menu Selection</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Toolbar</td>
</tr>
<tr>
<td>Sort</td>
</tr>
<tr>
<td>Auto Sort</td>
</tr>
<tr>
<td>Freeze</td>
</tr>
<tr>
<td>Add/Remove Columns</td>
</tr>
</tbody>
</table>
Status Bar | Hides or displays the status bar.
Always on Top | When selected, ensures that the Active Event View will stay on top of all other applications on your screen.
Event View Object | Opens the EventView object editor for this Active Event View.
Door | Opens the Door object editor.
Area | Opens the Area object editor.
Person | Opens the Personnel object editor.

<table>
<thead>
<tr>
<th>Menu Selection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contents</td>
<td>Opens Active Event View help topics.</td>
</tr>
<tr>
<td>About Active Access Event View</td>
<td>Displays program information, version number, and copyright information.</td>
</tr>
</tbody>
</table>

Quick Picks
As an alternative to the dropdown menus, you may use these quick pick icons to save time:

<table>
<thead>
<tr>
<th>Click this …</th>
<th>To Do this …</th>
</tr>
</thead>
<tbody>
<tr>
<td>![icon]</td>
<td>Prints the current Active Event View.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Starts or stops the addition of new events.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Opens the EventView editor.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Opens the Personnel editor.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Opens the Door editor.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Opens the Area editor.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Navigates to a video (brings up the VideoLayout editor) for an event.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Enables the sort function.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Opens the Pending Access Distribution dialog, which allows immediate distribution. When you want to distribute a personnel record immediately to a controller, in order to resolve a pending request to access an area by that person, highlight the pending distribution-event transaction, and click this button. The Pending Access Distribution dialog appears. To perform an immediate distribution, click the Distribute Now button. For related information, please see Chapter 20, Managing Personnel Distribution.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Opens Active Event View help topics.</td>
</tr>
</tbody>
</table>
Columns
For every event, the Active Event View displays the following columns of information:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date/Time</td>
<td>Date and time the event occurred</td>
</tr>
<tr>
<td>Type</td>
<td>Type of access event.</td>
</tr>
<tr>
<td>Door</td>
<td>Door at which the event occurred</td>
</tr>
<tr>
<td>Person</td>
<td>Personnel associated with the card reader or keypad event</td>
</tr>
<tr>
<td>Area</td>
<td>Area in which the event occurred</td>
</tr>
<tr>
<td>Controller</td>
<td>Full path to the controller that controls the door</td>
</tr>
<tr>
<td>Message</td>
<td>Not yet implemented</td>
</tr>
<tr>
<td>Zone Code</td>
<td>If the system is zone-based rather than area-based, the code number of the</td>
</tr>
<tr>
<td></td>
<td>zone in which the event occurred</td>
</tr>
<tr>
<td>Department Point</td>
<td>Department point number of the person causing the event</td>
</tr>
<tr>
<td>Card Number</td>
<td>Access card number of the person causing the event</td>
</tr>
<tr>
<td>Card Type</td>
<td>Access card type, Wiegand, or ABA, of the person causing the event</td>
</tr>
<tr>
<td>Site Code</td>
<td>Access card site code number of the person causing the event</td>
</tr>
</tbody>
</table>

Working in the Active Event View
As mentioned previously, the Active Event View is a dynamically updating list. By default, the view lists all of the event details in columns. You use the scroll bars to access the information not displayed in the window.

Two options are available for changing the way the information is presented in the view:

- **Resizing Columns** – You can resize column widths by pointing on the vertical dividing line between two columns.

<table>
<thead>
<tr>
<th>Date/Time</th>
<th>Type</th>
<th>Door</th>
</tr>
</thead>
</table>

When the cursor changes to a double arrow \[\leftrightarrow\], then hold down the mouse button and drag the column boundary to the left or right.
• **Adding/Removing Columns from the View** - You can modify the settings for the view to remove (or add) columns from the display. To accomplish this, choose the option **Add/Remove Columns** from the **View** dropdown menu.

A dialog appears:

![Add/Hide Columns dialog](image)

Click on the box to the left the columns you want removed from the view. The check mark is removed from the box indicating the column has been deselected. Click on the **OK** button to save the changes and have the view updated to reflect the column removal. Conversely, if you want to add columns to the view, click in the box so a check mark does appear and then click **OK** to save the changes.

**Viewing Event Details**

Viewing the event information can be accomplished through the Active Event View or you can retrieve an Event Details View. The **Details View** conveniently displays all of the event information in one window that you may find easier to read the event information.

Double click any event in the Active Event View to see the **Details View** of that event. The Details View shows you all the Active Event View column information in a single dialog.
Right click any browsable field to open a popup menu of options.

### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td>Indicates what type of event occurred.</td>
</tr>
<tr>
<td><strong>Date and Time</strong></td>
<td>Indicate when the event occurred.</td>
</tr>
<tr>
<td><strong>Message</strong></td>
<td>Displays a text string describing the event condition.</td>
</tr>
<tr>
<td><strong>Door</strong></td>
<td>Indicates at which door the event occurred.</td>
</tr>
<tr>
<td><strong>Personnel</strong></td>
<td>Shows the person associated with the card reader or keypad event.</td>
</tr>
<tr>
<td><strong>Area</strong></td>
<td>Shows what area the event occurred (where door is located).</td>
</tr>
<tr>
<td><strong>Controller</strong></td>
<td>Displays the name of the controller the access control device is attached.</td>
</tr>
<tr>
<td><strong>Department Point</strong></td>
<td>Indicates the department point number of the person causing the event (if one has been defined for the person).</td>
</tr>
<tr>
<td><strong>Zone Code</strong></td>
<td>Reflects the code number of the zone in which the event occurred, if your system uses zone rather than area based access control.</td>
</tr>
<tr>
<td><strong>Card #</strong></td>
<td>Shows the access card number of the person causing the event.</td>
</tr>
<tr>
<td><strong>Card Type</strong></td>
<td>Indicates the type of access control card used by the person causing the event.</td>
</tr>
<tr>
<td><strong>Site Code</strong></td>
<td>Displays the site code assigned to the person causing the event (if one has been defined for the person).</td>
</tr>
</tbody>
</table>
Sorting Events
You can sort events by the values of up to three columns. This is useful for grouping events to look for trends in, for example, the source of events, types of events, and which personnel are accessing which doors most often.

Note: You may also sort events by columns, and establish sort criteria, via the General tab of the EventView editor.

Perform the following steps to sort events by columns.

1. Select Sort from the View menu to display the Sort Criteria dialog.

2. From the Sort Criteria dialog, select up to three columns from the Primary, Secondary and Tertiary dropdown lists.
   The columns you select establish the sort order that the Active Event View uses.

3. Check the ascending checkbox to sort in ascending order, or clear it to sort by descending order.

4. Click OK to save your work, or click Cancel to exit the dialog without saving.

Rearranging Active Event View Columns
Use the click and drag method to rearrange the columns in the Active Event View:

1. Click once on a column heading to rearrange the columns in the Active Event View:

2. Click again anywhere in the column, and hold down the mouse button.
   A small box appears next to your cursor. This indicates you are ready to move the column.

3. Drag the cursor to the new location in the Active Alarm View, and release the mouse button.
Adding and Hiding Columns
Follow these procedures to add a column, hide two or more columns, and hide one column.

To add a column:

1. Select Add/Hide Columns from the View menu. This opens the Add/Hide Columns dialog.
2. Select the checkboxes of the columns you want to add.

To hide two or more columns:

1. Select Add/Hide Columns from the View menu. This opens the Add/Hide Columns dialog.
2. Clear the check boxes of the columns you want to hide.

To hide one column:

1. Right click the column you want to hide. This opens the shortcut menu.
2. Click Hide.

Accessing Events for a Specific Person
The Active Event View provides an overall method for monitoring events occurring in your facility. However, if you are interested in the activities of a particular person or door you will find it easier to view these events using the object editor window.

To monitor the access control activities of a particular person, you open the Personnel editor window for the person through a listview. Follow this procedure:

1. Retrieve the All Personnel Listview - Click on the All Personnel listview button. The listview opens showing a list of all your personnel.
2. **Open the Personnel Editor Window** - Double-click on the person whose activities you want to monitor.

![Personnel Editor Window]

The Personnel editor window opens for the person. In this example, John Entwistle is the selected person.
3. **Move to Access Events Tab** - Click on the **Access Events Tab**. The window updates to show the events recorded for this person, in chronological order:

As you can see from the figure above, the Access Events list displays:

- The type of event (**EventClass** column);
- Date and time the event occurred (**TimeStamp** column);
- Door associated with the event (**Door** column); and
- Area associated with the event (**Area** column).

4. **Refresh the Window** - Unlike the Active Event View window, which dynamically updates with new information, this window is static and must be refreshed periodically to obtain the most current events. To do this, click the **Refresh** button at the bottom of the window.
Accessing Events for a Specific Door

To monitor the access control activities of a particular door, you open the Door editor window for the door through a listview. The steps to do this are as follows:

1. **Retrieve the All Doors listview** - Click on the All Doors listview button. The listview opens showing a list of all your doors.

![All Doors listview](image1)

2. **Open the Door Editor Window** - Double-click on the door whose activities you want to monitor. The Door editor window opens for the door (in this example, Lobby Door is the selected door.)

![Door Editor Window](image2)

24-16 TAC
To monitor the access control activities of a particular door, you open the Door editor window for the door through a listview. Follow this procedure:

1. **Move to Access Events Tab** - Click on the Access Events tab. The window updates to show the events recorded for this door, in chronological order.

   ![Access Events Tab Screenshot]

   As you can see from the figure above, the Access Events list displays:
   - The type of event (*EventClass* column)
   - Date and time the event occurred (*TimeStamp* column)
   - Person associated with the event (*Person* column)
   - Area associated with the event (*Area* column—not shown in this figure but accessible via the horizontal scroll bar)

2. **Refresh the Window** - Unlike the Active Event View window, which dynamically updates with new information, this window is static and must be refreshed periodically to obtain the most current events. To do this, click the **Refresh** button at the bottom of the window.

In addition to monitoring active events, you may need to review past event information that has been stored in the Continuum database. To look at event history, ListViews are utilized.

Event history is useful in diagnosing recurring problems. For example, your supervisor may ask you to research Door Ajar events for a particular door. Or, gather information about the number of personnel moving into or out of a specific area.
An example event listview is shown below.

<table>
<thead>
<tr>
<th>Event Type</th>
<th>Event ID</th>
<th>Date</th>
<th>Time</th>
<th>Source</th>
<th>Destination</th>
<th>ullo</th>
<th>Protocol</th>
<th>Status</th>
</tr>
</thead>
</table>

Total: 22 Events
Version 1.7 and higher, CyberStation has two video object classes, VideoLayout and VideoServer, and video integration. Specifically, this chapter presents:

- Overview of Video integration and configuration
- Using the VideoServer editor
- Using the VideoLayout editor

Overview of Video Integration and Configuration

Video integration comprises:

- Two object classes: VideoLayout and VideoServer.

  A VideoLayout object is essentially CyberStation’s video surveillance monitor, through which you may view live and/or recorded video images. Each layout can display images from up to nine cameras.

  A VideoServer object identifies video servers for CyberStation, making it possible for CyberStation to communicate with each video server and its cameras.

  Note: It is assumed that the video servers (Integral brand) have already been configured, along with cameras and video presets. Therefore, to perform your configuration tasks, you should already know the video server names, user names, user passwords, and IP addresses for each Integral video server.
Various attributes for many existing object classes that have video associated with them — for example, graphics objects, Door objects, and points, such as InfinityInput and BinaryInput.

Active Alarm View features and Active Event View features that integrate video with individual alarms and access events, respectively

The following procedure provides an overview of configuration tasks that you perform to achieve video solutions suited to your site. While completing these tasks, refer to the other sections in this chapter (Using the VideoServer Editor and Using the VideoLayout Editor) for more details. Also refer to other parts of this manual, where noted.

1. **Create all VideoServer objects** — Enter server names, user names, passwords, and IP addresses. Test each server’s connection. (See **Using the VideoServer Editor**, later in this chapter.)

   **Note:** You must have already gathered this information from each video server, which should have already been configured, along with cameras and presets. (See your Integral video server documentation.)

2. **Create all VideoLayout objects** — When you create a VideoLayout object, you must associate cameras with (and assign them to) video control frames, or “windows,” where images are displayed.

   There are two ways to do this:

   - **Manually assign cameras** — You may manually assign a camera — that is, “hardwire” it — to each video frame in the VideoLayout object editor. You would typically “hardwire” a camera to view video that is not associated with alarms. For example, this method is useful during real-time surveillance and routine guard tours. (See **Using the VideoLayout Editor**, later in this chapter.)

   - **Pre-assign cameras** — You may pre-assign cameras in objects that associate video with alarms and access events. This method uses a new feature called video points. In the long run, video points save time and are easier to use because they populate the frames of VideoLayout objects dynamically and automatically. Up to four “video point” frame assignments are made in objects (such as a Door or InfinityInput) that generate alarms and access events. When the object goes into alarm, the VideoLayout associated with the object dynamically loads those camera assignments.

      Within the VideoLayout object, you must reference one of the four video points. (See **Using the VideoLayout Editor**, later in this chapter.)
The actual assignment of video points in objects is addressed in Step 4. See Step 4 below, as well as the section, Using the Alarms/Advanced Alarms Tab of an Object Editor, in Chapter 10, Configuring Alarms.)

3. **Make a list of objects to be associated with video** — You do this whenever you have a need to view video images when those objects, such as doors and input points, go into alarm or have an access event.

4. **Configure video points in the object editor** — For each object in the list, configure video points using its object editor, and associate the object with a VideoLayout.

   Video points are video-server and camera references that are attached to Continuum objects. Video points also contain other video information, such as presets, record flags, and PTZ (pan, tilt, zoom) information. A VideoLayout can be attached to objects in exactly the same way a graphic can be attached to an object.

   **Note:** If you launch (open) a VideoLayout from Continuum Explorer, from a graphic, from a ListView, and so on, and that layout references video points, then only the frames whose cameras have been “hardwired” display video.

   Open each object from the list in Step 3, select its editor’s Alarms tab or Advanced Alarms tab, and associate the video layout with the object. (See the section, Using the Alarms/Advanced Alarms Tab of an Object Editor, in Chapter 10, Configuring Alarms.)

   Configure video points 1 through 4 from the Video Points dialog. (See Chapter 10.)

   Repeat for each object in your list.

5. **Configure EventNotifications to display video with alarms** — If you are associating video with alarms, and you want to pop up a video layout when a new alarm comes in, then edit the EventNotifications associated with those alarms, and select Display Video on the Actions tab of the EventNotification editor. (See the section, The EventNotification Actions Tab, in Chapter 10.)

6. **Configure graphics with video** — Configure graphic controls to launch “hardwired” video layouts from buttons and other graphic controls.

7. **Test the alarms and access events** — Trigger an alarm with an associated video layout. Ensure the video pops up, if configured to do so.

   If you choose not to pop up video, you can launch the video layout using the new video button on the Active Alarm View. (See Active Alarm View in Chapter 10.)

   Repeat this process for access events, if necessary. Launch the video layout using the new video button on the Active Event View. (See Active Event View in Chapter 21.)
Using the VideoServer Editor

Using the VideoServer editor's **General** tab, you assign a physical video server to this VideoServer object. Any camera attached to this VideoServer object may be therefore assigned to (and its images viewed in) a video layout image frame or “window.” (See *Using the VideoLayout Editor*, later in this chapter.)

**General Tab**

In the **General** tab, you assign a physical video server to this VideoServer object:

Any camera attached to this VideoServer object may therefore assigned to video image windows (video controls) in the VideoLayout editor.

<table>
<thead>
<tr>
<th>Editor Attribute</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Description</strong></td>
<td>Enter a text description of this VideoServer object.</td>
</tr>
<tr>
<td><strong>IP Address</strong></td>
<td>Enter the IP address of the physical video server that you wish to assign to this object.</td>
</tr>
<tr>
<td><strong>User Name</strong></td>
<td>Enter the user name, and this user's password, that will be used to log onto the video server, when this VideoServer object is accessed. This user must exist on the actual video server to which you are connected. If the user does not exist on the server, this VideoServer object cannot be created for that user.</td>
</tr>
<tr>
<td><strong>Password</strong></td>
<td>Enter the password for the user name.</td>
</tr>
<tr>
<td><strong>Verify Password</strong></td>
<td>Enter the password for the user name.</td>
</tr>
</tbody>
</table>

**Tip:** To have two or more users log onto the same video server, create two or more VideoServer objects that connect to the same server, but with different user names and passwords. This is useful when you need to limit a Continuum user's access to Continuum video features. For example, a guard typically should not have the same access to video servers and layouts as an administrator.
Test Connection

Click this button to test the network connection to the server whose IP address appears.

If the test is successful, this message appears beneath the button:

Connection successful

If it is unsuccessful, this message appears:

Error Connecting to Server

Using the VideoLayout Editor

A “video layout” is essentially the video surveillance monitor for CyberStation. You open a VideoLayout object either manually in Continuum Explorer, or automatically by attaching it to a point's alarm or to a graphical control, to view live video images from a single surveillance camera or from multiple cameras set up in a matrix of video image frames. (See also Overview of Video Integration and Configuration, earlier in this chapter.)

**Note:** You may also open a video layout via the Plain English SHOW command, in the Continuum Command Line or via a Plain English program.

Via the VideoLayout editor's **General** tab, you may also:

- Assign, delete, and reassign cameras in the layout.
- Play back a recorded video clip.
- Capture a video image and save it to a file.
- Freeze, reload/refresh, pan, tilt, zoom, and adjust the image resolution (contrast, brightness, and so on)

Each image window in the layout is called a **video control frame**. Using a multiple-camera matrix, the VideoLayout editor allows you to assign (and view the images of) one, two, three, four, six, or nine cameras.

**Note:** In order to assign a camera to a video control, at least one video server must have been configured so that its cameras are available to the VideoLayout. (See the first two sections in this chapter.)

In Continuum Explorer, you may create a VideoLayout object from the **Root** directory or a folder. You may not create a VideoLayout object from a network, controller, workstation, or any other device.
**General Tab**

In the **General** tab, you configure a VideoLayout object, view video images, and perform basic video operations:

![VideoLayout Interface](image)

The **General** tab displays one or more video controls — frames that display live or recorded images from one or more video cameras associated with one or more video servers. Using a multiple-camera matrix, you may assign (and view the images of) one, two, three, four, six, or nine cameras in the same layout.
How to Access the Video Control Popup Menu — The video control popup menu allows you to assign and reassign cameras, view live video, play back recorded video clips, capture video images, adjust the image resolution, and perform other basic video operations. To access the video control popup menu:

1. Select (highlight) the video control frame with which you want to work. A red box appears around the selected frame.

2. Right click on the selected frame. The popup menu appears.

Video Control Popup Menu — The following table describes the choices in a video control popup menu, as well as the tasks you may perform via each selection.

<table>
<thead>
<tr>
<th>Menu Selection</th>
<th>Description</th>
</tr>
</thead>
</table>
| Live Video     | Select Live Video to display live (real time) images from the camera assigned to this video control frame.  
**Note:** Be sure to select Live Video again for any image that was previously frozen. (See Freeze Video, below.) |
| Recorded Video | Select Recorded Video to play back a video clip from the camera assigned to this video control frame. When Recorded Video is selected, a list of clips appears at the bottom of the video layout. Each clip in the list displays the camera name, the date the clip was recorded, the start time, the end time, and the number of frames. For example:

Select the video clip that you want to play back. A black play button and stop button appear on the bottom of the frame. Click the play button to begin the playback. Click the stop button to stop playback. You may also use the slider control within the frame to move forward and backward in the recording.  
To search for available video clips, specify a start date/time and an end date/time in the Start and End fields, respectively. Then click the Search button. All video clips within that time frame appear in the list. |
In the date fields, click the down arrow to display a calendar. Then click a start or end date on the calendar. The selected date is highlighted in blue, while the current date appears in a red circle. As an alternative, you may highlight the month, day, or year field, and manually key-in the month, day, or year.

In the time fields, use the up- and down-arrow buttons to select a time. As an alternative, you may highlight the hour, minute, second, or AM/PM field, and manually key-in the hour, minute, and second, and specify morning or afternoon/evening (AM or PM).

**Playback fps** – Select the speed (number of frames per second) at which you want to play back the video clip. The current number of frames per second is displayed at the left of this field. Use the slider bar and right- and left-arrow buttons, as needed.

**Note:** Video clips are stored on the video server, and not in the Continuum database.

<table>
<thead>
<tr>
<th>Freeze Video</th>
<th>Select <strong>Freeze Video</strong> to freeze the moving image of this video control frame immediately.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete Camera Assignment</td>
<td>Select <strong>Delete Camera Assignment</strong> to remove the camera from this video control frame. When you delete a camera assignment, the camera images disappear and the frame goes black. To reassign a camera, select <strong>Change Camera</strong>. (See below.)</td>
</tr>
</tbody>
</table>
| PTZ              | Select **PTZ** when you need to pan, tilt, or zoom in and out of the video image in this video control frame. **Note:** The camera assigned to this video control frame must have PTZ capabilities in order to use this feature. At the bottom of the frame, PTZ displays the numbers 1...6, as well as the following letters: 

<table>
<thead>
<tr>
<th>I O F N O C</th>
</tr>
</thead>
<tbody>
<tr>
<td>I — Click to zoom in.</td>
</tr>
<tr>
<td>O — Click to zoom out.</td>
</tr>
<tr>
<td>F — Click to focus the camera &quot;far&quot; or further out.</td>
</tr>
<tr>
<td>N — Click to focus the camera &quot;near&quot; or further in.</td>
</tr>
<tr>
<td>O — Click to open the iris and increase the amount of light streaming into the camera.</td>
</tr>
<tr>
<td>C — Click to close the iris and decrease the amount of light streaming into the camera.</td>
</tr>
</tbody>
</table>

The numbers 1...6 are the first six "preset" camera views. Although some cameras support up to 256 camera presets, only the first six are supported here.

**Panning and tilting** — To pan and tilt the camera, place your cursor inside the video control frame, and click once. A light blue thick arrow appears. You may pan/tilt up, down, left, right, and diagonally. The blue arrow changes direction, according to where you place it on the frame:

| Up arrow | Pan up. Click cursor at top-center. |
| Down arrow | Pan down. Click cursor at bottom-center. |
| Left arrow | Pan left. Click cursor at left-center. |
Right arrow — Pan right. Click cursor at right-center.

Right diagonal up arrow — Pan diagonally to the upper right. Click cursor at top right corner.

Left diagonal up arrow — Pan diagonally to the upper left. Click cursor at top left corner.

Right diagonal down arrow — Pan diagonally to the lower right. Click cursor at bottom right corner.

Left diagonal down arrow — Pan diagonally to the lower left. Click cursor at bottom left corner.

<table>
<thead>
<tr>
<th>Capture Image</th>
<th>Select <strong>Capture Image</strong> to capture the image being displayed in this video control frame and to save it to a file. The <strong>Capture Video Image Save</strong> dialog appears. Browse for the directory in which you want to save the image file, specify the file name, specify the image file type (.BMP, .JPG, and so on), and click <strong>Save</strong>.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video Points</td>
<td>Select <strong>Video Points</strong> to preconfigure a video control frame so that, when this VideoLayout is attached to an object and associated with an alarm, up to four cameras (known as &quot;video points&quot;) can be automatically associated with the VideoLayout. When the alarm goes off, this VideoLayout is launched, displaying the video points associated with the object that went into alarm. These cameras are pre-assigned via the <strong>Video Points</strong> button (and the <strong>Video Points</strong> dialog) in the <strong>Alarms</strong> tab or <strong>Advanced Alarms</strong> tab of the AnalogInput, AnalogValue, BinaryInput, BinaryValue, Door, InfinityInput, InfinityNumeric, InfinitySystemVariable, MultistateInput, or MultistateValue editor. <strong>Note</strong>: See <a href="#">Overview of Video Integration and Configuration</a>, earlier in this chapter, as well as the section, <em>Using the Alarms/Advanced Alarms Tab of an Object Editor</em>, in Chapter 10, <em>Configuring Alarms</em>. Using the <strong>Video Points</strong> dialog (shown below) in these editors, you designate between one and four video points, whereby each numbered &quot;video point&quot; represents a frame in this VideoLayout's matrix.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Video Points Dialog</th>
<th><strong>Video Points</strong> dialog (shown below) in these editors, you designate between one and four video points, whereby each numbered “video point” represents a frame in this VideoLayout’s matrix.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Video Points</th>
<th><strong>Video Points</strong> dialog (shown below) in these editors, you designate between one and four video points, whereby each numbered “video point” represents a frame in this VideoLayout’s matrix.</th>
</tr>
</thead>
</table>

About the Video Points Dialog — Click the **Video Points** button on the **Alarms** or **Advanced Alarms** tab of the editors listed above to bring up the **Video Points** dialog. (See also Chapter 10, *Configuring Alarms*.) In this **Video Points** dialog, you may also configure a camera to record a video clip, for specified number of seconds, when the alarm goes off.
**Video Servers:** Use the **Video Servers** dropdown menu to select a video server on which the camera is located. (A VideoServer object must be already configured and the server online. See VideoServer Editor earlier in this chapter.)

**Cameras:** Use the **Cameras** dropdown menu to select a camera for the numbered video point. (The camera must be configured and enabled on the selected video server.)

**Rec:** Check the **Rec.** checkbox to record a video clip from the selected camera. Recording begins at the moment the alarm goes off.

**Duration:** In the **Duration** field, use the up and down arrows to select the number of seconds to record a video clip, once you check the **Rec.** checkbox.

**PTZ:** In the **PTZ** field, select the number of the preset camera view. (This camera must have PTZ (pan, tilt, zoom) capabilities in order to use this feature.) See also the General tab of the VideoLayout editor.

After you preassign the video point cameras to the frames (Chapter 10) you reference a video point number here (in the General tab of the VideoLayout editor) that corresponds with each numbered frame you configured in the Video Points dialog. Right click over the frame, select Video Points, then select 1, 2, 3, or 4. For example, the camera you specified as "Video point 1" in the object editor is assigned to the frame you reference as "1" in this VideoLayout object.

When the VideoLayout is launched, on an alarm associated with the object, this preconfigured video control matrix is displayed.

<table>
<thead>
<tr>
<th>Change Camera</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select <strong>Change Camera</strong> to assign or reassign a camera or &quot;video source&quot; to this video control frame.</td>
</tr>
<tr>
<td>Select the name of a server in the popup menu of server names, next to Change Camera. Then, in the next popup menu, select the name of a camera — for example, it might be called &quot;main lobby&quot; or &quot;loading dock&quot; — belonging to that server. The camera is assigned to the video control, and the camera's images immediately appear in its frame.</td>
</tr>
<tr>
<td><strong>Note:</strong> If a server is not available for connection (not online) then its list of cameras does not appear in the popup menu. The server must be available for connection. Likewise, a server's cameras must be enabled. If a camera is disabled (via Integral video server software) it does not appear in the menu.</td>
</tr>
<tr>
<td>In order to assign a camera to a video control, at least one video server must have been configured. (See the VideoServer editor.)</td>
</tr>
<tr>
<td><strong>Security considerations:</strong> Access to video servers may be restricted by Continuum's security system. Access to cameras on the video server may be restricted by the server's security system. That is, users see only the cameras to which they have been granted access.</td>
</tr>
<tr>
<td>Repeat this procedure for every video control frame in the matrix. You may select another camera, or even the same camera, for other video control frames. When you select the same camera for two or more frames, then the same camera images are displayed in those frames. You may also select cameras from more than one video server.</td>
</tr>
</tbody>
</table>
The following table describes other General tab video attributes and buttons, which allow you to adjust your video control images.

<table>
<thead>
<tr>
<th>Editor Attribute</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text Overlay</td>
<td>Check this checkbox to display the name of the camera, as well as the date and time, over each video control frame of the matrix. Click and remove the check to display no text.</td>
</tr>
<tr>
<td></td>
<td><strong>Top</strong> — Click this radio button to position the text at the top of each frame.</td>
</tr>
<tr>
<td></td>
<td><strong>Bottom</strong> — Click this radio button to position the text at the bottom of each frame.</td>
</tr>
<tr>
<td>Text Colors</td>
<td>You may change the color of the text in the text overlay by clicking one of the six colors in the color key, located beneath the text overlay radio buttons. These colors are:</td>
</tr>
<tr>
<td></td>
<td>Red</td>
</tr>
<tr>
<td></td>
<td>White</td>
</tr>
<tr>
<td></td>
<td>Blue</td>
</tr>
<tr>
<td></td>
<td>Yellow</td>
</tr>
<tr>
<td></td>
<td>Green</td>
</tr>
<tr>
<td></td>
<td>Black</td>
</tr>
<tr>
<td></td>
<td>Black is the default.</td>
</tr>
<tr>
<td>Brightness Contrast / Sharpness</td>
<td>Use the slider control to increase and decrease brightness, contrast, or sharpness, respectively.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The slider control on the Brightness, Contrast, or Sharpness blinks at any given time to indicate which setting is currently selected.</td>
</tr>
<tr>
<td>Reload Layout</td>
<td>Click this button to reload and refresh all the video controls.</td>
</tr>
<tr>
<td>Freeze All Video</td>
<td>Click this button to freeze every video image in every video control frame.</td>
</tr>
<tr>
<td></td>
<td>If you wish to freeze the image for just one video control, right click on the control frame and select Freeze Video from the popup. (See the table above.)</td>
</tr>
<tr>
<td>Capture Layout</td>
<td>Click this button to capture the image being displayed (live or recorded) in the selected video control frame and save it to a file.</td>
</tr>
<tr>
<td></td>
<td>The Capture Video Image Save dialog appears. Browse for the directory in which you want to save the image file, specify the file name, specify the image file type (.BMP, .JPG, and so on), and click Save.</td>
</tr>
<tr>
<td>Matrix Selections</td>
<td>To select or change the desired video-control matrix to display one, two, three, four, six, or nine video images in your layout, click one of these video control frame matrix buttons. The matrix changes immediately.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The three-frame and six-frame matrices display one frame larger than the others, as shown in these matrix buttons.</td>
</tr>
<tr>
<td></td>
<td>A video-control frame remains black until you assign a camera by right-clicking on its frame and selecting Change Camera from the popup. (See the table above.)</td>
</tr>
</tbody>
</table>
Introduction

The Pinpoint graphics application is used to produce dynamic virtual control panels right on your workstation.

So, what is a control panel? We’re sure you’re familiar with the control panels of the physical world. They are a collection of controls and displays that are hard wired to a metal panel. Because these are physically wired to particular places within the controlled system, they are difficult to modify as your requirements change.

Continuum control panels are computer-generated representations of physical panels. They consist of a screen display of buttons, switches, animations and text, and other “controls” that control particular points, particular elements of log or array points, point attributes, or system variables. Unlike physical control panels, these might be thought of as “virtual” panels. Every control placed on a Continuum control panel can be easily changed, deleted and re-assigned through software.

There are several types of controls. All fall under one of two categories: active or passive. Active controls are controls that can be manipulated by the user, such as a switch or button. Passive controls convey information, such as gauges and read-only text controls that display values.

A switch control, when “turned,” might set a point value or setpoint. Alternatively, you could have the switch or a gauge only display a point value.

Controls can also open another panel for display or take similar actions on the workstation itself. For example, a button labeled “Fans” could open a panel that displays the settings of all fans in the building.
Each button, switch, or the like is referred to as a “control.” A control panel can have one control, many controls, or even no controls at all.

To make panels more life-like, Pinpoint supports a simple form of animation that uses multiple images of the same control. Because each image is slightly different, viewing them in a sequential order produces the illusion of animation.

The following are examples of Continuum controls placed on a virtual panel using Pinpoint.

**Access Control Applications**

Pinpoint’s switch and button controls allow you to easily construct a panel to control a high security facility or a simple room access application.

The application displayed above is made up of a series of button controls commanding a prison cell complex.
HVAC Applications
Using Pinpoint’s animation capabilities, panels depicting airflow control take on a much clearer meaning with moving fans, oscillating dampers and flashing temperature warnings.

Controls
The following illustrated list outlines the various controls available in the Pinpoint application.

Switches
Pinpoint switch controls allow you to control two-state (on-off) points. In addition to their control capabilities, they also can display a different image for each state. Using the left mouse button as your “virtual finger” allows you to control the switch. Clicking once activates the control and automatically displays the control’s image associated with its activation.

The left switch shows a wall toggle switch in an active state. Clicking again on the switch deactivates the switch and displays the alternate image associated with an un-activated control.

You choose the bitmap image that defines the switch in both positions.
A library of pre-drawn images is included with Pinpoint should you desire to choose a ready-made solution. See Appendix D.

**Buttons**

Buttons work in a similar manner to switches. They allow you to control two-state (on-off) points, launch applications, etc. Buttons can be any shape, but they do not change appearance.

**Active Animated Buttons**

Active or animated buttons can be any shape you like. They can change color when pressed.

**Bar Control**

A bar control shows the value of the point by filling to a particular level—like a thermometer, filling up as the value (i.e., level of water) rises.

**Text Control**

A text control displays a textual representation of a point value. If the point is an input or output, it displays the point value in engineering units. For a numeric point, it displays the numeric value. For a string point, it displays the characters in the string. For a datetime point, it displays the date and time in the point.

Text controls allow you to change any attribute value of the Continuum point that an object is tied to.

**Door Control**

The door control provides a graphic display of a Continuum door object. It illustrates the switch states of the door by using configurable animation. Various icons illustrate the states of the door as: alarm, enabled/disabled, locked/unlocked, scheduled lock/unlock, trouble, timed unlock and enabled/disabled/keypad/reader access.

To make the controls operational, you have the option of:

- Using the default animation bitmap set.
- Choosing from several supplied bitmap sets.
- Using your own bitmap set.
Panel with Multiple Controls
If you have the security privileges to create new panels and would like to create a panel now, you may skip the rest of this chapter. However, before you proceed, it is a good idea to see what a complex panel of controls like the one shown above can actually do for you.
Operating Panel Controls
When you first open an-existing panel, it is automatically in a state called Run mode. You can tell the panel is in Run mode because the cursor looks like a hand pointing when placed over a control object—you can refer to it as the “hand cursor.”

To understand the panel on the previous page, each control is described below:

<table>
<thead>
<tr>
<th>Text Controls</th>
<th>Controller Time/Date</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Controller Date/Time: 4/5/09 12:31:42 PM</td>
</tr>
</tbody>
</table>

This is a text control tied to the system clock. It displays the date and time.

<table>
<thead>
<tr>
<th>Power Fail</th>
<th>Off</th>
</tr>
</thead>
</table>

This text control indicates whether the power fail condition is true or false.

The other text controls are also tied to various points throughout the system and include such information as the amount of free system memory, which server is being accessed, alarm and error counts, etc.

<table>
<thead>
<tr>
<th>Bar Control</th>
<th>Temperature Gauge</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0.0</td>
</tr>
</tbody>
</table>

This bar control is linked to a sensor and displays the temperature graphically.

<table>
<thead>
<tr>
<th>Switches</th>
<th>Gate Switches</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>On</td>
</tr>
</tbody>
</table>

These switch controls operate security gates. When on, the indicator on the top of the switch turns red.

<table>
<thead>
<tr>
<th>Gate 4</th>
</tr>
</thead>
</table>

This object indicates whether a gate in the building area is open (up) or closed (down) position.
Before You Begin

Before creating your own panels, let’s discuss the different image formats you will be using. Pinpoint lets you use many image formats to create your panels; however, there are benefits and drawbacks to using each format.

One thing to keep in mind as you build a panel is the number of controls in a panel. Due to polling limitations, a large number of controls could affect the rate at which a panel reacts to changes.

Where you store your image files also affects your system performance. Whether you access these images from a central location, such as a server, or from the local drive of a workstation makes a difference. Using a central location makes changes easier since you only have to make them on the “central” workstation. This is an important consideration if you are working with a large number of workstations. However, because the data must travel through a network, accessing them will be slower than if the data was retrieved locally. See Setting Up Pinpoint Options.

When you create a graphic to become part of your panel, we strongly suggest that you save the image in the lowest resolution possible, so that the resulting image file stays small and takes up less memory.

Keep this in mind also when you use Pinpoint’s image library. Even though the image library contains bitmap (*.bmp), JPEGs, icon, and enhanced metafile (*.emf) files, we recommend that you use the metafile graphics wherever possible. This is because metafiles are significantly smaller than the other formats, they scale up or down without distortion, and they support transparency better than the other formats.
Getting Started

Selecting Pinpoint from the Continuum Main Menu

1. Click on the hot spot on the left-hand side of the Continuum Main Menu, the System & Status menu page will appear.

2. Clicking on the Graphics Editor hot spot will bring the main Pinpoint Graphics panel (not show) to the screen.

Creating a Blank Pinpoint Panel

1. Click on Graphics Editor and an empty Pinpoint panel appears. Click the File option on the Pinpoint toolbar and the File drop down list appears. Click New from the File drop down list and the Create dialog appears.
2. Type a name into the Object Name field (the name simultaneously appears in the Alias field without spaces and/or special characters) and click the **Create** button. A new blank Pinpoint panel appears.
Setting Up Pinpoint Options

The next step is to determine whether you want to access the image folders (Graphics, Image, and Background folders) from a central location, such as a server, or on the local drive of a workstation. Using a central location makes changes easier since you only have to make them on the “central” location. This is an important consideration if you are working with a large number of workstations. However, because the data must travel through a network, accessing them will be slower than if the data was on each workstation.

The system performs this task during Continuum installation setup, but you can accomplish the setup with Pinpoint by performing the following steps:

1. Run Pinpoint from Windows Explorer or the Continuum Menu system.
2. From the View menu select Options; the dialog shown below appears.

3. Enter (or browse to) the appropriate locations where you want your graphics, image, and background files stored.

<table>
<thead>
<tr>
<th>Location</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graphics Folder</td>
<td>This is the ‘.pin’ file storage location of graphics that is accessed. In a multi-user setup this could be a shared location across the workstations.</td>
</tr>
<tr>
<td>Image Folder</td>
<td>This is the image file storage location that contains ready-made images that you can use to make graphic panels in Pinpoint. The installation program usually performs this optional setup. See Inserting Images.</td>
</tr>
</tbody>
</table>
### Location Description

<table>
<thead>
<tr>
<th>Location</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Background Folder</td>
<td>This is the background image file storage location that serves as the background for the panels. The background image graphic is a link to the background image.</td>
</tr>
</tbody>
</table>

**Note:** A signal icon ![X] warns you if there is an error within the path to the currently selected folder. Verify the path or browse to the desired folder. The icon disappears when a valid path is chosen.
Setting Up Miscellaneous Pinpoint Options

Although Pinpoint has default values for all options, you can change these options by performing the following steps:

1. Run Pinpoint from Continuum Explorer or from the Continuum Menu system.
2. From the View menu, select Options and click the Misc tab, the following tab page appears. The following table describes the Misc tab.

<table>
<thead>
<tr>
<th>Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Save Panel Field</strong></td>
<td></td>
</tr>
<tr>
<td>Warn Save Into Run Mode</td>
<td>If selected, Pinpoint displays a message asking if you want to save the panel file before you enter Run Mode; if not selected, Pinpoint saves the panel file when you enter Run Mode.</td>
</tr>
<tr>
<td>Make Backup Copy Panel File</td>
<td>If selected, Pinpoint will automatically make a backup copy of a panel (.pin) file when that panel file is saved in the graphics folder. Backup files have the extension: *.bck.</td>
</tr>
<tr>
<td><strong>Home Panel Field</strong></td>
<td></td>
</tr>
<tr>
<td>Home Panel Field</td>
<td>Enter (or browse to) a Pinpoint graphic as the Pinpoint application home panel. When the Home button of the Standard Tool Bar is clicked, the selected home panel opens.</td>
</tr>
<tr>
<td>Area</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Current Window Field</strong></td>
<td></td>
</tr>
<tr>
<td>No Change</td>
<td>Opens the Home Panel with no change to the current panel state.</td>
</tr>
<tr>
<td>Minimize</td>
<td>Opens the Home Panel and minimizes the current panel.</td>
</tr>
<tr>
<td>Close (default)</td>
<td>Opens the Home Panel and closes the current panel.</td>
</tr>
<tr>
<td><strong>Default Paper Orientation Field</strong></td>
<td>Select the radio buttons to choose the default paper orientation (landscape or portrait).</td>
</tr>
<tr>
<td><strong>Units of Measure Drop Menu</strong></td>
<td>Select the units of measure for the size of your canvas. The default is inches.</td>
</tr>
</tbody>
</table>

**Drag and Drop**
Pinpoint supports drag and drop of points from any Continuum source (normally the Explorer). With drag and drop, you can create an active control that is automatically linked to the object it was dragged from.

The drag and drop operation can be performed with either the left or right mouse button depending on what type of control you want to create on the Pinpoint canvas.

**Left Mouse Button**
When you drag and drop an object (other than a door) with the left mouse button, an active text control button will be created. With a door, a door control will be created.

To drag and drop an object with the left mouse button, proceed as follows:
1. Create a new panel.
2. Open Explore and adjust its size so that the Pinpoint panel is visible to one side.
3. Place the cursor over the object in Explorer that you want to place on the panel.
4. Depress and hold down the left mouse button while you drag the object onto the Pinpoint panel.
5. Release the mouse button. An active text control button appears on the Pinpoint panel.
Right Mouse Button

When you drag and drop an object with the right mouse button, you can choose one of eight different controls to place on the Pinpoint panel. The controls that drag and drop supports include:

- Text
- Edit Box
- Button
- Slider
- Check Box
- Progress Bar
- LED Number
- Door

To drag and drop an object with the right mouse button, proceed as follows:

1. Create a new panel.
2. Open Explore and adjust its size so that the Pinpoint panel is visible to one side.
3. Place the cursor over the object in Explorer that you want to place on the panel.
4. Depress and hold down the right mouse button while you drag the object onto the Pinpoint panel.
5. Release the mouse button. A popup menu appears listing the eight control types.
6. Click on the type of control you want.
7. The object will appear on the panel. (In the example shown below a button was selected.)

Pinpoint Tools

Drawing Capabilities
Pinpoint provides you with drawing capabilities that are similar to most end-user, drawing applications. You can draw or insert the following types of components onto a panel.

- Lines
- Polygons
- Rectangles
- Curves
- Closed Curves
- Ellipses
- Text
- Bitmap Images
- Windows Icons
- Windows Enhanced Metafiles
Pinpoint also provides the functionality needed to interact with the shapes and images drawn on the panel. Here are some of the actions that you can perform on the drawing components:

- Selection
- Movement
- Rotation
- Scaling
- Vertex Editing
- Alignment
- Cut, Copy, and Paste
- Grouping/Ungrouping
- Stacking Order (Z-Order)
- Grid Alignment

### Drawing Components

Components are objects that you place on the canvas (Pinpoint workspace) and manipulate. A component can be a simple shape (such as a rectangle or circle) or a complex collection of shapes or images.

To start drawing a component, you select the toolbar button or menu command that corresponds to a particular shape. The left mouse button is used to draw the shape, and the right mouse button cancels the draw command. How to draw each type of shape or component and perform other drawing related tasks are described below.

<table>
<thead>
<tr>
<th>How to …</th>
<th>User Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draw a component of equal proportions or at 90 degree angles.</td>
<td>Hold the <strong>SHIFT</strong> key while drawing a component. For example, if the user selected a rectangle tool button and then clicked in an empty area on the canvas while holding the <strong>SHIFT</strong> key, the application would draw a square.</td>
</tr>
<tr>
<td>Resize a component from the center</td>
<td>Hold the <strong>CTRL</strong> key while resizing a component.</td>
</tr>
<tr>
<td>Draw a line</td>
<td>Click the <strong>Line</strong> button and then click and hold the mouse button in an empty area on the canvas until the line is the desired length.</td>
</tr>
<tr>
<td>Draw a polyline</td>
<td>Click the <strong>Polyline</strong> button and then click in an empty area on the canvas. Click again to place an endpoint or corner. Double-click to finish drawing. Click the right mouse button to cancel the action.</td>
</tr>
<tr>
<td>How to ...</td>
<td>User Action</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Draw a polygon</td>
<td>Click the <strong>Polygon</strong> button 🟢 and then click in an empty area on the canvas. Click again to place an endpoint or corner. Double-click to finish drawing. Click the right mouse button to cancel the action.</td>
</tr>
<tr>
<td>Draw a rectangle</td>
<td>Click the <strong>Rectangle</strong> button 🟡 and then click and hold the mouse button in an empty area on the canvas. Drag the pointer until the rectangle is the width and length you want.</td>
</tr>
<tr>
<td>Draw a polycurve</td>
<td>Click the <strong>Polycurve</strong> button 🔵 and then click in an empty area on the canvas. Click to place an endpoint, two control points and another endpoint. Double-click to finish drawing or click the right mouse button to cancel.</td>
</tr>
<tr>
<td>Draw a closed curve</td>
<td>Click the <strong>Closed Curve</strong> button ⌜ and then click in an empty area on the canvas. Click to place an endpoint, two control points and another endpoint. Double-click to finish drawing or click the right mouse button to cancel. Unlike the polycurve, a fill color can be assign to a closed curve.</td>
</tr>
<tr>
<td>Draw an ellipse</td>
<td>Click the <strong>Ellipse</strong> button 🟣 and then click and hold the mouse button in the canvas until the ellipse is the size you want.</td>
</tr>
<tr>
<td>Add text</td>
<td>Click the <strong>Text</strong> button 📝 and then click in an empty area on the canvas. The text can be changed by right-click edit text or from the <strong>Text</strong> tab in the <strong>Display Properties</strong> pane.</td>
</tr>
</tbody>
</table>
| Add an image | Click the **Image** button 📸 to open a standard dialog from which you can select an image to insert on the canvas in the following formats.  
- .bmp  
- .ico  
- .jpg  
- .emf  
- .dib |
**Pinpoint Environment**

Pinpoint operates in two modes: **Design** and **Run**. In **Design Mode** you create a panel, which allows you to draw, animate, and insert objects, attach points, etc. In **Run Mode** the panel operates – showing assigned point values, opening/closing doors, etc.—as you designed it to do.

Below are the basic components of Pinpoint:

<table>
<thead>
<tr>
<th><strong>Pinpoint Window Features</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Menu bar</strong></td>
<td>The Menu bar comprises the standard Windows program functions and Pinpoint-specific functions such as Active Components (ties the component to a Continuum point), Window Control, and Pinpoint Help.</td>
</tr>
<tr>
<td><strong>Tool bars</strong></td>
<td>The tool bars provide editing functions in Pinpoint. When no applicable elements are open in the main window, the functions are grayed-out indicating their unavailability. A detailed description of every tool bar element is provided in Appendix C.</td>
</tr>
<tr>
<td><strong>Status bar</strong></td>
<td>The status bar along the bottom of the window indicates the status of the program, i.e., whether Pinpoint is in <strong>Design Mode</strong> or <strong>Run Mode</strong>, at what magnification the panel is displaying, etc. The status bar also provides you with useful prompts, and visual indication of the status of various keyboard functions.</td>
</tr>
</tbody>
</table>
Creating a Panel
To create a panel, select the Graphics Editor HotSpot from Continuum Explorer or from Pinpoint.

Note: Due to performance considerations, we recommend that you do not open more than five panels at a time.

From the Graphics Editor HotSpot

1. Click on the Graphics Editor HotSpot to open Pinpoint. A blank Pinpoint window appears.

2. Select File/New from the Menu bar. The following dialog appears:
3. Enter the name of your new panel, select your target location, and click **Create**. A blank Pinpoint panel appears in **Design Mode**.

Or

**From the Continuum Explorer**

1. In Continuum Explorer select **New/Graphics** from **Object** in the **Menu** bar and the **New** dialog appears.

2. Select your target location, enter the name of your new panel, and click **Create**. A blank Pinpoint panel appears in **Design Mode**.

Or

**From Pinpoint**

1. Select **New** from the **File** menu. The **Create** dialog appears.

2. Select your target location, enter the name of your new panel, and click **Create**. A blank Pinpoint panel appears in **Design Mode**.
Panel Configuration

General Tab
After creating a panel, select Configuration from the File drop down list. The General tab page of the Graphics dialog appears:

Enter the configuration information in the fields described below:

<table>
<thead>
<tr>
<th>Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Free text general description of the panel, up to 32 letters.</td>
</tr>
<tr>
<td>Graphic Panel File</td>
<td>File created when the panel is saved. By default it takes the same name as the panel object. All files are saved to a specific location (shared in a multi-user environment) usually set at c:\Program Files\Continuum\NewGraphicsFiles. Graphic panel files have a &quot;.pin&quot; extension.</td>
</tr>
<tr>
<td>Plain English Program to Run when Panel is Opened</td>
<td>Use this field to select a program or Infinity program when the panel is in Run Mode.</td>
</tr>
<tr>
<td>Stop When Panel is Closed</td>
<td>If selected and you have selected a Plain English program to run when the panel opens, the Plain English program stops running when you close the panel or put it into Design Mode. If not selected, the Plain English program continues to run when the panel is closed or put in Design Mode.</td>
</tr>
<tr>
<td>Window Size Field</td>
<td>Select whether the panel should be maximized or retain the position/size of the panel when it was last saved.</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Scroll Bars</td>
<td>Activate this checkbox to enable scroll bars in <strong>Run</strong> or <strong>Design Mode</strong>. Without scroll bars you can still view parts of a panel that do not initially appear onscreen, because the Pinpoint window can be resized by stretching the frame around the panel.</td>
</tr>
<tr>
<td>Active Polling Rate Only</td>
<td>Activate this checkbox to enable the active polling.</td>
</tr>
</tbody>
</table>
Canvas Tab Page
On the tab page, you can select the panel background color, canvas size, or background image:

<table>
<thead>
<tr>
<th>Field</th>
<th>User Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Background Color</td>
<td>Select the desired panel background color from the drop down list.</td>
</tr>
<tr>
<td>Background File</td>
<td>Enter the location of the background image file when the panel is loaded. If the background file changes, the panel will reflect the latest change. If you choose a background folder that is outside of the default background folder specified in the Options dialog, a copy of the file is placed in the default folder. If you choose a background file for your panel, it will override the background color. For example, if you have a gray background for your panel and then you add a graphic image to be the background, the image will show and the background color will not. Enter the dimensions of the canvas.</td>
</tr>
</tbody>
</table>
Object List Tab Page
This tab page displays a list of the points attached to active components and other objects, and allows you to perform basic operations like find and replace.

**Areas Description**

<table>
<thead>
<tr>
<th>Areas</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information Field</td>
<td>Provides you with applicable object names, component names, and polling rates</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the selected object.</td>
</tr>
<tr>
<td>Go To</td>
<td>Selects the active component and brings it to the center.</td>
</tr>
<tr>
<td>Find Object Field</td>
<td>Finds an object selected by the user.</td>
</tr>
<tr>
<td>Replace With Field</td>
<td>Replaces the object found in the Find Object field with an object selected by the user.</td>
</tr>
<tr>
<td>Replace Object Control</td>
<td>Replaces the selected object with the one specified by the user.</td>
</tr>
<tr>
<td>Replace All Objects Control</td>
<td>Replaces all selected objects with the one specified by the user.</td>
</tr>
</tbody>
</table>
Panel Default Properties
Before adding components to a panel, you can set their default properties. Default properties are common to all component types and are used as the initial settings for every component added to a panel. Your settings will not apply to existing objects in a panel, only to new objects.

To display the default properties for a panel, select Default Properties from the Edit menu or right click on the canvas and select Default Properties from the pop-up menu.

Line Properties
Use the Line tab page to define the default appearance of lines in a component. Select line color, style, and width. When Transparent is selected, lines will not appear when a panel is in Run Mode. Dashed or dotted lines can only be used when 0-point size is selected.
**Fill Properties**

Use the Fill tab page to define component fill properties. A solid fill, a foreground color without hatching, is the most commonly used fill. A hatched fill with a background color can also be used. When **Transparent Fill** is selected, a component’s fill won’t show when the panel is in **Run Mode**. Selecting Transparent Fill locks out the use of the other options on this tab page.

![Default Properties](image)

- **Foreground Color**
- **Background Color**
- **Hatch**
  - No Hatch
  - Downward Diagonal
  - Crosshatch
  - Diagonal Crosshatch
  - Upward Diagonal
Font Properties
These properties define the appearance of text in a component. Choose any True Type font and any typographical effects such as italic or underline. Because True Type fonts are the only fonts that support rotation, text is limited to True Type fonts.
Creating Panel Components

Creating an Active Text Component
To create an active text control to display the text of any object attribute, follow these steps.

1. From the Drawing tool bar, select the Text icon.

![Text Icon]

2. Select a location on the canvas. Click on the location and a text box appears.

3. At this point (while the text box is selected) you can manipulate any of the properties of the component. Right click to select from the context drop down list.

![Context Menu]

You can also click the **Properties** icon,

![Properties Icon]

or double click on the object to make the following dialog appear. You can also use the mouse or the **Nudge** buttons to move the text box.
**Note:** The **Nudge** buttons correspond to the arrow buttons on your keyboard and operate the same way with one exception: When you press and hold an arrow key, the object continues to move in the direction corresponding to the arrow, but you must repeatedly click a Nudge button to keep an object moving in the corresponding direction.

4. Use the above dialog to select and modify any visual property, font, filling, transparency, etc.

5. To make this text component an active component (tied to a Continuum point), select the text component and click the **Text** icon from the **Active Components** toolbar or select **Text** from the **Active Components** drop-down menu.
The **Active Text** tab page of the **Active Text Object** dialog appears.

<table>
<thead>
<tr>
<th>Area</th>
<th>User Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object Field</td>
<td><strong>Browse</strong> or type in the path to a Continuum point and attribute.</td>
</tr>
<tr>
<td>User Entry Field</td>
<td>Select this box to change the value of a point from the panel.</td>
</tr>
</tbody>
</table>

**High/Low Limit**

Enter the maximum and minimum values accepted when user entry is enabled.

6. If the selected object is attached to alarm(s), you can use the colorwells (which open like drop-down lists) attached to each field to select the color the text changes to in response to the following alarm events.

**Alarm States**

1. Active Alarms
2. Acknowledged Alarms
3. RTN Unacknowledged
4. Normal
5. Fault
7. Click the **Misc** tab page to adjust the polling rate. The polling rate determines how often a point is queried per millisecond to see if its value has changed.

### Active Button Object

<table>
<thead>
<tr>
<th>Polling Rate</th>
<th>Set this rate (in ms) to poll an object attribute for its values. This poll occurs when a panel is active (with focus) or when a panel is inactive (without focus) or when a control is with focus but out of view.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tool Tips Field</td>
<td>Select this checkbox if you want the user to view <strong>ToolTips</strong>. A ToolTip is a text box that describes an object’s function when the cursor passes over that object in <strong>Run Mode</strong>.</td>
</tr>
<tr>
<td>Attached Object</td>
<td>Activate this radio button if there is an object attached.</td>
</tr>
<tr>
<td>User Defined</td>
<td>Select this radio button to enter a custom ToolTip text for this component.</td>
</tr>
</tbody>
</table>

**Note:** Attached Object and User Defined are mutually exclusive.
8. Click the **OK** button. The text component is now tied to a Continuum Point.

To test a new panel, select **Run Mode** from the **Menu** or from the main tool bar:

![Menu and Run Mode](image)

This action saves the panel, and puts the panel into **Run Mode**.
Creating an Active Switch Control

To create an active switch control, follow these steps.

1. To make an active switch control, create two drawings or insert two images: one to show the ON state and one to show the OFF state.

2. Do not combine the ON and OFF images/drawings by grouping them together. Each remains a separate graphic object.

3. Select the OFF image. Drag it so that it covers the ON switch (you should see only the OFF appearance of the switch). Later, to show or change the setting of the point or attribute, the software toggles between the two graphics:
   - Displays the ON graphic (hides the OFF graphic) when the point or attribute is ON.
   - Displays the Off graphic (hides the ON graphic) when the point or attribute is OFF.
An active switch control always toggles between two discreet values, i.e., a binary or digital value. To make your graphic objects an active switch control, follow these steps:

1. Create two drawings or insert two images: one to signify one state (ON) and the other to signify the opposite (OFF). Place the graphic you created to symbolize OFF on top of the graphic you created to symbolize ON, completely covering the ON graphic.

2. Select the graphic object for the OFF setting.

3. Go to the **Menu** bar and select **Active Components/Switches**, or select the **Active Switch** button from the **Active Components** toolbar. The dialog illustrated below appears:

![Active Switch dialog](image)

Perform the following steps in the **Active Switch** dialog:

1. In the **Object** field on the Active Switch tab page, enter the full path to the point, object, or object attribute the switch controls. If you do not know the full path of the object or attribute, use the **Browse** button attached to the **Object** field to search the system. Since a switch has only two settings, the object or attribute must have only two states (as a digital point does). For example, you can have the switch set the **State** of a program – ENABLED or DISABLED.

2. Select the **User Entry** checkbox if you want to allow users to toggle the state of the object or attribute (for example, to allow an operator to turn on and off a light).

3. Press the **OK** button to save the control and close the Active Switch window.

4. To test the control, go to the **View** menu and select **Run Mode**, or select the **Run Mode** button from the Standard toolbar. This action saves the panel.
Creating an Active Rotation Control

An Active Rotation graphic control can be any shape or style, but it is most useful in a circular style control. For instance, you could draw a fan or pump with spokes inside the circular part of it. Then when the fan or pump is ON, the spokes continuously rotate.

**Note:** An Active Rotation control can be any shape or combination of grouped shapes.

Creating the Control

To make the graphic object an Active Rotation control, follow these steps:

1. Select the graphic object that you want to make a rotating control.
2. Go to the main Active Components menu and select Rotation or select the Active Rotation button from the Active Components toolbar.

**Note:** When creating objects to group as one, complete the grouping before selecting Active Components/Rotation or select the Active Rotation button. Separate elements of a group previously active lose their active link when grouped.
The **Active Rotation** dialog appears. Use this dialog to indicate what point the control represents, as well as other aspects of the control.

![Active Rotation dialog](image)

### Area | User Action
--- | ---
**Object Drop Menu** | Enter the full path or browse to the point the control represents. This is an option; you do not have to link the rotation to an object. It can be used simply for effect.

**Rotate when:** | **Always**
--- | ---
Indicates that the object always rotates and there is no need to select a point.

**Value is on**
You can use Value is on with analog (numeric) or digital (binary) points. The object rotates whenever the value of the point is not zero.

**Direction Field** | Choose a clockwise or counterclockwise rotation.

**Rotation Parameters Field** | **Rotation Rate**
Enter the rotation rate for the control. The valid range for this field is between 100 and 5000 milliseconds.

**Angle**
Enter the angle in degrees the control will rotate at each interval based on the **Rotation Rate**. The valid range for this field is between 1 and 180 degrees.
<table>
<thead>
<tr>
<th>Area (continued)</th>
<th>User Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Pivot Point</td>
<td>By default, a component chosen to be an <strong>Active Rotation</strong> object will rotate about its center. To change the center of rotation, click the <strong>Select Pivot Point</strong> button. The <strong>Center of Rotation</strong> dialog appears. Either drag with the mouse or use the <strong>Nudge Pivot</strong> buttons to move the rotation selector to the desired center of rotation.</td>
</tr>
</tbody>
</table>

To test the control, go to the **View** menu and select **Run Mode**, or select the **Run Mode** button from the Standard toolbar. This action saves the panel.
Creating a Personnel Picture Control
To display a set of personnel data including photos in a panel, follow these steps:

1. From the **Active Components** drop-down menu select **Personnel Picture Control**

![Active Components drop-down menu](image)

or, click the **Personnel Picture Control** from the **Active Components** toolbar.

2. The **Active Personnel Picture** tab page of the **Active Picture** dialog appears:

![Active Picture dialog](image)
Area | User Action
--- | ---
Person: | Either type in or browse for the personnel object name of the person whose photo you want to display, or enter any attribute that stores a personnel object. For example, any of the following door attributes may be used:
- LastPersonEntered
- LastPersonExited
- LastInvalidEntry
- LastInvalidEntryExit
  
  If you select one of these attributes, you can display a person’s photo when the person enters/exits through the door.

Fade:Delay Time | Enter the number of seconds you want to display a photo before it fades. If the delay is set to 0, the personnel photo will not fade.
Fade:File | Either type in or browse for the path to the personnel photo.
User Entry Checkbox | Activate this checkbox to change the control right from the panel in Run Mode.
Beep When the Picture Changes Checkbox | Activate this checkbox to hear a beep when a new photo appears.
Creating an Active Bar Control
A bar control is similar to a thermometer. It fills as the value rises and empties as the value falls.

To make an active bar component, follow these steps:

1. From the Drawing toolbar, select the rectangle icon.

   ![Rectangle Icon]

2. The cursor will change to a small plus sign. Draw a rectangle on the canvas by holding down the left mouse button and moving the mouse diagonally.

3. At this point (while the rectangle is selected), you can click the Properties icon from the toolbar or right click and select Display Properties from the context menu to edit any of the properties of the component.

   ![Properties Icon]

4. After clicking the Properties icon or selecting Display Properties, the Component Properties dialog appears. Select and modify any visual property, font, filling, transparency, etc.
5. To make this rectangle component an active bar component (tied to a Continuum point) select the **Active Bar** icon from the **Active Components** toolbar.

![Active Bar Object](image)

6. You can select the following properties:

<table>
<thead>
<tr>
<th>Area</th>
<th>User Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object Drop Menu</td>
<td>Either type in or browse for the Continuum point and attribute.</td>
</tr>
<tr>
<td>User Entry Checkbox</td>
<td>Select the check box to change the value of point right from the panel in <strong>Run Mode</strong>.</td>
</tr>
<tr>
<td>Scale Field</td>
<td></td>
</tr>
<tr>
<td>Top of Scale</td>
<td>Enter the maximum value to represent a completely filled bar.</td>
</tr>
<tr>
<td>Bottom of Scale</td>
<td>Enter the minimum value to represent an empty bar.</td>
</tr>
<tr>
<td>Direction Field</td>
<td></td>
</tr>
<tr>
<td>Vertical/Horizontal</td>
<td>Select a radio button to indicate which direction you want the bar to grow in proportion to the value.</td>
</tr>
</tbody>
</table>

7. Click the **OK** button and the rectangle component is now an Active Bar tied to your chosen Continuum point.

8. To test the new control, go to **Run Mode**. This saves the panel.

If the **User Entry** checkbox on the **General** tab page of the **Active Bar Object** dialog is checked, you can change the value of the Continuum point that the bar component is tied to by placing the mouse cursor over the bar component and clicking the left mouse button while in **Run Mode**.

An image of a calculator will appear. Either use the mouse to press the calculator buttons or use the keyboard to type in the new value. Press the **OK** button on the calculator to set the new value of the Continuum point the bar is tied to. Select the **Cancel** button to exit the calculator without changing the point value.
Creating an Active Button Control
A button can be any shape you like. For a button to change color when pressed, you must create a switch rather than a button. Buttons do not change appearance. Clicking a button can trigger one of the following events or actions:

- Open an object
- Open a panel
- Replace a point
- Run a Plain English program
- Start a Windows program
- Stop a Plain English program
- Toggle the value of a point

To create an active button control, follow these steps:
1. From the Drawing toolbar, select a shape or image button.
2. Select a location in the canvas.
3. At this point, (while the graphic area is selected) you can manipulate any of the properties of the component. Click the Properties icon in the toolbar or right click and select Display Properties from the context menu. The Component Properties dialog appears.
4. Use this dialog to select and modify any visual property, e.g., font, fill, transparency, etc.
5. Either click the **Active Button** toolbar icon or select **Buttons** from the **Active Components** drop-down menu. The **Active Button Object** dialog appears.

![Active Button Object dialog](image)

6. To make this shape component an active button component, select an action from the following **Action** field drop down list.

**Note:** The default selection for this menu is Open Panel.

![Active Button Object dialog](image)

7. After you select an action, the **Active Button** data entry fields change to reflect the information required for that action. The following sections provide you with how the Active Button tab page appears after each of the above actions are chosen.

26-44  
*TAC*
**Open Object**

After making this selection, perform the following user actions.

<table>
<thead>
<tr>
<th>Area</th>
<th>User Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Drop Menu</td>
<td>Select Open Object from the drop down menu.</td>
</tr>
<tr>
<td>Object Field</td>
<td>Enter or browse for the name of an object that this button will open.</td>
</tr>
<tr>
<td>OK</td>
<td>Select OK to make this object an active button.</td>
</tr>
</tbody>
</table>

**Open Panel**

After making this selection, perform the following user actions.

<table>
<thead>
<tr>
<th>Area</th>
<th>User Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Drop Menu</td>
<td>Select Open Panel from the drop down menu.</td>
</tr>
<tr>
<td>Panel Field</td>
<td>Enter or browse for the name of a panel that this button will open.</td>
</tr>
<tr>
<td>Current Window</td>
<td>Select the desired state that the current window should be in after the Active Button is clicked.</td>
</tr>
<tr>
<td>OK</td>
<td>Select OK to make this panel an active button.</td>
</tr>
</tbody>
</table>
Replace Point
After making this selection, perform the following user actions.

<table>
<thead>
<tr>
<th>Area</th>
<th>User Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Drop Menu</td>
<td>Select Replace Point.</td>
</tr>
<tr>
<td>Object Field</td>
<td>Enter or browse for the name of the point that will be replaced when you click the button.</td>
</tr>
<tr>
<td>OK</td>
<td>Select OK to make this point an active button.</td>
</tr>
</tbody>
</table>

**Note:** When you go into Run Mode, click on the replacement point you have selected to become an active button and you will be prompted for the point you want to replace.
Run Plain English Program
After making this selection, perform the following user actions.

<table>
<thead>
<tr>
<th>Area</th>
<th>User Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Drop Menu</td>
<td>Select Run Plain English Program from the drop down menu.</td>
</tr>
<tr>
<td>Program Field</td>
<td>Enter or browse to the name of the Plain English program you want the button to launch.</td>
</tr>
<tr>
<td>OK</td>
<td>Select OK to make this program an active button.</td>
</tr>
</tbody>
</table>
Start Windows Program
After making this selection, perform the following user actions.

<table>
<thead>
<tr>
<th>Area</th>
<th>User Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Drop Menu</td>
<td>Select Start Windows Program from the drop down menu.</td>
</tr>
<tr>
<td>Windows Program Field</td>
<td>Enter or browse to the name of the Windows program you want the button to launch.</td>
</tr>
<tr>
<td>Command Line Arguments Field</td>
<td>Enter any arguments, such as launching another application or opening a specific file that should be passed to the Windows program. (Optional)</td>
</tr>
</tbody>
</table>
| Button Wizard Control | The Button Wizard selection presents you (below) with menus (refer to the next section) that allow you to create a button to:  
  - Edit an existing object  
  - Create a new object  
  - Open an existing object  
  - Create a new object from an existing template object  |

Click OK to save your changes.
Button Wizard
The following menus are presented to you when you select the Start Windows Program Button Wizard.

Edit an Existing Window
After making this selection, perform the following steps.

1. At this menu, you can choose to open a specific object or select to open an object at a chosen location. Make your decision and click Next.

2. After deciding what you want the button to do, select the class of object you would like to have the button open and click Next.
3a. If you have chosen (in step 1) to open a specific object, the following menu will appear. Select the object that you would like the button to open and click Finish. Note that you can also Edit the object offline by making the offline selection.

3b. If you have chosen (in step 1) to open an object at a chosen location, the following menu will appear. Select the location of the object that you would like the button to open. Also at this menu, choose if you want the button to open objects at only the designated location or at a location of your choice. After making your selection, click Finish.
4. You will be presented with the Start Windows Program screen. Verify that the Action, Windows Program, and Command Line Arguments entries are correct and click OK.

5. To ensure that the edits you made have taken effect, enter Run mode and check if your edits have been implemented.

Create a New Object
After making this selection, perform the following steps.

1. Click on the class of object you would like to have the button create (from the scroll list) and click Next. Note that you can also Create the object offline by making the offline selection.

2. At this menu, select the directories that you want the object's folder and the object's device located and click Finish.
3. You will be presented with the Start Windows Program screen. Verify that the Action, Windows Program, and Command Line Arguments entries are correct and click OK.

4. To ensure that the edits you made have taken effect, enter Run mode and check if your edits have been implemented.
Open an Existing Window

After making this selection, perform the following steps.

1. At this menu, you can choose to open a specific object or select to open an object at a chosen location. After making your decision, click Next.

2. After deciding what you want the button to do, select the class of object you would like to have the button open and click Next.
3a. If you have chosen (in step 1) to open a specific object, the following menu will appear. Select the object that you would like the button to open and click Finish.

3b. If you have chosen (in step 1) to open an object at a chosen location, the following menu will appear. Select the location of the object that you would like the button to open. Also at this menu, choose if you want the button to open objects at only the designated location or at a location of your choice. After making your selection, click Finish.
4. You will be presented with the Start Windows Program screen. Verify that the Action, Windows Program, and Command Line Arguments entries are correct and click OK.

5. To ensure that the edits you made have taken effect, enter Run mode and check if your edits have been implemented.

Create a New Object from an Existing Template Object
After making this selection, perform the following steps.

1. At this menu, choose a template the button will use to create an object. After making your decision, click Next.
2. At this menu, select what location you want to create the object from the template and click Finish.

3. You will be presented with the Start Windows Program screen. Verify that the Action, Windows Program, and Command Line Arguments entries are correct and click OK.

4. To ensure that the edits you made have taken effect, enter Run mode and check if your edits have been implemented.
Stop Plain English Program
After making this selection, perform the following user action.

<table>
<thead>
<tr>
<th>Area</th>
<th>User Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Drop Menu</td>
<td>Select the Stop Plain English Program from the drop down menu.</td>
</tr>
<tr>
<td>Program Field</td>
<td>Enter or browse to the name of the Plain English program you want the button to stop.</td>
</tr>
<tr>
<td>OK</td>
<td>Select OK to make this program an active button.</td>
</tr>
</tbody>
</table>
**Toggle Value**
After making this selection, perform the following user action.

<table>
<thead>
<tr>
<th>Area</th>
<th>User Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Drop Menu</td>
<td>Select Toggle Value from the drop down menu.</td>
</tr>
<tr>
<td>Value Field</td>
<td>Enter or browse to a point that you want the button to toggle (i.e., on/off, lock/unlock, etc.).</td>
</tr>
<tr>
<td>OK</td>
<td>Select OK to make the designated point an active button.</td>
</tr>
</tbody>
</table>
**Current Panel**
After making this selection, perform the following user action.

<table>
<thead>
<tr>
<th>Area</th>
<th>User Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Drop Menu</td>
<td>Select Current Panel from the drop down menu.</td>
</tr>
<tr>
<td>Current Window</td>
<td>Select the desired state that the current window should be in after the Active Button is clicked.</td>
</tr>
<tr>
<td>OK</td>
<td>Select OK to make the designated point an active button.</td>
</tr>
</tbody>
</table>
Plain English (PE) Scripts
PE scripts can execute any command-line command. PE Scripts cannot have local variable declarations or labels. Note that PE scripts are executed before the selected Active Button performs its action (i.e., open panel, open object, etc.).

After making this selection, create or insert your PE Script and perform the following user action.

<table>
<thead>
<tr>
<th>Area</th>
<th>User Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check</td>
<td>Click this button to check the script for errors.</td>
</tr>
<tr>
<td>OK</td>
<td>Saves the Plain English Program.</td>
</tr>
</tbody>
</table>
Misc

The polling rate determines how often a point is queried per millisecond to see if its value has changed. After making this selection, perform the following user action.

<table>
<thead>
<tr>
<th>Area</th>
<th>User Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Polling Rate</td>
<td>Set this rate (in ms) to poll an object attribute for its values. This poll occurs when a panel is active (with focus) or when a panel is inactive (without focus) or when a control is with focus but out of view.</td>
</tr>
<tr>
<td>Tool/Tips Field</td>
<td>Select this checkbox if you want the user to view ToolTips.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> A ToolTip is a text box that describes an object’s function when the cursor passes over that object in Run Mode.</td>
</tr>
<tr>
<td>Attached Object</td>
<td>Select this button if you want to attach an object.</td>
</tr>
<tr>
<td>User Defined</td>
<td>Select this button to enter a custom ToolTip text for this component.</td>
</tr>
<tr>
<td>OK</td>
<td>Click OK to save the poll rate and the tool tip information.</td>
</tr>
</tbody>
</table>
Creating an Active n-Stage Animation Control

To create a n-stage animation:

1. Select Animation from the Active Components drop-down menu,

   or click the Active Animation toolbar icon.

2. In the dialog that appears select the Animation type, analog or digital. The default animation type, which appears in the Active Animation tab page of the Active Animation dialog, is analog.

   The selection you make in the Animation Type field determines the appearance of the tab page.
**Analog Animation** – Analog animation deals with analog points and allows images to be shown based on value ranges.

<table>
<thead>
<tr>
<th>Area</th>
<th>User Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value Field</td>
<td>Enter or browse to the analog value to be used to control which image is viewed for the animation.</td>
</tr>
<tr>
<td>Animation Type Drop Menu</td>
<td>Select the animation type from the drop-down list attached to this field. (Analog Animation)</td>
</tr>
<tr>
<td>Image Ranges</td>
<td>Value ranges for each chosen image file.</td>
</tr>
<tr>
<td>Image Files</td>
<td>List of the files to be used for this animation.</td>
</tr>
</tbody>
</table>

To manually list items, use the four icons at the top of the List Items field:

- ![Insert](image) Insert a new list item – Click this icon and type in the list item in the edit box.
- ![Delete](image) Delete a list item – Select the item to be deleted and click on this icon.
- ![Move Up](image) Move an item one up the list – Select the item to move and click this icon.
- ![Move Down](image) Move an item one down the list - Select the item to move and click this icon.

Also, to edit an existing list item, double click the item and make the appropriate changes in the open edit box.
## Area User Action (cont’d)

<table>
<thead>
<tr>
<th>Area</th>
<th>User Action (cont’d)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preview</td>
<td>Click this button to preview the files in the <strong>Image Files</strong> field.</td>
</tr>
<tr>
<td>High/Low Limit Fields</td>
<td>Enter maximum and minimum values. If you change either of these values, the ranges are automatically configured when the edit boxes lose their focus.</td>
</tr>
<tr>
<td>Change</td>
<td>By default, the ranges are split evenly over the range limits set in the <strong>High Limit</strong> and <strong>Low Limit</strong> fields. Use this button to change the high limit for a selected range (and as a result the low limit for the next higher range) in the <strong>Image Range</strong> field.</td>
</tr>
<tr>
<td>Reset</td>
<td>Click this button to reset all the ranges to their default ranges ((High limit – Low Limit)/ # of files in the image list). This is only applicable if you have made changes to the default range. The range is also reset when you modify high and/or low limits.</td>
</tr>
<tr>
<td>Hide Animation if Above/Below Range</td>
<td>Activate this checkbox to hide the animation if the value is above/below the high/low limits.</td>
</tr>
</tbody>
</table>

**Digital Animation** – deals with binary values and allows images to be played based on the value being On/Off or a change of state.

![Digital Animation](image)

Menu selections for the Digital Animation Type selection are discussed on the following page.
<table>
<thead>
<tr>
<th>Area</th>
<th>User Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value Field</td>
<td>Binary value to be used to control the state of which the image is to be viewed for the animation.</td>
</tr>
<tr>
<td>Animation Type Drop Menu</td>
<td>Select the type of animation from the drop down list attached to this field. (Digital Animation)</td>
</tr>
<tr>
<td>Image Files</td>
<td>List of the files to be used for this animation.</td>
</tr>
<tr>
<td></td>
<td>To manually list items, use the four icons at the top of the List Items field:</td>
</tr>
<tr>
<td></td>
<td>Insert a new list item – Click this icon and type in the list item in the edit box.</td>
</tr>
<tr>
<td></td>
<td>Delete a list item – Select the item to be deleted and click on this icon.</td>
</tr>
<tr>
<td></td>
<td>Move an item one up the list – Select the item to move and click this icon.</td>
</tr>
<tr>
<td></td>
<td>Move an item one down the list - Select the item to move and click this icon.</td>
</tr>
<tr>
<td></td>
<td>Also, to edit an existing list item, double click the item and make the appropriate changes in the open edit box.</td>
</tr>
<tr>
<td>Preview</td>
<td>Click this button to preview the files in the Image Files field.</td>
</tr>
<tr>
<td>Animate When On</td>
<td>Select this checkbox for the animation to continue repeatedly when the value is on. Deselect this checkbox for the animation to continue repeatedly when the value is off.</td>
</tr>
<tr>
<td>Animate only when Change of State</td>
<td>If this checkbox is selected the system runs through the image list one time for change of state ON, and then in reverse order for change of state OFF. This cycle repeats for every change of state.</td>
</tr>
<tr>
<td>Invisible When Off</td>
<td>Select this checkbox to make the image invisible when it is not animating. (when value = off)</td>
</tr>
<tr>
<td>Current Frame When Off</td>
<td>When the animation is off and visible, select this checkbox for the current frame to appear. Leave this checkbox unselected for the first frame in the image list to appear.</td>
</tr>
<tr>
<td>Image Rate</td>
<td>Rate (in ms) the system cycles through the images selected in Image Files.</td>
</tr>
</tbody>
</table>
3. After you have selected the Animation type and entered the properties, click the OK button. The process for making this object an **Active Animation** is complete. Click the Preview button in either Animation type to view the configured animation (for example; a sequence of propeller images).

Switch to **Run Mode** to test the animation. The mode switch saves the panel.
Creating an Active Animated Button Control

Like the Active Button, the Animated Button can be any shape. It also supports the same actions as an Active Button, but can change appearance when an event occurs. To create an active animated button control:

1. From the Drawing toolbar, select a shape (neither text nor images can be used as an active animated button).

2. Select a location in the canvas. After drawing the shape, highlight the object/component.

3. To make this shape component an active animated button component, you must either click Animated Button on the Active Components drop-down menu, or click the Animated Button icon on the toolbar.
4. Enter the appropriate information on the Active Animated Button tab page:

![Active Animated Button Tab](image)

<table>
<thead>
<tr>
<th>Area</th>
<th>User Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trigger Field</td>
<td>Enter or browse to the object used to trigger the animated effects of the button. The trigger is the point or attribute that initiates (&quot;fires&quot;) an event.</td>
</tr>
<tr>
<td>Trigger Options Drop Menu</td>
<td>Use the drop-down list to select the event that triggers button animation. The following are the three available choices:</td>
</tr>
<tr>
<td></td>
<td>• On/Off</td>
</tr>
<tr>
<td></td>
<td>• Alarm</td>
</tr>
<tr>
<td></td>
<td>• Ranges</td>
</tr>
<tr>
<td>Disable Action</td>
<td>Select this checkbox to disable the action on the button.</td>
</tr>
<tr>
<td>Action Field</td>
<td>Choose one of the actions to be triggered by the button from the following drop-down list. (Not Required)</td>
</tr>
<tr>
<td></td>
<td>• Open Object</td>
</tr>
<tr>
<td></td>
<td>• Open Panel</td>
</tr>
<tr>
<td></td>
<td>• Replace Point</td>
</tr>
<tr>
<td></td>
<td>• Run Plain English Program</td>
</tr>
<tr>
<td></td>
<td>• Start Windows Program</td>
</tr>
<tr>
<td></td>
<td>• Stop Plain English Program</td>
</tr>
<tr>
<td></td>
<td>• Toggle Value</td>
</tr>
<tr>
<td>Object Drop Menu</td>
<td>If needed, enter or browse to the action object.</td>
</tr>
<tr>
<td>Current Window</td>
<td>Select the checkbox that indicates what will happen to the current window when the panel is launched.</td>
</tr>
</tbody>
</table>
After selecting this tab, refer to the **Options** tab page of the dialog.

The **Trigger Option Values** that appear in the drop-down list are determined by the selection you make in the Trigger Options on the **Active Animated** button tab page. In the above example the choices in the drop down list are ON/OFF. Use this tab page to determine how the button appears in each state.

**Note**: Both ON and OFF require separate configuration.

**Area** | **User Action**
--- | ---
**On/Off Section** | The **Trigger Option Values** that appear in the drop-down list are determined by the selection you make in the Trigger Options on the **Active Animated** button tab page. In the above example the choices in the drop down list are ON/OFF. Use this tab page to determine how the button appears in each state.

**Fill** | Activate this checkbox to select **Fill** options for the state indicated in the **Trigger Option Value** field. The Fill Properties dialog appears.

**Visible** | Select this checkbox for the button to be visible in that state.

**Blink and Beep** | Select these checkboxes for the button to blink and/or beep in that state.

**Display Value** | Disabled in this version.
Inserting Images
To insert an image in Pinpoint, perform the following steps.

1. From the **Insert** menu select **Image Library**.

2. The **PinPoint Images** dialog appears displaying a folder for each type of image. When you click an “image type” folder below the individual images available for insertion appear. Additionally, a preview of the selected image appears in the right pane of the dialog.

3. Click the Insert button to insert a selected image. You can also double click on any image to insert the image into the panel display a preview of the image in the frame on the left side of the dialog. You can also insert an image by using the **Insert Image** button on the toolbar.

4. Whichever way you select to insert the image, you must click the **Close** button to remove the Pinpoint Images dialog.
Inserting a Scale

To insert a scale, follow these steps:

1. From the Insert menu select Scale.

2. The Scale dialog appears with the default scale type as linear. Properties for a circular type scale are dimmed.

<table>
<thead>
<tr>
<th>Area</th>
<th>User Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type Field</td>
<td>Select the scale to be linear or circular.</td>
</tr>
<tr>
<td>Orientation Drop Menu</td>
<td>To insert a Linear scale use the drop down list attached to the Orientation field to specify a horizontal or vertical scale.</td>
</tr>
<tr>
<td>Start and Sweep Angle Fields</td>
<td>To insert a circular scale, type in the number of degrees from vertical in a clockwise direction as the start angle. The default start angle is 90 degrees. The direction of the sweep angle is always clockwise. The default sweep is 180 degrees.</td>
</tr>
<tr>
<td>Direction Radio Buttons</td>
<td>Use these radio buttons to choose the direction that the numbers will appear on the scale. Select Clockwise and the numbers appear clockwise from low to high. Select Counterclockwise and the numbers appear counterclockwise from low to high.</td>
</tr>
<tr>
<td>Area (continued)</td>
<td>User Action</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Scale Color Drop Menu</td>
<td>Select a color for the scale using the Scale colorwell drop-down list.</td>
</tr>
<tr>
<td>Scale Settings Field</td>
<td></td>
</tr>
<tr>
<td>Limits</td>
<td>Use these fields to set the high and low limits of the scale. The limits can</td>
</tr>
<tr>
<td></td>
<td>be positive or negative (you can set the number of decimal places that appear</td>
</tr>
<tr>
<td></td>
<td>in the Decimal Places field). The High limit is the largest number displayed</td>
</tr>
<tr>
<td></td>
<td>on the scale, and the Low Limit is the smallest number displayed on the scale.</td>
</tr>
<tr>
<td>Subdivisions</td>
<td>Use these fields to set the number of Subdivisions and Steps that appear on</td>
</tr>
<tr>
<td></td>
<td>the scale. Subdivisions are the tiny tick marks between each Step (major tick</td>
</tr>
<tr>
<td></td>
<td>mark).</td>
</tr>
<tr>
<td>Show Units</td>
<td>Use these fields to type in and select the color for a short text string</td>
</tr>
<tr>
<td></td>
<td>usually used to display the units of scale. Select the color you desire from</td>
</tr>
<tr>
<td></td>
<td>the colorwell, which opens like a drop down list.</td>
</tr>
<tr>
<td>Show Numbers</td>
<td>Select Show Numbers to display numbers on the scale.</td>
</tr>
<tr>
<td></td>
<td>Type in or scroll to the number of decimal places you want to display in the</td>
</tr>
<tr>
<td></td>
<td>Decimal Places field.</td>
</tr>
<tr>
<td></td>
<td>Select the color you want the numbers to appear in Color field.</td>
</tr>
<tr>
<td></td>
<td>Use the Position drop down list to enter where you want the numbers to</td>
</tr>
<tr>
<td></td>
<td>appear. The options depend on the type of scale selected.</td>
</tr>
<tr>
<td></td>
<td>• Linear Horizontal – Top or Bottom</td>
</tr>
<tr>
<td></td>
<td>• Linear Vertical – Left or Right</td>
</tr>
<tr>
<td></td>
<td>• Circular– Inside or Outside</td>
</tr>
</tbody>
</table>
Inserting a Gauge
To insert a gauge, follow these steps:

Either from the toolbar or the Active Components menu, select Gauge. The Gauge dialog appears.

<table>
<thead>
<tr>
<th>Area</th>
<th>User Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object Field</td>
<td>Browse for or enter the Continuum point that the gauge will indicate.</td>
</tr>
<tr>
<td>Scale</td>
<td>Enter the numbers that will appear at the top and bottom of the gauge, respectively. For example, the top number in gauge shown below is 100.0 and the bottom number is 0.0.</td>
</tr>
<tr>
<td>Direction (Clockwise and Counter Clockwise)</td>
<td>Select the direction in which the numbers will appear on the scale. Selecting the Clockwise checkbox causes the numbers to appear clockwise from high to low. Selecting the Counterclockwise checkbox causes the numbers to appear from low to high in a counterclockwise direction.</td>
</tr>
<tr>
<td>Sweep Angle</td>
<td>Enter the angle, in degrees, (the direction of the sweep angle is always clockwise) for the gauge. For example, a gauge with measurements that form a complete circle would have a Sweep Angle of 360 degrees. The default sweep angle is 310 degrees. In the example below the sweep angle is 180 degrees.</td>
</tr>
<tr>
<td>Select Pivot Point</td>
<td>Click this button and the Select the Center of Rotation dialog appears. Use this graphic device to position the pivot point of the gauge. In the above example, the gauge appears in the default pivot position.</td>
</tr>
</tbody>
</table>
Inserting a Scale for a Gauge

This procedure is divided into two parts and provides you with the steps necessary to insert a scale for a gauge. The process includes steps for creating a scale and how to turn a line into a gauge and set it's properties.

**Note:** Refer to the two previous sections for detailed component property information about scales and gauges.

**Part 1: Inserting a Scale**

1. From the menu bar, select **Insert** and pick **Scale** from the drop down menu.

2. At the **Scale General** screen, make the following picks and entries:
   - Select Circular for your gauge type
   - Under the Scale Settings, Subdivisions, Steps field, enter a 4
   - Click OK to accept these settings

---

26-74   TAC
Part 2: Inserting a Gauge

A circular scale will be displayed in your Pinpoint working area with four subdivision steps as was specified.

1. Create a line. Make the line 2 points thick and red.
2. Move the line onto the scale so that it may be used as a gauge needle.

3. Click on the needle/line so that it is selected and then from the Active components tool bar, select the Gauge button. The gauge dialog appears displaying the Active Gauge tab.
4. In the Object field, browse for the continuum point and attribute that you want the
gauge to represent. For this example, the Analog1 point in the WS1 folder is
selected by clicking on the Select button.

![Image of Browse window]

5. In the Scale field, change the Top of Scale value from 0.0 to 100. This value
needs to be changed to match the value of the actual scale.

6. In the Dial Needle Parameters, Sweep Angle, change the value of 360 to 180
degrees. The scale that we are creating is 180 degrees.
7. From the screen in step 3, click on Select Pivot Point. Your Pinpoint working area now shows the scale with a circle (with a cross section) placed on the needle. This is the point of rotation. By using the Nudge Pivot arrows, nudge the rotation point over the black dot. When the rotation point is over the black dot, click OK to accept the location.

8. To test the gauge to see if it is working properly, select View from the menu bar and Run Mode from the View drop down menu.
9. The needle is pointing to 75.0, which reflects the value of the Analog1 point attached.

To change the value of the Analog1 point, right click on the needle and the following screen appears. Change the value from 75.0 to 25.0 and click OK to accept this value.

10. The gauge now points to the value of 25.0.
Importing a Pinpoint Panel

To import a Panel:

1. From the File menu select Import Panel File.

2. The Import Panel dialog appears displaying the available .pin files. Use the dialog to select a panel and either double click on the selected panel or click the Import button.
3. A Warning telling you that the imported file will completely replace the contents of the open panel appears. Click OK.
Window Controls

There are two ways to create Window controls: from the Window Controls menu or the Window Controls toolbar. Unlike creating controls from the Active Control menu or Active Control toolbar, you do not need to have an object selected in order to create a Window Control. Just select the appropriate control and it will be created for you on your Pinpoint working area. You can create one or more of the following controls:

- Window button
- Window edit box
- Window switch
- Window combo box
- Window slider
- Window video control
- Window checkbox
- Window web browser
- Window progress bar
- Window trend control
- Window LED number control
- Window door control

The Window Control menu and the Window Control toolbar are provided below.

![Window Controls Menu and Toolbar](image-url)
The Window Control Context Menu

This menu appears when you right click on a control you have created. The same menu is used by all of the Window controls. However, there are differences in the sub menus for some of the controls, as described below.

Note: The Object Properties of each Window Control are discussed later in their respective sections of this chapter.

- The Cut, Copy, Paste, and Delete selections are standard Window editing commands.
- Selecting Order allows you to move controls as shown below.
- Selecting Grouping allows you to group or ungroup controls as required. Note that controls need to be selected before being grouped or ungrouped.
Window Control Display Properties

There are two different Display Properties dialog screens that are used with the Window Controls (see below.) View the Display Properties of a Window Control as follows.

1. Select the Window Control.
2. Select Edit from the menu bar.
3. Click on Display Properties and the Display Properties dialog for the selected control appears.

When you select Display Properties for the following controls, the screen below appears. Use this screen to change the file name of the selected control.

- Edit Box
- Switch
- Combo Box
- Slider
- Progress bar
- Door Control

**User Action**

In the Name field:

1. Select the Name field.
2. Type in the new file name.
3. Click OK to verify your change.
When you select Display Properties for the following controls, the screen below appears. Use this screen to change the file name of the selected control and/or the caption of the selected control.

- Button
- Check Box

**User Action**

In the Name and/or Caption field:

1. Select the Name or Caption field.
2. Type in the new file name and/or caption.
3. Click OK to verify your change.

---

**Creating a Window Button Control**

Follow these steps to create a Window Button Control.

1. From the Window Controls menu or toolbar, select the Button control.
2. The following control will be created for you on your Pinpoint working area.

![Button Image]

3. Select **Edit** from the menu bar and click on **Object Properties**.

![Object Properties Dialog]

**Note:** The properties of this Window control are the same as the standard Pinpoint active button control. Refer to the section in this chapter called *Creating an Active Button Control* for detailed information about these properties.

The **Active Button Object** dialog appears.

![Active Button Object Dialog]

4. After you have selected the properties you require, click **OK**.
Creating a Window Edit Box Control

Follow these steps to create a Window Edit Box Control.

1. From the Window Controls menu or toolbar, select the Edit Box Control.

<table>
<thead>
<tr>
<th>Window Control Menu</th>
<th>Window Control Toolbar</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Controls</td>
<td></td>
</tr>
<tr>
<td>Button</td>
<td></td>
</tr>
<tr>
<td>Edit Box</td>
<td></td>
</tr>
<tr>
<td>Switch</td>
<td></td>
</tr>
<tr>
<td>Combo Box</td>
<td></td>
</tr>
<tr>
<td>Slider</td>
<td></td>
</tr>
<tr>
<td>Video</td>
<td></td>
</tr>
<tr>
<td>CheckBox</td>
<td></td>
</tr>
<tr>
<td>Web Browser</td>
<td></td>
</tr>
<tr>
<td>Progress Bar</td>
<td></td>
</tr>
<tr>
<td>Trend</td>
<td></td>
</tr>
<tr>
<td>LED Number</td>
<td></td>
</tr>
</tbody>
</table>

2. The following control will be created for you on your Pinpoint working area.

3. Select Edit from the menu bar and click on Object Properties.
4. When the **Edit Box Object** Properties dialog appears, select the properties you require as described in the table below and click **OK**.

![Edit Box Object Properties dialog](image)

<table>
<thead>
<tr>
<th>Area</th>
<th>User Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object Field</td>
<td>Browse or type in the path to a Continuum point and attribute.</td>
</tr>
<tr>
<td>User Entry</td>
<td>If selected, it would allow you to enter values into the edit control, just like active text.</td>
</tr>
<tr>
<td>3D Border</td>
<td>If selected, the edit control would be given a border.</td>
</tr>
</tbody>
</table>

**Note:** Selecting **Misc** allows you to access the Polling dialog (refer to the section called *Creating Panel Components* in this chapter for detailed information about polling.)
Creating a Window Switch Control

Follow these steps to create a Window Switch Control.

1. From the Window Controls menu or toolbar, select the Switch Control.

   **Window Control Menu**
   ![Window Control Menu]

   **Window Control Toolbar**
   ![Window Control Toolbar]

2. The following control will be created for you on your Pinpoint working area.

   ![Switch Control Image]

3. Select **Edit** from the menu bar and click on **Object Properties**.

   ![Edit Menu and Object Properties]

26-88   TAC
4. When the **Switch Properties** dialog appears, select the properties you require as described in the table below and click **OK**.

![Switch Properties Dialog](image)

<table>
<thead>
<tr>
<th>Area</th>
<th>User Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object</td>
<td>Browse or type in the path to a Continuum point and attribute.</td>
</tr>
<tr>
<td>Style</td>
<td>Scroll to which switch style you want to use.</td>
</tr>
<tr>
<td>User Entry</td>
<td>If selected, it would allow you to toggle the attached value.</td>
</tr>
</tbody>
</table>

**Note:** Selecting **Misc** allows you to access the Polling dialog (refer to the section called *Creating Panel Components* in this chapter for detailed information about polling.)
Creating a Window Combo Box Control

Follow these steps to create a Window Combo Box Control.

1. From the Window Controls menu or toolbar, select the Combo Box Control.

   Window Control Menu
   Window Control Toolbar

2. The following control will be created for you on your Pinpoint working area.

3. Select Edit from the menu bar and click on Object Properties.
4. When the **Combobox Object Properties** dialog appears, select the properties you require as described in the table below and click **OK**.

![Combobox Object Properties dialog](image)

<table>
<thead>
<tr>
<th>Area</th>
<th>User Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object Field</td>
<td>Browse or type in the path to a Continuum point and attribute.</td>
</tr>
<tr>
<td>List Items</td>
<td>The List Items are the possible values of the attached object that will be displayed in the Window Combobox control dropdown list. To manually list items, use the four icons at the top of the List Items field:</td>
</tr>
<tr>
<td></td>
<td>Insert a new list item – Click this icon and type in the list item in the edit box.</td>
</tr>
<tr>
<td></td>
<td>Delete a list item – Select the item to be deleted and click on this icon.</td>
</tr>
<tr>
<td></td>
<td>Move an item one up the list – Select the item to move and click this icon.</td>
</tr>
<tr>
<td></td>
<td>Move an item one down the list - Select the item to move and click this icon.</td>
</tr>
<tr>
<td></td>
<td>Also, to edit an existing list item, double click the item and make the appropriate changes in the open edit box.</td>
</tr>
<tr>
<td>Autofill</td>
<td>Automatically inserts the values of a selected object in the List Items field.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> A message will appear informing you that the current list of items will be overwritten with the newly selected values.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Selecting <strong>Misc</strong> allows you to access the Polling dialog (refer to the section called <strong>Creating Panel Components</strong> in this chapter for detailed information about polling.)</td>
</tr>
</tbody>
</table>
Creating a Window Slider Control

Follow these steps to create a Window Slider Control.

1. From the Window Controls menu or toolbar, select the Slider Control.

   Window Control Menu

   Window Control Toolbar

2. The following control will be created for you on your Pinpoint working area.

3. Select Edit from the menu bar and click on Object Properties

   Object Properties...
4. When the **Slider** dialog appears, select the properties you require as described in the table below and click **OK**.

![Slider dialog](image)

<table>
<thead>
<tr>
<th>Area</th>
<th>User Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Object Field</strong></td>
<td>Browse or type in the path to a Continuum point and attribute.</td>
</tr>
<tr>
<td><strong>Scale</strong></td>
<td></td>
</tr>
<tr>
<td>Top of Scale</td>
<td>Enter the maximum value to represent a completely filled slider.</td>
</tr>
<tr>
<td>Bottom of Scale</td>
<td>Enter the minimum value to represent an empty slider.</td>
</tr>
<tr>
<td>Integers Only</td>
<td>This check box is used if you want the slider scale to be in whole numbers</td>
</tr>
</tbody>
</table>

**Note:** Selecting **Misc** allows you to access the Polling dialog (refer to the section called *Creating Panel Components* in this chapter for detailed information about polling.)
Create a Window Video Control

A video control window is used to display a live or recorded video stream from a source video object – a surveillance camera or a file containing a recorded video – which you assign to the video control window.

Follow these steps to create a Video Control.

1. From the Window Controls menu or toolbar, select the Video Control.

![Window Control Menu and Toolbar](image)

A new video control window appears:
2. Place the cursor over the empty video control window, and click right. A popup menu appears:

| Cut   |
| Copy |
| Paste |
| Delete |
| Order  |
| Grouping  |
| Display Properties... |
| Object Properties... |
| Delete Active Link |

3. As an option, if you want to assign a name to the new video control, select **Display Properties**.

   The **Video Properties** dialog appears:

4. Enter the name of the video control window over the default name, *VideoCtrl*.

5. Check the **Preserve Original Video Aspect Ratio** checkbox if you are going to resize the video control and want to preserve its original aspect ratio in the resize. That is, it prevents you from accidentally distorting the dimensions of the image. This box is not checked, by default.

   **Note:** This checkbox is for live video only. If you are using a video source file, please ignore this feature.

6. Click **Apply**, then **OK**.
7. From the popup menu, select **Object Properties**:

The **Video Properties** dialog appears:

From the **Active Video** tab, as an option, you may select a source data object. However, you must select either a video source file or a video source device (surveillance camera.)

**Note:** If you wish to select a source object, it must be an object that has two states – something that can be on or off, enabled or disabled, set or cleared, and so on. Live or recorded video is displayed only when the object is an on/enabled state. It does not display when it is in an off/enabled state. If you do not wish to select a source object, then live images are displayed continuously, and recorded file video is played either once (by default) or continuously, at your discretion via the **Loop Forever** checkbox (described in the following text.)
8. If you select a source data object, click the browse button in the **Play when object value is On** field, search for, and select an object that has an on/off (or enabled/disabled) state. For example, it can be an alarm.

9. Click the **Video Source File** radio button if you want to play back a recording from a video file, or click the **Video Source Device** radio button if you want to display live images from a surveillance camera. (**Video Source File** is selected, by default.) If you are selecting **Video Source File**, go to step 11.

10. When you click **Video Source Device**, select a video driver from the dropdown menu. For example:

Your system must be configured with video surveillance-camera software in order for video driver selections to appear in the dropdown menu.

**Suggested Hardware for Live Video Feed**

The following video hardware is recommended for use with the video control window:

- CreativeLabs WebCamGo+ USB camera
- Hauppage WinTVGo Model 190
- Any capture board with VGA/DirectX compatibility
- Integral’s FlashBus cards

**Note:** As shown above, the four checkboxes are not selectable when you click **Video Source Device**. These are video source file configuration features only.

Go to Step 12.
11. When you select **Video Source File**, click the browse button in the **Video Source File** field to browse for a AVI, MOV, or MPG file whose video recording you want to play back. Use the four checkboxes to configure the file’s video display, as follows:

**Loop Forever**
Check this box when you want the recorded video in the file to play back continuously (over and over again). This box is not checked, by default. Remove the check from this box when you want the file’s recorded video to play back only once.

**Note:** If you have selected a source data object, the video is played back (once or continuously) **only** when the object is on/enabled. If the object is turned off or becomes disabled during playback, the playback stops and the image disappears from the video control window.

**Show configuration menu**
Check this box when you want access to the video control window’s configuration popup menu – accessible in either design mode or run mode. This menu, shown below, allows you modify the display in a number of ways:

<table>
<thead>
<tr>
<th>View</th>
<th>Volume</th>
<th>Speed</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The **Show configuration menu** box is checked by default. Remove the check to deny access to the configuration menu – for example, if you don’t want security guards or certain other users to change the video display. (Configuration menu selections are described later in Step 13.)

**Show Play Controls**
Check this box when you want to display a play button, a menu button, and a playback slider control along the bottom of the video control window, as shown in Step 12. This box is checked by default. Remove the check to hide these controls. (Play controls are described in Step 12.)

**Auto Play when panel loads**
Check this box when you want the video control window to begin playback automatically, as soon as its panel loads on the screen. This box is not checked by default.
12. When you are satisfied with all your object property settings, click **OK** (or click **Cancel** to dismiss the settings and the **Video Properties** dialog).

**Live images** – If you are viewing live video from a device (surveillance camera) the live image appears. For example:

![Live image example](image1.png)

**Recorded images** – If you are viewing a recorded video file, the beginning of the recording appears (in a stopped state) in design mode in your video control window. For example:

![Recorded image example](image2.png)

**Note:** Your video control window can play a video stream in either design mode or run mode. In the recorded video image above, notice the play controls along the bottom of the control window. (You must have checked the **Show Play Controls** checkbox in the **Video Properties** dialog.) Live images (from a video source device) do not display play controls.
Play Controls – In run or design mode, the play controls function as follows:

- **Play button**
  Click the play button to begin or resume the playback of a video. This button becomes a stop button when the video is playing, as shown below:

- **Menu button**
  Click the menu button (next to the play button) to bring up the configuration menu at any time, while the video is playing or stopped:

  Configuration menu selections are described in Step 13.

- **Playback slider control**
  The length of the slider control represents the entire duration of the recorded video. The position of the slider control button represents the current spot in playback — for example, if the slider button is located in the middle of the slider, then playback is 50 percent completed. Use the slider button to go to a specific spot in the recording. Click and drag the slider control button right to advance the recording forward, as well as all the way to the right to go to the end of the recording. Likewise, slide it left to go back to a previous spot in the recording, or all the way to the left to restart the entire recording.
13. Configure the size, sound, and speed of your video stream via the configuration menu. (You must have checked the **Show configuration menu** checkbox in the **Video Properties** dialog.) This menu also allows you to make a “still” copy of the image inside the video control window, open and close the window, and pause, stop, and resume playback.

To use this menu, click right on the video control window in run or design mode. The configuration popup menu appears:

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Key Combination</th>
</tr>
</thead>
<tbody>
<tr>
<td>View</td>
<td></td>
</tr>
<tr>
<td>Speed</td>
<td></td>
</tr>
<tr>
<td>Volume</td>
<td></td>
</tr>
<tr>
<td>Copy</td>
<td>Ctrl+C</td>
</tr>
<tr>
<td>Command...</td>
<td>Ctrl+F5</td>
</tr>
<tr>
<td>Half Size</td>
<td>Alt+2</td>
</tr>
<tr>
<td>Normal Size</td>
<td>Ctrl+1</td>
</tr>
<tr>
<td>Double Size</td>
<td>Ctrl+2</td>
</tr>
</tbody>
</table>

14. Click **View** to select the size of the image from its popup menu, as shown above. **Half Size** reduces the image by 50 percent. **Double Size** increases the image to twice its current size. **Normal Size** restores the image to its original (100 percent) size.

15. Click **Volume** to adjust the video’s sound (if the video has sound) using the volume slider control, as shown below:

Click and drag the slider button down to decrease volume. The integer inside the slider button indicates the percentage of full volume. For example, the 90 shown above means 90 percent of full volume. Likewise, drag the slider up to increase volume.
16. Click **Speed** to adjust the playback speed using the speed slider control, as shown below:

![Speed Slider Control](image1)

Click and drag the slider button down to decrease playback speed. The integer inside the slider button indicates the percentage of speed, where 100 percent is normal speed.

Click **Copy** to make a still snapshot of the image currently inside the video control window. This is useful if you want to show a picture of something important happening at a precise moment during the course of a video recording. This image can be pasted into documentation files, for example.

**Note:** Copy copies only the image, not the video control window.

17. Selecting **Misc** allows you to access the Polling settings (refer to the section called Creating Panel Components in this chapter for detailed information about polling.)

![Video Properties Window](image2)
Creating a Window Check Box Control

Follow these steps to create a Window Check Box Control.

1. From the Window Controls menu or toolbar, select the Check Box Control.

2. The following control will be created for you on your Pinpoint working area.

3. Select Edit from the menu bar and click on Object Properties.
4. When the **Check Box** dialog appears, select the properties you require as described in the table below and click **OK**.

![Checkbox Object Properties](image)

<table>
<thead>
<tr>
<th>Area</th>
<th>User Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object Field</td>
<td>Browse or type in the path to a Continuum point and attribute.</td>
</tr>
<tr>
<td>User Entry</td>
<td>Allows you to toggle the attached value.</td>
</tr>
</tbody>
</table>

**Note:** Selecting **Misc** allows you to access the Polling dialog (refer to the section called *Creating Panel Components* in this chapter for detailed information about polling.)
Creating a Window Web Browser Control

A web browser control window allows you to show web pages inside a Pinpoint panel. This can be either a URL address or a local HTML file. You control which web pages to display in a web browser control window, based on certain trigger conditions. As such, when a point is turned on, one page is displayed; when it is off, another web page is displayed. For example, you can display different web pages, depending on the current state of an alarm – that is, when an alarm is active, acknowledged, returned, and so on. Depending on your needs, this control can also host any type of active document, such as Microsoft Word or Excel.

Typically, you may want to use the web browser control to display documentation, perhaps instructions for handling an active alarm. In HVAC applications, for example, when the outside temperature gets too hot or too cold, and triggers alarm, you could display a web site for the local weather forecast.

Note: Your web browser control window must be in run mode in order for the web source object to display in the window. Switch from design mode to run mode after you have configured your web browser control.
To create a new web browser control window:

1. Click the web browser (globe) icon in your Window Controls toolbar.

   An empty web browser control window appears:
2. Place the cursor over the top of the empty window, and click right. A popup menu appears:

3. As an option, if you want to assign a name to the new web browser control, select Display Properties. The Web Browser Properties dialog appears:

Enter the name of the web browser control window over the default name, WndWebBrowser. Click Apply, then OK.

4. From the popup menu, select Object Properties:
The Web Browser Control Object Properties dialog appears:

5. You must assign a trigger for the web browser control. The trigger comprises a string object (representing a URL address or an HTML file) and a trigger, which defines the condition under which your web page appears.

From the General tab, shown above, select a String Object. Click the browser button in the String Object field, and select a Continuum string object.

6. From the General tab, shown above, select a Trigger Option from the dropdown menu:

String URL
By default, you may simply bring up a URL or HTML page in your web browser control window, every time the web browser window opens – that is, whenever the string object that you assigned is turned on. When you choose this String URL, the Options tab is therefore not selectable.
**On-Off**
Select this option when you want to launch two different web pages in your web browser control window – one when the string object is turned on, and the other when it is turned off. When you select **On-Off**, the **Options** tab becomes selectable, as shown below:

![WebBrowser Control Object Properties](image)

From this On-Off **Options** tab, in the **On** field, enter a URL address, or click the browse button to browse for an HTML file that you want to launch in your web browser control window when your string object is turned on. Likewise, in the **Off** field, enter a URL address, or click the browse button to browse for an HTML file that you want to launch in your web browser control window when your string object is turned off.
Alarms
Select this option when you want to open different web pages according to a particular state of an alarm, when an alarm is triggered on your string object. For example, you can launch one URL or HTML file when an alarm is active, another when it is acknowledged, another when it is returned, and so on. When you select Alarms, the Options tab becomes selectable (see below):

In this Options tab, there are five fields, one field for each state of an alarm, as shown above. In each state’s respective field, enter a URL address or use the browse button to browse for an HTML file. When your string object triggers an alarm, the web page that you specify will open according to the state of the alarm.

7. From the General tab, as an option, you may specify a home page for your web browser control window. To do, simply enter a URL address in the Home Page field, or click the browse button to browse for an HTML file to launch as a home page.

When the web browser control window is active, click the home icon at the top of the window to go to the specified home page.
8. From the General tab, you may select user entry mode and theater mode by checking the User entry URL and Theater Mode checkboxes, respectively. By default, User entry URL is checked and Theater Mode is unchecked.

**User entry URL**
This feature allows you to navigate in run mode with a manual entry. To do so, enter a URL address in the edit entry field at the top of the web browser control window, as shown below:

![User entry URL](image)

**Theater Mode**
This feature displays the web browser control window without the navigational buttons and edit entry field. Using theatre mode, you may create buttons that trigger certain conditions whereby a different web page appears based on which particular button you click. Each button would be labeled according to the web page that it retrieves.

9. Selecting Misc allows you to access the Polling settings (refer to the section called Creating Panel Components in this chapter for detailed information about polling.)
Creating a Window Progress Bar Control

Follow these steps to create a Window Progress Bar Control.

1. From the Window Controls menu or toolbar, select the Progress Bar Control.
   
   **Window Control Menu**
   
   ![Window Control Menu]

   **Window Control Toolbar**
   
   ![Window Control Toolbar]

2. The following control will be created for you on your Pinpoint working area.

   ![Created Progress Bar Control]

3. Select **Edit** from the menu bar and click on **Object Properties**.

   ![Menu with Object Properties selected]

26-112  TAC
When the **General** tab of the **Progress Bar Object Properties** dialog appears, select the properties you require as described in the table below and click **OK**.

![Progress Bar Object Properties Dialog](image)

<table>
<thead>
<tr>
<th>Area</th>
<th>User Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object Field</td>
<td>Browse or type in the path to a Continuum point and attribute.</td>
</tr>
<tr>
<td>High/Low Limit</td>
<td>Enter maximum and minimum values. If you change either of these values, the ranges are automatically implemented on the progress bar.</td>
</tr>
<tr>
<td>Display Value</td>
<td>Select to display the progress bar values.</td>
</tr>
<tr>
<td>Units</td>
<td>Select this pick to show the values in engineering units.</td>
</tr>
<tr>
<td>Vertical</td>
<td>Select to change the progress bar from horizontal to vertical.</td>
</tr>
<tr>
<td>User Entry</td>
<td>Allows you to change the value through the calculator.</td>
</tr>
</tbody>
</table>
4. Click the **Colors** tab to view the Colors dialog. This screen allows you to select colors for:
   - Text
   - Background
   - Start
   - End

You can select different colors from the individual drop down colorwells for each color field.

5. After you have selected the Color properties you require, click **OK**.

**Note:** Selecting **Misc** allows you to access the Polling dialog (refer to the section called *Creating Panel Components* in this chapter for detailed information about polling.)
Creating a Window Trend Control

A trend control window is used to display points of data, plotted on a trend graph from one or more sources (data objects) over a period of time. Data from the objects are displayed in user-customized formats on a graph within the trend control window. For example, these can be line, point, or bar graphs. The trend window consists of four main areas:

- Graph plot area, with optional grid (center of window)
- Pen units scale (left side of window)
- Time scale (bottom of window)
- Pen labels area (beneath the time scale by default). This area lists the pens (a key to the data object sources) that are plotted on the graph. You may move the pen labels area to the right side of the trend control windows via the Graph Properties dialog, discussed later in this section.

The trend window with its four main areas is shown below. In this example, the trend control has three pens, each of which is polling data for temperature, in degrees Fahrenheit:

You may select the color and plot-point design of each pen, via the pen style properties.

**Note:** Your trend control window must be in run mode in order for Pinpoint to poll live data from the data source objects and plot it on the graph. Switch from design mode to run mode after you have configured your pen properties and your graph properties.

Andover Continuum CyberStation Configurator’s Guide 26-115
Margin
The area surrounding the entire trend control window is called the margin. You may change the margin color (as well as many other characteristics of the graph) via the Graph Properties dialog, discussed later in this section.

Scrolling
Pen scale units begin at 0 at the bottom of the graph, by default. You may scroll the pen units scale and the time scale by placing the cursor over one of the scales, holding down the left mouse button, and dragging the scale up or down (for the pen scale) or from side to side (for the time scale). You may also scroll up the pen units scale to show negative unit values. Scrolling the scales is useful when you want to demarcate a certain area of plots on the graph.

Zooming
Your trend control window also allows you to zoom in and zoom out on the graph. The zoom features are contained in the graph’s run mode menu. For more information on zooming, please see Using Graph and Pen Popup Menu Features.

Creating a New Trend Control Graph
Follow these steps to create a Window Trend Control.

1. From the Window Controls menu or toolbar, select the Trend Control.
A new graph appears:

The graph is empty, and it does not display the pen labels area because you have not yet created a pen. However, the active pen unit scale and the time scale appear at the left side and bottom of the graph, respectively. Notice that the pen units scale begins at 0 at the bottom of the graph. Notice also the graph’s grid also appears.

Adding a New Pen

When you have no pens, you will first want to add a pen and assign it a source data object to track. To add a pen, perform the following steps.

1. Place the cursor over the graph, and click right. In design mode, this popup menu appears:
2. Select **Add New Pen** from the popup menu. The **Pen Properties** dialog appears:

![Pen Properties dialog]

3. Designate the source of the data, the *pen data object*. Click the browse button in the **Pen Data Object** field, and search for an object whose data you wish to poll, track, and plot.

   A data source is a real-time source (object attribute)

   **Note:** The name of the pen data object becomes the pen label (i.e., the name of the pen). Pen labels appear in the pen labels area of the trend control window – on the bottom of the window by default, or on the right.

4. In the **Scale** area, enter a range of values for the data that is plotted on the graph. Enter a minimum value and a maximum value in the **Top** and **Bottom** fields, respectively.
5. In the **Style** area, you may customize the appearance of the pen itself, as it appears on the graph. Style characteristics include pen color, what kind of line connects the data points, as well as the style of the data points themselves.

**Pen Color**
Click this button to select a color for the pen – that is, the color of the data points and the style of the lines that connect them.

**Style**
From the **Style** dropdown menu, select a style for showing how the pen (and its trend of plotted data points) is displayed on the graph. For example – a trend line, bar chart, etc. The menu provides the following choices.

<table>
<thead>
<tr>
<th>Line</th>
</tr>
</thead>
<tbody>
<tr>
<td>Area Fill</td>
</tr>
<tr>
<td>Bar</td>
</tr>
<tr>
<td>Vertical Lines</td>
</tr>
<tr>
<td>Horizontal Lines</td>
</tr>
<tr>
<td>Points</td>
</tr>
</tbody>
</table>

**Data Point Style**
From the **Data Point Style** dropdown menu, select a style for marking a data point itself. The menu provides the following choices:

- ▲ Triangle
- ◆ Nothing
- ● Dot
- ■ Square
- ✱ Diamond
- ♦ ▲ Invert Triangle

**Hide this pen**
Check this box when you don’t want this pen to appear on the graph. The pen continues to record data from its source data object, but does not plot data on the graph. A gray screen covers the pen itself in the pen labels area. For example, the pen on the left is hidden:

The **Hide this Pen** box is *not* checked by default.

To implement your new pen with pen settings, click **OK**. To dismiss the changes and revert to the previous style settings, click **Cancel**. The pen labels area appears in the trend control window.
About Pens
In order for Pinpoint to poll data from the source objects, you must first be in run mode.
Typically you would switch from design mode to run mode only after you have configured all your pen properties via the Pen Properties dialog, and after you have configured your graph properties via the Graph Properties dialog.

All pens belonging to a trend control window are displayed in the window’s pen labels area. The list of pens in the pen labels area is scrollable if there are more pens than the area can display. In the pen labels area, each pen is listed as a pushbutton. Each label name appears on its respective button.

You may select a pen as follows:

- Click its pen button in the pen labels area.
- Click on its actual pen data plotted on the graph.

When you select a pen, the active pen scale and active time scale change according to how that pen is configured.

Once the pen labels area is created on the trend control window, you may access the Pen Properties dialog by moving the cursor over one of the pens in the pen labels area, clicking right, and selecting Pen Properties from the popup menu, as shown below:

![Pen Properties](image)

Configuring Graph Properties
You may customize your graph properties via the trend window's Graph Properties dialog. To access the Graph Properties dialog, click right on the graph area, and select Properties, as shown below in the graph’s design mode popup menu:

![Graph Properties](image)
The **Graph Properties** dialog appears, with the following tabs:

- Pens
- Plot
- Pen Units
- Miscellaneous

These property tabs are described in the subsections that follow.

**Graph Plot Tab Properties**

From the **Plot** tab, you may:

- Specify the color and size of the trend control’s margin. The margin is the area that surrounds the trend control window.
- Assign a label title for the trend control window.
- Specify the background color of the graph area.
- Show or hide the graph’s grid.
- Customize the time scale – hide it, make it visible, display the text vertically or horizontally.
Margin
Select the margin's background color and size. From the Background Color dropdown menu, select a color from the color palette. The default color is blue.

From the Size up and down buttons, select the number of pixels, or enter a number in the Size field.

Plot
Select the graph's background color as well as whether to show or hide the grid. From the Background Color dropdown menu, select a color from the color palette. The default color is gray. Check the Grid Marks checkbox if you want to show the grid. Remove the check if you want to hide the grid. The Grid Marks box is checked by default.

Label
In the Label field, as an option, you may enter a name for the trend control window. This label appears above the graph. Click the Font button to select a typeface and font for the trend control label, as well as for the text throughout entire trend control window. Check the Show checkbox when you want to show the trend control label name. Remove the check in the Show checkbox when you want to hide the label name. A trend control window looks like this:

![Trend Control Window Example](image)

Time Scale
Check the Show Time Scale checkbox when you want to show the time scale on the trend control window. Remove the check when you want to hide the time scale. The Show Time Scale box is checked by default. Check the Vertical Text checkbox when you want to display time scale text vertically, at a right angle. This box is not checked, and text is displayed horizontally, by default. When you check this box, text is displayed vertically, as shown below:

![Time Scale Example](image)
Graph Pen Labels Tab

The Pen Labels tab allows you to show, hide, and position pen labels, as well as pen label units, on the trend control window:

Labels
Check the Show Pen Labels checkbox when you want to display the pen labels on the trend control window. Remove this check to hide all pen labels. Click the Show at the Bottom radio button when you want to display the pen labels along the bottom of the trend control, beneath the time scale. By default, this button is selected, and pen labels are displayed on the bottom.
Click the **Show on the Right** radio button when you want to display the pen labels along the right side of the trend control. By default, this button is *not* selected. When you display pen labels on the right, it looks something like this:

### Units

Check the **Show Pen Units** checkbox when you want to display the pen units scale. For example:

Remove the check when you do not want pen units displayed. By default, the **Show Pen Units** box is *not* checked.
Check the **Vertical Text** checkbox when you want to display text in the pen scale vertically. By default, the **Vertical Text** box is checked, and text is displayed vertically, at a right angle. When you do not display pen scale text vertically, it is displayed horizontally. For example:

![Graph Pens Tab](image)

**Graph Pens Tab**

The Pens tab simply lists the pens that are currently configured for the trend control window, as shown below. It also allows you to add or delete a pen, as well as access the Pen Properties dialog, where you may check and/or modify a pen’s properties.
Add
To add a pen to the trend control, click the Add button. The Pen Properties dialog appears, as shown in Adding a New Pen, shown earlier in this section.

Delete
To delete a pen from the trend control: From the pens list, select the pen you want to delete, then click the Delete button.

Properties
To check and/or modify the properties for an existing pen: From the pens list, select a pen, and then click the Properties button. The Pen Properties dialog appears. Please see Adding a new Pen.

Configuring Miscellaneous Graph Properties – the Misc Tab
Selecting Misc allows you to access the Polling settings (refer to the section called Creating Panel Components in this chapter for detailed information about polling.)
Using the Graph and Pen Popup Menu Features
There are some useful other features in the graph and pen popup menus, both for run
mode and design mode.

Run Mode Menu Features
The run mode popup menus for the graph and the pen labels are shown below, respectively:

Pause
Select Pause to stop the plotting of new sample data on the graph.

Restart
Select Restart after a pause, to resume the plotting of data on the graph.

Auto Scroll
Select Auto Scroll when you want the graph to scroll to the left automatically whenever
more data samples are plotted on the graph. This allows you to see the latest plotted
data.

Fit Time
Select Fit Time to show all the plotted data on the graph at once, beginning with the time
of the first plot in the leftmost part of the graph, and ending with the latest plot on the
rightmost part of the graph.
**Time Zoom In**
Select **Time Zoom In** to zoom into the graph area (time axis) by 50 percent of its current size. For example:

Before zoom:

![Graph before zoom](image1)

After zoom:

![Graph after zoom](image2)

**Time Zoom Out**
Select **Time Zoom Out** to zoom out of the graph area (time axis) by 50 percent of its current size.

**Object Properties**
Select **Object Properties** to launch the data object (Continuum point) editor for the source data object whose data is being polled and plotted.

**Hide**
Select **Hide** to hide the selected pen.
Design Mode Menu Features

The design mode popup menus for the graph and the pen labels are shown below, respectively:

Properties
Select **Properties** to launch the **Graph Properties** dialog for the trend control window.

Add New Pen
Select **Add New Pen** to launch the **Pen Properties** dialog, which allows you to add a new pen to the trend control window. See also Adding a New Pen.

Pen Properties
Select **Pen Properties** to launch the **Pen Properties** dialog containing all the settings for that particular pen.
Creating a Window LED Number Control

A light-emitting diode (LED) number control window allows you to simulate a digital LED number display, based on numeric values it receives from a source data object that is assigned to the number control. The number control can be a multiple-digit integer, up to 10 digits. You may also display the digits in certain colors to indicate various states of an alarm, when your data object has triggers an alarm.

**Note:** Your number control window must be in run mode in order for the source object values to display in the window. Switch from design mode to run mode after you have configured your number control.

To create a new LED number control window:

1. Click the LED number control icon on the window controls toolbar or from the Window Controls dropdown menu.

A new, empty LED number control appears. By default, it has four digit places:

A new, empty LED number control appears. By default, it has four digit places:
2. Place the cursor over the LED control window, and right click. A popup menu appears:

![Popup menu](image)

3. As an option, if you want to assign a name to the new LED number control object, select **Display Properties**. The **LED Number Control Display Properties** dialog appears:

![LED Number Control Properties dialog](image)

Enter the name of the LED number control object over the default name, `WndLEDNumberCtrl`. Click **Apply**, then **OK**.
4. From the popup menu, select **Object Properties**:

The **LED Number Control Object Properties** dialog appears:

5. From the **General** tab, assign a source data object to the LED number control. Click the browse button in the **Object** field, search for, and select an object whose numeric values you want to display in the digit placeholders in the number controls.

**Note**: Your LED number control must be in **run mode** before the integer can be displayed.
6. From the **General** tab’s **Digits** area, in the **Minimum Places** field, select the minimum number of digits you want in the number control. Four is the default, as shown in the empty number control in Step 1. You may select a minimum of one digit and a maximum of 10 digits. For example, if you select a minimum of seven, your LED number control might look like this:

![LED Number Control](image)

7. From the **General** tab, check the **User Entry** checkbox if you want to be able to manually change the integer value of the number control’s source object. This box is checked by default.

To change the value as a user entry:
1. Place the cursor over the number control while it is in run mode.
2. Click the left mouse button. An image of a calculator appears.
3. Use the calculator buttons or the your keyboard to type in the new value. If you click the calculator’s **OK** button, the value shown in the calculator window becomes the new value of the number control’s source object. (Click the calculator’s **Cancel** button to dismiss the calculator and keep the previous value.)

8. From the **Alarms** tab, shown below, you may select a color for each state of an alarm. When your data object triggers an alarm, the integer in the LED number control appears in the specified color, depending on its current state:
9. For each alarm state, select a color from the dropdown color palette:

When you have finished, your Alarms tab settings might look like this:
For example, when the LED number control is in run mode, and its object has triggered an alarm that is in an active state, the digits are displayed in red:

For example, when the LED number control is in run mode, and its object has triggered an alarm that has been acknowledged, the digits are displayed in green:

10. Selecting **Misc** allows you to access the Polling settings (refer to the section called *Creating Panel Components* in this chapter for detailed information about polling.)
Creating a Window Door Control

The Window Door Control provides you with a graphic display of a Continuum Door Object. It illustrates the switch states of the door by using configurable animation. Icons illustrate the states of the door. These icons show the door as:

- Alarm
- Enabled/disabled
- Locked/unlocked
- Scheduled lock/unlock
- Trouble
- Timed unlock
- Enabled/disabled keypad/reader access

To make the control operational, you have the option of:

- Using the default animation bitmap set.
- Choosing from several supplied bitmap sets.
- Using your own bitmap set.

Creating a Door Control in Design Mode

To create a Window Door Control while in design mode, click the door control icon on the Window Controls Toolbar.

Follow these steps to create a Window Door Control.

1. From the Window Controls menu or toolbar, select the Door control.

2. The following control will be created for you on your Pinpoint working area.
3. Select **Edit** from the menu bar and click on **Object Properties** or right click on the door control and select **Object Properties**. You are presented the **Door Control** dialog page.

![Door Control dialog page](image)

4. At the **General** tab, select the properties you require as described in the following table.

![General tab of Door Control dialog](image)
<table>
<thead>
<tr>
<th>Area</th>
<th>User Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object</td>
<td>Browse or type in the path to a door object to attach to this control.</td>
</tr>
<tr>
<td>Style</td>
<td>Select a style of door that you want to use from the drop down menu.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The default style of the door is shown in the previous illustration.</td>
</tr>
<tr>
<td>User Entry</td>
<td>If checked, it would allow you to interact with the door control when in Run Mode. While in Run Mode, right click on the door control to access the following context menu and make the appropriate selection.</td>
</tr>
<tr>
<td>Switch Animation</td>
<td>Check this box if you want the selected set of bitmaps in the style combobox to reflect the state of the door switch or to represent the locked/unlocked state of the door. If the attached door is not configured for a switch (switch channel is zero), the switch animation checkbox is unchecked and disabled and the locked/unlocked state of the door is represented.</td>
</tr>
<tr>
<td>Flat Appearance</td>
<td>If not checked, the door control will have a raised edge (appearing like a button.)</td>
</tr>
</tbody>
</table>

|          | ![Door Control Options](image) |

![Door Control Options](image)
5. At the **Advanced Alarms Images** page, you can choose to display a specific image for a forced entry, door ajar, or custom alarm, by browsing to or entering an image file (in their respective edit boxes) and then specifying the alarm link (1 through 8) from the door editor’s alarm page. If the alarm enrollment associated with the alarm link is in the alarm stage, the specified bitmap is displayed. The custom alarm can be attached to any alarm link.

**Note:** If advanced alarms are not required, make sure the Forced Entry, Door Ajar, and Custom controls are set to zero.

At the Forced Entry, Door Ajar, and Custom drop down menus, select (from 0 to 8) an appropriate designation for the file that you selected.
6. Select the **Custom Images** tab if you wish to use your own door style images. Browse to or enter the names of your custom set of bitmaps in the Open, Closed, Alarm, and Trouble edit boxes. Files must be entered for both the Open and Closed images; the Alarm and Trouble images are optional. If the Alarm and Trouble images are blank, the door control checks the door switch state and implements the appropriate Open or Closed image.

**Note:** If you are not going to use custom images, ensure that the Open, Closed, Alarm, and Trouble edit boxes are blank.
7. At the **Personnel Data** page, you can select up to four attributes to be displayed in the details dialog. You can select any personnel attributes listed to be displayed under the personnel picture of the last person to enter or to exit through the attached door. If the check box next to the attribute is checked, it will be displayed in the dialog, otherwise, it is considered disabled and will not be displayed. The check boxes allow the user to display less than four attributes.

![Personnel Data Page](image)

8. At the **Plain English (PE) Script** page, you can execute any command-line command. PE Scripts cannot have local variable declarations or labels. Note that PE scripts are executed before the selected Active Button performs its action (i.e., open panel, open object, etc.).

```plaintext
myCtStartFanOutput = on
run myCtLoggingFanPig
Print "Fan 15 located at Mech Room has started" to message window
```
9. After making this selection, create or insert your PE Script and perform the following user actions.

<table>
<thead>
<tr>
<th>Area</th>
<th>User Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check</td>
<td>Click this button to check the script for errors.</td>
</tr>
<tr>
<td>OK</td>
<td>Saves the Plain English Program.</td>
</tr>
</tbody>
</table>

10. At the Misc page, you can access the Polling settings (refer to the section called Creating Panel Components in this chapter for detailed information about polling.)
Appendix A
Commissioning the Controller
Before the NetController can be operated, the controller’s network address information must be entered so the Continuum workstation can communicate with the controller. This operation is called “commissioning”.

Note: For commissioning information regarding the Andover Continuum BACnet b4920, see the BACnet Technical Reference, 30-3001-862. To commission the bCX1 series controllers refer to the bCX1 Controller Technical Reference, 30-3001-890. Information about commissioning the 9702 is detailed on the product face plate.

What You’ll Need
Commissioning a NetController requires a laptop or other computer that is running an ASCII terminal emulator. Terminal emulators are common programs that allow you to communicate simply with RS-232 devices. One emulator program, HyperTerminal, is built into Windows NT and is available from the Accessories menu off of the Start menu.

Connections
You can connect to the NetController either directly or through a modem, using a device with a keyboard and display. These devices are often referred to as ASCII terminals, TTY replacements, or terminals. We call them command terminals.

Your command terminal must be DEC VT100 or VT220 compatible, or your computer must be running a terminal emulation program for one of these terminals.

Communications between the NetController and the command terminal is through the RS-232 interface. Connect the NetController Comm Port and the command terminal’s Serial or Comm port.

Connections made through a modem are straightforward; however, refer to the modem manufacturer’s guidelines before making the connection.

Direct connection requires an RS-232 Null Modem cable. The NetController’s default state is for connection to the CyberStation via a modem. If you are connecting directly to the controller via an RS-232 null modem cable, select “MODEM RS-232 OVERRIDE” on the NetController’s display panel.

RS-232 communications operates at a number of speeds called the Baud Rate. Both the NetController and the command terminal must be set to the same baud rate to communicate. Use Comm3 on the NetController. The following table shows the correct default settings:

<table>
<thead>
<tr>
<th>RS-232 Settings</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Baud rate</td>
<td>9600</td>
</tr>
<tr>
<td>Data Length</td>
<td>8 bits</td>
</tr>
<tr>
<td>Parity</td>
<td>None</td>
</tr>
<tr>
<td>Stop bits</td>
<td>One</td>
</tr>
</tbody>
</table>
Example of NetController Commissioning Using HyperTerminal

The following is an example procedure for connecting the CyberStation to the NetController using the emulator program, HyperTerminal, built into Windows. Open HyperTerminal from the Accessories menu off the Start menu.

- For modem connection, enter a name for your connection, select an icon, and click OK.
- For direct connection, enter a name for your connection and click OK.
The **Connect To** dialog appears.

- For modem use, fill in the appropriate dial-up information, select the desired port and click **OK**.
- For direct connection, select the desired port and click **OK**.
When the **Port Settings** tab of the **COM1 Properties** dialog appears, configure your command terminal port settings as follows, and click **OK**:

![COM1 Properties dialog](image)

- **Bits per second**: 9600
- **Data bits**: 8
- **Parity**: None
- **Stop bits**: 1
- **Flow control**: None
Logging on to the NetController

After connection, power up the terminal and the NetController. In the blank screen at the command terminal type:

- For modem connection, type &.
- For a direct connection, type WINDOW.

In either case, the characters do not echo to your display. If they were received properly, the command terminal interface window appears:

For security reasons, access to the NetController internal setup program is limited to people who need to use it, so you must log on the system. Your System Administrator should have been given a User ID and Password. The default User ID and Password are both ACC. These defaults should be changed as soon as possible to prevent unauthorized users from entering Continuum.

Type your user name and press the TAB key, then type your password and click Enter to log into the controller.
The Command Terminal Main Window appears containing the following features:

**Menu Bar**
There are four menus (View, Edit, Connect, and Logout), with the current menu highlighted. In the figure above, View is the current menu.

**Command Prompt**
Issue commands to the system at the R> prompt in the Command Window. (The R indicates “Ready.”)

**Status Bar**
The status line displays information on the status of the Infinity control system.

Toggle between the Command Prompt and Menu Bar by using the F4 key.
Setting the NetController Ethernet Address Information
Select Edit from the Menu Bar. Using the arrow keys, move the cursor down to highlight Controllers and press Enter.

After the ‘Open a Controller’ window appears, press the F2 function key and use the arrow keys to select your NetController. Then press Enter.
The Ethernet setup form contains all the address information. Enter the requested numbers supplied by your Network Administrator.

Name: Displays the default name for the controller. You can change this at the CyberStation workstation. Do not enter anything here.

Description: This description is also entered at the workstation.

Serial Number: Automatically displays the serial number of the controller. You do not enter it.

Model: Automatically displays the controller model number. You do not enter it.

Status: Displays Offline or Online depending on whether or not the controller is on the network.

EnergyNet Id: Enter the ID of this controller on your Andover Continuum Network.

ProbeTime: Displays the rate per second that the controller probes the network for other devices.

Version: Displays the version of the controller

Ethernet ID: Automatically displays the controller Ethernet ID number. You do not enter it.

To set the IP address, press TAB until the TCP/IP button is highlighted and press Enter.
Setting the NetController IP Address

Enter the appropriate information when the TCP/IP window appears. Use the arrow keys to move around in the window.

IP Address: Displays the Internet Address of the controller.
Subnet Mask: Displays the Subnet Address of the controller.
Default Router: Displays the Router ID number on your LAN.
PPP IP Address: Displays the Point-to-Point Protocol Address of the controller.
Max Response Time: Displays the Number of seconds the system is to wait for a response to a command before it is determined that communications are lost.

After entering the particulars, press the TAB key until the Save button is highlighted and press Enter.

Back at the main form, TAB to the Save button and press Enter.

Commissioning is now complete from the controller end. You will still have to create a new controller object and fill in many of these numbers at the CyberStation workstation to complete the process.
Appendix B

Points - Electrical Types
Infinity Electrical Types and BACnet Objects

Continuum supports BACnet-compliant devices — for Andover Continuum b4920, bCX1 (b40x0 series), and b3 controllers, as well as third-party devices.

When you create an InfinityInput or InfinityOutput residing on Andover Continuum BACnet controller controller, a BACnet Analog, Binary, or Multistate input or output object is also created, depending on the electrical type you assign when the InfinityInput or InfinityOutput point is created via their respective editors.

For example, if you select an analog electrical type, Voltage, a BACnet AnalogInput or AnalogOutput is also created. If you select a binary electrical type, Digital, a BACnet BinaryInput or BinaryOutput is also created. If you select a multistate electrical type, Supervised or Tristate, a MultistateInput or MultistateOutput object is created, respectively.

These BACnet Analog, Binary, and Multistate input and output objects may be viewed in the BACnet devices portion of the Continuum Explorer’s navigation pane. Their Infinity point counterparts may be viewed in the Infinity portion of the navigation pane. Please see Chapter 14 for a description of the Analog, Binary, and Multistate object editors, as well as BACnet device operations in general.

InfinityInput Types

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACC_Airflow</td>
<td>Not Available: This electrical type will be available in a future release.</td>
</tr>
<tr>
<td>ACC_Keypad</td>
<td>Not Available: This electrical type will be available in a future release.</td>
</tr>
<tr>
<td>ACC_Pressure</td>
<td>Not Available: This electrical type will be available in a future release.</td>
</tr>
<tr>
<td>ACCTemp(DegC)</td>
<td>Use this electrical type for Andover Continuum thermistor type temperature sensors, and for the EMX 170/SP 100 temperature sensor modules. This input type performs the conversion from voltage to temperature in degrees Celsius.</td>
</tr>
<tr>
<td>ACCTemp(DegF)</td>
<td>Use this electrical type for Andover Continuum thermistor type temperature sensors, and for the EMX 170/SP 100 temperature sensor modules. This input type performs the conversion from voltage to temperature in degrees Fahrenheit.</td>
</tr>
<tr>
<td>Counter</td>
<td>Use this electrical type for a pulse counting input. The counter triggers on the falling edge of the input waveform.</td>
</tr>
<tr>
<td>Electrical Type</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Digital</td>
<td>Use this electrical type of the input point is an ON or OFF contact closure. After you select Digital as an electrical type, a checkbox for Polarity will appear. If you want to invert the meanings of ON and OFF, click the box to put a check mark in it.</td>
</tr>
<tr>
<td>InputCurrent</td>
<td>Use this electrical type if the input is a current type.</td>
</tr>
<tr>
<td>RTD1000TempC</td>
<td>Use this electrical type for RTD 1000 Ohms temperature (Celsius) sensors.</td>
</tr>
<tr>
<td>RTD1000TempC2W</td>
<td>Use this electrical value if the sensor is a Resistive Thermal Device Temperature Sensor, 1000 Ohms, Degrees Celcius, 2 wire.</td>
</tr>
<tr>
<td>RTD1000TempF</td>
<td>Use this electrical type for RTD 1000 Ohms temperature (Fahrenheit) sensors.</td>
</tr>
<tr>
<td>RTD1000TempF2W</td>
<td>Use this electrical value if the sensor is a Resistive Thermal Device Temperature Sensor, 1000 Ohms, Degrees Farenheit, 2 wire.</td>
</tr>
<tr>
<td>RTDTemp(DegC)</td>
<td>Use this electrical type for Andover Continuum 1K RTD resistive type temperature sensors. These sensors must be wired to two consecutive input points where the first channel number is an odd number. Assign the odd number as the channel number. This input type automatically performs the conversion from resistance to temperature in degrees Celsius. RTD Temp is only available on 9400 and 9500 series controllers.</td>
</tr>
<tr>
<td>RTDTemp(DegF)</td>
<td>Use this electrical type for Andover Continuum 1K RTD resistive type temperature sensors. These sensors must be wired to two consecutive input points where the first channel number is an odd number. Assign the odd number as the channel number. This input type automatically performs the conversion from resistance to temperature in degrees Fahrenheit. RTD Temp is only available on 9400 and 9500 series controllers.</td>
</tr>
<tr>
<td>RTDTempC2W</td>
<td>Use this electrical type if the sensor is a Resistive Thermal Device Temperature Sensor, 100 Ohms, Degrees Celsius, 2 wire.</td>
</tr>
<tr>
<td>RTDTempF2W</td>
<td>Use this electrical type if the sensor is a Resistive Thermal Device Temperature sensor, 100 Ohms, Degrees Farenheit, 2 wire.</td>
</tr>
<tr>
<td>Supervised</td>
<td>Use this multistate electrical type if the input is for an access control system on either a 700 or a 800 series controller, an</td>
</tr>
</tbody>
</table>
AC1, AC1Plus or AC1A Continuum module, a b4 or b3 controller, and most Infinity models.

This type creates three states: On, Off, and Trouble.

Supervised inputs are normally part of a Door object, so you do not have to set them up as input points unless you want to use them in programs, or associated them with alarms.

After you select Supervised as an electrical type, a checkbox for the resistor type will display. Click the down arrow to select one of the following: NoSeries, NoParallel, NoSerPar, NCSeries, NCParallel, or NCSerPar.

If the resistor is for a Supervised input on a EMX 190 or CRM 100 (channel 9, 10, 11, or 12), you must select NOSeries, NOParallel, NCSeries, or NCParallel.

Note: When this type is selected, a BACnet MultistateInput object, with these three states (On, Off, and Trouble) is created, in addition to the InfinityOutput point. The MultistateInput can be viewed in the BACnet devices portion of the Continuum Explorer’s navigation pane. Please see Chapter 14 for a description of the MultistateInput editor and on BACnet in general.

**TankProbe**

Use this electrical type for a probe on TankNet

**ThermoCoupBTempC**

Not Available: This electrical type will be available in a future release.

**ThermoCoupBTempF**

Not Available: This electrical type will be available in a future release.

**ThermoCoupETempC**

Not Available: This electrical type will be available in a future release.

**ThermoCoupETempF**

Not Available: This electrical type will be available in a future release.

**ThermoCoupJTempC**

Not Available: This electrical type will be available in a future release.

**ThermoCoupJTempF**

Not Available: This electrical type will be available in a future release.

**ThermoCoupKTempC**

Not Available: This electrical type will be available in a future release.
ThermoCoupKTempF  Not Available: This electrical type will be available in a future release.
ThermoCoupRTempC  Not Available: This electrical type will be available in a future release.
ThermoCoupRTempF  Not Available: This electrical type will be available in a future release.
ThermoCoupSTempC  Not Available: This electrical type will be available in a future release.
ThermoCoupSTempF  Not Available: This electrical type will be available in a future release.
ThermoCoupTTempC  Not Available: This electrical type will be available in a future release.
ThermoCoupTTempF  Not Available: This electrical type will be available in a future release.

Voltage  Use this electrical type if the input point is a voltage or current sensor. Continuum gives a voltage reading for this type of sensor, so you will need to enter a conversion formula on the Conversions page.

InfinityOutput Types

Current  Select this type if the output is a current type.

Digital  Use this electrical type of the output point is an ON or OFF contact closure. After you select Digital as an electrical type, a text box for Polarity will appear. If you want to invert the meanings of ON and OFF, click the box to put a check mark in it.

HiResCurrent  Select this type for certain EMX input modules.

HiResVoltage  Select this type for certain EMX input modules.

PanelMeter  Use this unit type when setting up an output point for an LS-8 Seven Segment Display Board IOUmodule. A PanelMeter output allows a Plain English program to assign a numeric value to the display without doing a string conversion. The Alternative is to use
a string output, but the Plain English program must convert the string using the NumToStrn function.

**Pneumatic**
Select this type if the output is a pneumatic type. Pneumatic is applicable only if the controller is an Infinet controller and the point is on an EMX 140 or POM 200 expansion module. If you have an EMX 141 or an EMX 143 with only one output, you must skip a channel for the missing one.

**Tristate**
Select this multistate type if the output is a tristate type (ON, OFF, and -ON).

*Note:* When this type is selected, a BACnet MultistateOutput object, with these three states, is created, in addition to the InfinityOutput point. The MultistateOutput can be viewed in the BACnet devices portion of the Continuum Explorer's navigation pane. Please see Chapter 14 for a description of the MultistateOutput editor and on BACnet in general.

**Voltage**
Use this electrical type if the output point is a voltage output. Continuum gives a voltage setting for this type of output, so you will need to enter a conversion formula on the Conversions page.
Appendix C

Pinpoint Toolbars
The Standard Toolbar

S1 Create a new graphic panel
S2 Open an existing graphic file
S3 Save the current graphic file
S4 Go to the previous graphic file. If available, the down arrow will display a list of all previous graphic files. This functionality is similar to Microsoft's Internet Explorer.
S5 Go to the next graphic file. If available, the down arrow will display a list of all next graphic files. This functionality is similar to Microsoft's Internet Explorer.
S6 Go to the home panel.
S7 Show a list of all panels.
S8 Cut the current selection
S9 Copy the current selection
S10 Paste the contents of the clipboard
S11 Undo last action
S12 Redo last undo
S13 Print the current panel
S14 Run Mode
S15 Design Mode
S16 Zoom in 25% (Max 400%)
S17 Zoom out 25% (Min 25%)
The Active Components Toolbar and Window Control Toolbar

C1  Delete active link
C2  Active text control
C3  Active button control
C4  Active animated button control
C5  Active switch control
C6  Active bar control
C7  Active gauge control
C8  Active rotation control
C9  Active animation control
C10 Active personnel picture control
W1  Window button control
W2  Window edit box control
W3  Window switch control
W4  Window combo box control
W5  Window slider control
W6  Window video control
W7  Window check box control
W8  Window progress bar control
W9  Window web browser control
W10 Window trend graph control
W11 Window LED number control
W12 Window door control

C-4  TAC
The Alignment Toolbar

A1 Align all selected objects by vertical top
A2 Align all selected objects by vertical center
A3 Align all selected objects by vertical bottom
A4 Align all selected objects by horizontal left
A5 Align all selected objects by horizontal center
A6 Align all selected objects by horizontal right

The Drawing Toolbar

D1 Select control to choose an object
D2 Edit the endpoints or corners of the current object
D3 Display the properties dialog of the current object
D4 Draw a line
D5 Draw a poly-line
D6 Draw a polygon
D7 Draw a rectangle
D8 Draw a poly-curve
D9 Draw a closed curve
D10 Draw an ellipse or circle
D11 Insert a text box
D12 Insert an image
The Layout Toolbar

L1 Horizontally distribute selected objects evenly
L2 Vertically distribute selected objects evenly
L3 Stretch all selected objects to the same horizontal length of the last selected object in the set
L4 Stretch all selected objects to the same vertical height of the last selected object in the set
L5 Combined functionality of L3 and L4

The Nudge Toolbar

N1 Nudge the selected object(s) up
N2 Nudge the selected object(s) down
N3 Nudge the selected object(s) left
N4 Nudge the selected object(s) right
The Rotate Toolbar

R1  Rotate - Anchors the selected object(s) to allow arbitrary rotation
R2  Rotate the selected object(s) left by 90°
R3  Rotate the selected object(s) right by 90°
R4  Flip the selected object(s) horizontally
R5  Flip the selected object(s) vertically

The Structure Toolbar

T1  Group the selected objects into one component
T2  Ungroup the selected object to its components
T3  Bring the selected object(s) to the front
T4  Put the selected object(s) to the back
T5  Move the selected object(s) forward
T6  Move the selected object(s) backward
Appendix D
Pinpoint Image Library
Security Cross Section Controls

Alarms
File Name: Alarm1, Alarm2
File Format: EMF
File Size: 9K Each

Doors
File Name: DoorClosed, DoorOpenRed, DoorOpenGray
File Format: EMF
File Size: 17K, 20K, 20K

Cameras
File Name: CameraLeft, CameraRight
File Format: EMF
File Size: 77K each
**Fire Sensor**
File Name: FireSensor1, FireSensor2
File Format: EMF
File Size: 21K, 34K

![Fire Sensor](image)

**General Sensor**
File Name: SensorBlack, SensorRed, SensorGreen
File Format: EMF
File Size: 122K each

![General Sensor](image)

**Fire Strobe**
File Name: FireStrobe
File Format: EMF
File Size: 93K

![Fire Strobe](image)

**CCTV**
File Name: CCTV
File Format: EMF
File Size: 22K

![CCTV](image)
Hand Reader
File Name: HandReader
File Format: EMF
File Size: 208k

Intercom
File Name: Intercom
File Format: EMF
File Size: 28K

Roll Door
File Name: RollDoor1Gray_Down, RollDoor2Gray, RollDoor3Gray, RollDoor4Gray, RollDoor1Red_Down, RollDoor2Red, RollDoor3Red, RollDoor4Red
File Format: EMF
File Size: 45K, 46K, 17K, 7K
**Keypad**
File Name: Keypad
File Format: EMF
File Size: 376K

![Keypad Image]

**Person**
File Name: Person
File Format: EMF
File Size: 17K

![Person Image]

**Motion Sensor**
File Name: MotionSensor
File Format: EMF
File Size: 15K

![Motion Sensor Image]
**Request to Exit**
File Name: RequestExit1, Request Exit2
File Format: EMF
File Size: 80K Each

**Turn Style**
File Name: Turnstyle1, Turnstyle2
File Format: EMF
File Size: 23K, 52K

**Security Gate**
File Name: Gateup, Gatedown
File Format: EMF
File Size: 32K Each
Card Swipe
File Name: CardSwipePos1, CardSwipePos2, CardSwipePos3
File Format: EMF
File Size: 41K Each

Security CAD View

Doors
File Name:
Down_Dble_Closed, Down_Dble_Open, Down_Single_Left, Down_Single_Right
Left_Dble_Closed, Left_Dble_Open, Left_Single_Closed, Single_Left,
Single_Right, Single_Side
Up_Dble_Closed, Up_Dble_Open, Up_Single_Closed, Up_Single_Left,
Up_Single_Right
File Format: EMF
File Size: 3K each
Cameras
File Name: CamLeft, CamLeftDown, CamLeftUp, CamRight, CamrRightDown, CamRightUp
File Format: EMF
File Size: 7K each
PIR
File Name: PIR_Off_Down, PIR_Off_Down_Left, PIR_Off_Down_Right, PIR_Off_Left,
PIR_Off_Right, PIR_Off_Up, PIR_Off_Up_Left, PIR_Off_Up_Right, PIR_On_Down,
PIR_On_Down_Left, PIR_On_Down_Right, PIR_On_Left, PIR_On_Right, PIR_On_Up,
PIR_On_Up_Left, PIR_On_Up_Right
File Format: EMF
File Size: 15K each
Glass Break
File Name: GlassBrk_Red, GlassBrk_Yellow, GlassBrk_Green
File Format: EMF
File Size: 9K each

Card Reader
File Name: CardReader
File Format: EMF
File Size: 7K each

PullStation
File Name: PullStation
File Format: EMF
File Size: 5K each

SmokeHead
File Name: SmokeHead1, SmokeHead2
File Format: EMF
File Size: 27K each
**TurnStyle**
File Name: TurnStyle1, TurnStyle2
File Format: EMF
File Size: 25K each

**Straight**
File Name: HorzStraight_P, VerStraight_P
File Format: EMF
File Size: 27K, 14K

**Exhaust**
File Name: Exhaust_P
File Format: EMF
File Size: K
**Cross**
File Name: Cross_P
File Format: EMF
File Size: 27K

**LShapes**
File Name: DownLeft_P, DownRight_P, UpLeft_P, UpRight_P
File Format: EMF
File Size: 21K each

**Tshapes**
File Name: DownT_P, UpT_P, LeftT_P, RightT_P
File Format: EMF
File Size: 21K each
HVAC Controls

Arrows
File Name: Arrow_Blue_Left_In, Arrow_Green_Left_In, Arrow_Red_Left, 
Arrow_Blue_Right, Arrow_Green_Right, Arrow_Red_Right, Arrow_Blue_Up, 
Arrow_Green_Up, Arrow_Red_Up, Arrow_Blue_Down, Arrow_Green_Down, 
Arrow_Red_Down
File Format: EMF
File Size: 21K each
Filters
File Name: Filter_H, Filter_V
File Format: EMF
File Size: 515K
Comments: Integrates into the Andover Controls Ducts

Dampers
File Name: HDampers1_P, Dampers2_P, HDampers3_P, HDampers4_P,
VDampers1_P, VDampers2_P, VDampers3_P, VDampers4_P
File Format: EMF
File Size: 45K each
Comments: Integrates into the Andover Controls Ducts
**Blowers DGreen (this is a Dark Green)**
File Name: 
File Format: EMF
File Size: 25K each
Comments: Integrates into the Andover Controls Ducts
GREEN (Full Suite applies to these, see Green Blowers for full list)
RED (Full Suite applies to these, see Green Blowers for full list)
BLUE (Full Suite applies to these, see Green Blowers for full list)

**Coils**
File Name: CoilH, CoilV
File Format: EMF
File Size: 30K each
Comments: Integrates into the Andover Controls Ducts

**RH Sensors**
File Name: RHSensCold_H, RHSensCold_V, RHSensHot_H, RHSensHot_V
File Format: EMF
File Size: 10K, 10K, 13K, 16K
Comments: Integrates into the Andover Controls Ducts
Pressure Sensors
File Name: PressSensor_H, PressSensor_V
File Format: EMF
File Size: 87K each
Comments: Integrates into the Andover Controls Ducts

Temperature Sensors
File Name:, TempSensor_H, TempSensor_V
File Format: EMF
File Size65K each
Comments: Integrates into the Andover Controls Ducts

Freeze Sensors
File Name:, Freeze_H, Freeze_V
File Format: EMF
File Size: 15K each
Comments: Integrates into the Andover Controls Ducts

Sprinkler
File Name: SprinklerWet, SprinklerDry
File Format: EMF
File Size: 26K, 22K

Boilers
Pumps
File Name: Pump_Gray, Pump_Blue, Tank_Red
File Format: EMF
File Size: 21K
Pipes (RED) (Blue) (GRAY)

File Name:
Pipe_Red_Horizontal, Pipe_Red_Vertical,
Pipe_Red_Cap_Down, Pipe_Red_Cap_Left, Pipe_Red_CurveLeftDown,
Pipe_Red_CurveLeftUp, Pipe_Red_CurveRightDown, Pipe_Red_CurveRightUp,
Pipe_Red_FlangeDown, Pipe_Red_FlangeDown, Pipe_Red_Flange_Left,
Pipe_Red_FlangeRight, Pipe_Red_FlangeUp

Pipe_Blue_Horizontal, Pipe_Blue_Vertical, Pipe_BLUE_Cap_Down, Pipe_BLUE_Cap_Left,
Pipe_BLUE_CurveLeftDown, Pipe_BLUE_CurveLeftUp, Pipe_BLUE_CurveRightDown,
Pipe_BLUE_CurveRightUp, Pipe_BLUE_FlangeDown, Pipe_BLUE_FlangeDown,
Pipe_BLUE_Flange_Left, Pipe_BLUE_FlangeRight, Pipe_BLUE_FlangeUp

Pipe_Gray_Horizontal, Pipe_Gray_Vertical, Pipe_Gray_Cap_Down,
Pipe_Gray_Cap_Left, Pipe_Gray_CurveLeftDown, Pipe_Gray_CurveLeftUp,
Pipe_Gray_CurveRightDown, Pipe_Gray_CurveRightUp, Pipe_Gray_FlangeDown,
Pipe_Gray_FlangeDown, Pipe_Gray_Flange_Left, Pipe_Gray_FlangeRight,
Pipe_Gray_FlangeUp

File Format: EMF
File Size: 34K
HVAC Simple

Straight
File Name: HorzStraight_S, VerStraight_S
File Format: EMF
File Size: 10K each

Exhaust
File Name: Exhaust_S
File Format: EMF
File Size: K

Image is still under construction

Cross
File Name: Cross_S
File Format: EMF
File Size: 27K
LShapes
File Name: DownLeft_S, DownRight_S, UpLeft_S, UpRight_S
File Format: EMF
File Size: 21K each

Tshapes
File Name: DownT_S, UpT_S, LeftT_S, RightT_S
File Format: EMF
File Size: 21K each
Dampers
File Name: HDampers1_S, Dampers2_S, HDampers3_S, HDampers4_S,
VDampers1_S, VDampers2_S, VDampers3_S, VDampers4_S
File Format: EMF
File Size: 6K each
Comments: Integrates into the Andover Controls Ducts

Continuum Product

CNC_IOUModules:
File Name: CNC, AC1, AC1_Plus, AO4, DI6, DI8, DM20, DO4, DO6, LO2, MI6, PO2,
UI8, VT1
File Format: EMF
File Size: 160K each
Personal Computers
File Name: 
File Format: EMF 
File Size: K each

Switches

Selector
File Name: RedDial_Right, RedDial_Left, BlueDial_Right, BlueDial_Left, GreenDial_Right, GreenDial_Left, BlackDial_Right, BlackDial_Left
File Format: EMF
File Size: 52K each
LED Push
File Name: LED_Push_Green, LED_Push_Red, LED_Push_Yellow, LED_Push_Black
File Format: EMF
File Size: 50K each

DIP
File Name: DIP_Horizontal_On.EMF, DIP_Horizontal_Off.EMF, DIP_Vertical_On.EMF, DIP_Vertical_Off.EMF
File Format: EMF
File Size: 9K each

Lever
File Name: Lever_Up.EMF, Lever_Down.EMF
File Format: EMF
File Size: 18K each
**Rocker**
File Format: EMF
File Size: 40K, 16K

**Toggle**
File Format: EMF
File Size: 40K, 16K

**Button**
File Name: Round_Black, Round_Green, Round_Red, Round_Yellow
File Format: EMF
File Size 23K Each
Appendix E

EpiSuite SDK
Installation and Use
What is EPISuite?

EPISuite is a software product that:

- Captures photographs, fingerprints, and signatures
- Corrects output colors
- Encodes magnetic stripes and smart chips
- Prints cards

When integrated with the Continuum database, you can create photo ID cards that work with Continuum's personnel objects. That means when these cards are used at access control points, Continuum workstation operators can compare the image in the database to that on the card or the actual cardholder.

In this Appendix

This appendix contains the following sections:

- Installation on Systems Running EPISuite
- Installing EPISuite for the First Time
- Setting Up EPISuite
- EPISuite Operation

Installing on Systems Running EPISuite

Perform the following steps to upgrade EPISuite.

1. Remove the old EPISuite security key from your printer port.

2. Uninstall EPISuite

3. Upgrade Continuum in accordance with published upgrade procedures.

4. Run the EpiSetup.bat, which is located in the Continuum installation folder on your drive. Choose server and update the database. Choose workstation and confirm the settings are correct. You will be prompted to restart your computer. This action must be performed on each workstation that is to be enabled for badging.
5. Contact TAC and obtain an activation code for the integrated version. When contacting TAC for the activation code you will need to provide the serial number of the Continuum Security Key connected to the workstation's printer port. To assist in obtaining this serial number and activating the key, run the ACCKeyWriter.exe, which is located in the Continuum installation folder on your drive.

6. TAC will provide you with the activation code. This code must be entered into the "Keycode" field of the ACCKey Writer program, which will in turn activate EpiSuite at the workstation you are on. After entering the code, click the Update button. It should return a message:

   Your key has been programmed.

   Click Cancel to exit the ACCKey Writer.

7. Activation of the Continuum Security Key will need to be performed on every workstation, which is to allow badging. This activation code is different for each workstation and is based upon the serial number of the Continuum Security Key.

8. Proceed to the Setting Up EpiSuite section on your PC.

**Installing EpiSuite for the First Time**

Perform the following steps to install EpiSuite on your PC.

1. If you ordered badging with Continuum version 1.3 or later, your security key should be activated. If you decided to add badging later, you will need to perform steps 5 and 6 in the preceding section.

2. Run the EpiSetup.bat, which is located in the Continuum installation folder on your drive.

3. Depending upon your installation, choose server or standalone as applicable and update the database.

4. Choose workstation and confirm the settings are correct. You will be prompted to restart your computer.

5. Proceed to the Setting Up EpiSuite section.
Setting up EpiSuite
Perform the following steps to set up EpiSuite on your PC. Refer to the figure below during this procedure

1. Start Cyberstation.

2. Open the **Preferences** tab of the Device editor for the CyberStation device. (See Chapter 15.)

3. In the **Value** column of the **The location of the badge format files** setting, assign a default path for the location at which you will be storing the badge layouts.

4. In the **Value** column of the **The default badge format** row, assign a default badge layout for the system to load when creating new personnel.

   This is unique to each user. A user in this instance is defined as “each person who has his own NT logon”. Steps 3 and 4 will need to be repeated for each user.

5. Click **OK**.
6. Editing or creating badge layouts is controlled through the Cyberstation user security. Right click on the Continuum icon from the Windows system icon tray and choose Security. The Security editor appears:

![Security Editor](image)

7. Make your changes and click **OK**.

E-6 TAC
EpiSuite Operation

The following procedure provides you with the steps necessary to create a badge.

1. The first time you use the integrated badging, you will need to create one or more badge layouts. Create or Edit a personnel object, choose Make/Edit Badge. (See the following figure.)
2. After selecting Make/Edit Badge, the Badge Manager dialog will open. (See the following figure)

3. Select a layout. If you are creating a new layout select Edit Badge Layout. GuardDraw will start. Refer to the GuardDraw online help for further information on its use. (See the following figure.)

4. Capturing the photo or signature can be done by double clicking on the:
   - Photo, signature or fingerprint field. (See the following figure.)
5. When you perform a capture for the first time the system will ask you to define the source (Twain device or from File), see the figure below. If you have installed a video capture board, select Twain. Refer to the online help for further information.
6. Setting the Image Source for Photo, Signature and Fingerprint can be changed from the Tools menu. (See the following figure.)

7. Each time a card is printed, the value of the card is set to “printed”. (See the above figure.)

Note: An internal counter keeps track of the total amount of cards “printed” with an incrementing count. When the card is set “unprinted” from the Tools menu, the count decrements.
8. You can print your card(s) by selecting Print Preview Card or Print Card from the File menu. Selecting Batch Print Cards will create a batch print job of all cards currently listed as unprinted. (See the following figure.)

9. If you are using card encoding, you can start the function from the Tools menu as follows. (See the figure in Step 6.)

   a. Create a new Template in GuardDraw
   b. In GuardDraw, select Edit -> Card Encoding...
   c. Add “NonABACardNumber” to track 2
   d. Save Template and Close GuardDraw
   e. In the Make/Edit Badge dialog, select File -> Printer Card Encoder...
   f. Select Printer
   g. Under Magstripe select “Magstripe Printer Encoder”
   h. Click Setup and then Click Import
   i. In C:\Program Files\G&A Imaging Ltd\Episuite sdk\5.0\Encoding Setup Files\Printer Magstripe, there are ENC files for the more popular Printer/Encoders select the one that matches your printer
   j. OK out to the Make/Edit Badge dialog

**Note:** If you have a printer/encoder other than the ones listed you will need to go to the printer manufacturer to get the proper information for this field. (with the Magicard Turbo Flip M, the Magicard 300 printer.enc worked)

Refer to online help for further information.
Appendix F

Multiple Custom Card Formats
Multiple Custom Card Formats

CX version 1.11 introduces support for up to four custom card formats.
The User can now define more than one AccessFormat array object. This will enable the access control engine to handle more than one custom card format per CX Controller.

Note: Multiple Custom Card Formats supported in the CX99XX controllers only.

Requirements:
2. Each custom card format must have a unique site code, otherwise the system will not be able to uniquely identify people with the same card number but different formats.
3. Selecting the Custom card type on a door would allow all custom card types to enter that door.

Functionality:
There is no change in the way custom cards are implemented; this new revision only expands the number of custom cards supported from one to four.

Custom Card Validation in Degrade Mode:
Degrade mode is when the AC-1 cannot communicate with the NetController. For the AC1 to perform site code validation when operating in degrade mode do the following:

Add the following code at the end of the Plain English program where the AccessFormat array(s) is/are initialized:

```
Numeric SiteCode1, SiteCode2, SiteCode3, SiteCode4

'Set up AccessFormat below
'AccessFormat[0] =
'etc

'STORE SITE CODES FROM DOOR
SiteCode1 = MyDoor Site1
SiteCode2 = MyDoor Site2
SiteCode3 = MyDoor Site3
SiteCode4 = MyDoor Site4

'CLEAR DOOR'S SITE CODES
MyDoor Site1 = 0
MyDoor Site2 = 0
MyDoor Site3 = 0
MyDoor Site4 = 0
```
‘RESTORE DOOR’S SITE CODES
MyDoor Site1 = SiteCode1
MyDoor Site2 = SiteCode2
MyDoor Site3 = SiteCode3
MyDoor Site4 = SiteCode4

IMPORTANT:
All site code information is sent to the AC-1s for each card type selected in the following order.

1. Infinity37
2. AC4Plus432
3. Weigand26
4. CK34
5. Custom
6. G31

The AC-1 can only store all four site codes for one format and the last one selected from the above list wins. Out of the four possible Custom Access Format arrays, only the AccessFormat is sent to the AC-1. Note that if G31 were selected, the AC-1 would store that instead of Custom Access Format.
Appendix G

Comma Separated Variable File Import
Comma Separated Variable File Import

The Comma Separated Variable File Import feature (hereafter referred to as CSV import) allows the creation or update of one or more objects from a text file. CSV files are a quick and efficient method of importing objects of varying classes from older versions into Continuum. This text file contains an object class name, a list of object attributes, and one row for each object. The first line specifies the class name of the objects to be imported. The second line, called the Attribute Definition Line (ADL), defines the attributes to be imported by name. The third and successive rows contain the objects themselves, called Attribute Value Lines (AVL), using the ADL as a template for what order the attributes are in.

Viewing and Editing CSV Files
CSV files can be viewed and edited from either a text editor or through a spreadsheet program. An example of a CSV import file viewed through a text editor is as follows:

```
Object Class Name | Attribute Definition Line

<table>
<thead>
<tr>
<th>Attribute Value Lines</th>
</tr>
</thead>
</table>
```

Andover Continuum CyberStation Configurator's Guide  G-3
The CSV import file can be viewed and (if necessary) edited with either a text editor or with a spreadsheet program such as Microsoft Excel. The CSV import file distributes the data such that a comma separates the columns for each row. An example of a CSV import file viewed through Microsoft Excel is as follows:

![Microsoft Excel screenshot](image)

**Extra commas**

Editing CSV import files with Microsoft Excel is a quick and efficient method of adding or deleting columns of data. In the screenshot above, notice that not all rows use the same number of columns. The first row uses one column and rows two through five use five columns. When a CSV file is saved from Microsoft Excel, each row that does not populate all columns will have an extra comma afterwards for each column not used. Once edited and saved, the CSV import file in the above screenshot viewed with a text editor appears as follows:

```
name, description, doornum, doorkid, doorno, doorno, doorno
Door1, Main Lobby front door, locked, closed, enabled
Door2, Entrance to first floor offices, locked, closed, enabled
Door3, Entrance to second floor offices, locked, closed, enabled
```

**Extra commas**

After editing a CSV file with Microsoft Excel, you must open the CSV file with a text editor and remove all of the extra commas in the object class lines and at the end of any lines throughout the file that have extra commas at the end.
CSV Import Files for Personnel Objects

The CSV import of personnel objects follows the same format as that of other objects, except that there are three optional lines that can be added. The format includes the following additional CSV keyword lines:

**AutoNumber** – This optional line will automatically assign CardType, SiteCode(for Non-ABA) and CardNumber for every personnel object being imported. The user can overwrite this auto-assignment for particular personnel by including CardType, SiteCode(For Non-ABA), and CardNumber in the attribute definition line and put non-empty values in the attribute value line. If no value is specified for personnel, auto-assignment will take place. This overwrite feature is useful when you want to change a personnel’s cardnumber with the Key line presented and set to non-CardNumber.

**Key** – This optional line will try to resolve each attribute value line (personnel or user) by using the unique key or keys specified in the key line. With this line, the user can specify the attribute list that uniquely identifies personnel. Examples of Key lines are as follows:

- Key,firstname,lastname
- Key,socsecno
- Key,name
- Key,alias
- Key,cardnumber,sitecode,cardtype
- Key,name,socsecno

**Note:** Key must not be an attribute in any class. All attributes in the Key Definition Line (KDL) must also be in the Attribute Definition Line (ADL).

**Option** – This line has two options available, as follows:

- **NoPhotoUpdate** – This option will not update the personnel photo file.
- **NoCardNumberCheck** – This option will not check CardNumber duplication. This will speed up personnel CSV import. Without this option, CSV import will always check CardNumber duplication.
The CSV import file format for personnel objects is as follows:

```
ClassName
AutoNumber,CardType,SiteCode,BeginCardNumber
Key,attribute1,attribute2,...
Option,NoPhotoUpdate
Attribute Definition Line
Attribute Value Lines
```

The sample CSV import file content is as follows:

```
personnel
AutoNumber,CardType,SiteCode,BeginCardNumber
name,lastname,firstname,address,sex
AnneJ.Jones,Anne,123 Park Street,F
SteveSmith,Steve,456 Cherry Street,M
BillB.James,Bill,789 Chestnut Ave,M
CherylKing,Cheryl,100 Seaside Drive,F
```